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TELL US WHAT YOU THINK

As the reader of this book, you are the most important critic and commentator. We value your opinion and

want to know what we're
doing right, what we could do better, what areas you'd like to see us publish in,

and any other words of wisdom you're willing to pass our way.

As an editor for New Riders Publishing, I welcome your comments. You (an fax, email,or write me directly to

let me know what you did or didn't like about this book-as well as what we can do to make our books
stronger. When you write, please be sure to include this book's title, ISBN,and author,as well as your name

and phone or fax number. I will carefully review your comments and share them with the author and editors

who worked on the book.

Please note that I cannot help you with technical problems related to the topic of this book, and that due to the

high volume of email i receive, I might not be able to reply to every message.

Fax: 317-581-4663

EmaiL elise.walter@newriders.com

Mail: Elise Walter
Acquisitions Editor

New Riders Publishing

800 E.96'" 5treet

Suite 200
Indianapolis, IN 46240 USA
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INTRODUCTION

Why you need this book

I :: ~~~~::~:~a~I:::tne~~~~~u:h~~:t~:t~~~:e~;~:~: ~~~~~~~~~~~dh:~~

Content tools and you've got a whole lot of boxes going on, but aher all, it seems

doable. And it is But, being an accomplished-ta-expert user in Quark is quite
another matter. And that's because you're not just learning or perfecting how to

use a piece of software.Not hardly.You're trying to master the field of graphic

design and layout that sits between the linesof your Quark software. That's where

how you use Quark separates the proverbial men from the boys.There'sa whole
lot more going on.

And that's why I wrote this book. Knowing where the leading tool is on the

Measurements palette or even knowing the keyboardshortcut for leading is one
thing. But knowing how to set leading for subheads so that your body copy lines
up by the baseline across the page and spread is another thing, When your copy
is running long, how many Quark ways can you pull out of your hat to make it fit,
gracefully? Or, knowing how to use mUltiple master pages to make your facing
pages both have the same set of unequal margins (perfect for product catalogs
and other layouts) is not something you'l! easily or ever find in another Quark

book.These are just a very few of the more than 300 exciting and useful tips

you'll find here,

This book is the one you're going to want to buy and read, because it goes
where no previous Quark books have gone-into the realm of the unknown and

unknowable. Okay, okay, I'm
going off the deep end, But, on every page, this book

has all those great kernels of wisdom that you have to hunt for in any other
Quark books and, in many cases, you will not find. Instead of flipping through the

book, looking for those little boxes of juicy tidbits-the tips-every page in this
book is filled with just tips! Right out front. Amazing!

Is this book for you?
Yes, unquestionably, whether you have been using Quark for years or you're a

newer user-because this book brings together years of collective wisdom about
using Quark. As a digital designer {since 1985} and longtime pre-digital designer,

authorized Quark trainer, and graphic design instructor, I've used Quark over
many years. My colleagues, Toby Zallman and Clint Funk, who contributed some

invaluable tip suggestions, are longtime users and designers from the pre-
desktop publishing era of.analog~graphic design.
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Even though the book is called QuarkXPress 6 Killer Tips, it's not just about the "6"
part. It's about everything you ever wanted to know, and more, about using Quark.
The only Quark users who should not buy this book are those who are using

Quark exclusively to do web design. There is absolutely nothing in this book about

the web capabilities of Quark. It's not that I don't like doing web work, but when it
came right down to it,there simplywasn't enough room to include Chapter 14,

"Quark for the Web," and believe me,l didn't want to end on a Chapter 13! Other
than that, any print designer or production person should learn a lot from these

well-seasoned tips

What's the best way to read this book?
Because this is a tips book and not what I call an A-to-Z book, you can read these
tips in any order you like. Each one is self-sufficient and is written to stand alone,

without reference to other tips, (Well, okay, there are a couple here and there that

say you should read the tip above, but, as my Mom says, "They're the exceptions
that prove the rule,")

The tips are organized into common sense groups-chapters that more or less

follow the layout process, so it's easy to find all the tips on one topic in one place.

Occasionally, a closely related tip had to go in another area, where it was needed
more, so you'll find a "see also" given, with the tip name and chapter number. And

of course, I know you'll want to use the excellent index that New Riders Publishing
put together-thank goodness I didn't have to do that!

Is this just for Mac? Is this just for Windows?
Okay, it's for everyone! I have both, so no problem. Every time you see a keyboard

shortcut, both Mac and Windows keys are included. But to make it easier to glide
right through those shortcuts, I decided not to say IMac and /Win, Too many

words, After all, when it's Mac, it's Cmd-Option-Shift; and when it's Windows,

it's Ctrl-Alt-Shift. So they're easy to spot without all those platform labels.

Occasionally, on a Mac, you do use the Control key, but then the word is spelled
out, every letter, because most Mac users don't even know they have a Control

key! Windows users are old-timers with Ctrl keys so they can have the no-vowels

version, and that's how you tell those Mac and Win keys apart.



More on those keyboard shortcuts
One last note-my apologies to those fast-track Quark users who only want

keyboard shortcuts and don't want to know the command name and menu, Well,

first of all, there are quite a few commands (I stopped counting at 25) that don't
have keyboard equivalents, Some people just don't like using shortcuts anyway.
Of course in Quark, you really have to, because so many things are too hard or
impossible to do without shortcuts. However, my tips are not usuaily just a key-

board shortcut, particularly if they're already on the menu. They go deeper. So

to make everyone happy, along with the shortcut, I usually give the menu and

command name, like this:

Item> Content> Picture

Notice, the word
"menu" is avoided. Again, too many words.

Contact me with your tips

I'm sure to upgrade this book for future versions of Quark. So while you're reading

this book or not reading the book, I'm sure you'll remember some of those cool
things you did to get through your worst deadlines and even your best ones. Let

me know what works for you! I'll be happy to credit you in the tip.

May your Quark days (daze?) be smart, easy, fun, and fruitful.and may these tips

help multiply your paycheck by many zeros!
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FOREWORD

....
If you were writing 0

book, and you had

a really cool tip, an

amazing trick. or an

inside secretor shortcut,

you wouldn't bury it

among hundreds of

paragraphs of text.

You'd make ir stand out:

You'd put a box around

it, maybe pur a rim

behind it, and if ir was

really cool (and short

and sweet), you'd get

everybody's attention

by starring with the

word 'Tip!"

QuarkXPress 6 Killer Tips

Edited by Scott Kelby

As Editor for the KillerTips series, ,'m delighted to introduce you to Eda

Warren, a really talented author who is going to take you to a whole new

level of speed, efficiency, and productivity with QuarkXPress 6. But first, a

little background on this book and what makes it different from every

other QuarkXPress book out there.

The idea for this type of book came to me one day when I was at the
bookstore, browsing in the computer section, when I thought to myself,

"Man, these authors must be making a ton of moneyr No wait, that wasn't
what I was thinking (it's close, mind you, but not exactly}. Actualiy, I was
standing there flipping though the different books on Adobe Photoshop

(I'm a Photoshop
guy at heart). Basically what I would do is look for pages

that had a tip on them. They're usually pretty easy to find, because these

"rich book authors" usually separate their tips from the regular text of the

book. Most of the time, they'll put a box around the tips,or add a tint

behind them, maybe a "tipsWkon-something to make them stand out

and get the readers'attention.

Anyway, that's what I would do-find a tip, read it, and then start flipping
until I found another tip. The good news-the tips were usually pretty

cool. You have to figure,that if an author has some really slick trick, maybe

a hidden keyboard shortcut or cool workaround, they probably wouldn't
bury it in blocks of boring copy. No way! They'd find some way to get your
attention (with those boxes, tints, a little icon, or simply the word HTipi")
So, that's the cool news-if it said tip, it was usually worth checking out.
The bad news-there's never enough tips. Sometimes they'd have five or

six tips in a chapter, but other times just one or two. But no matter now
many they had, I always got to the last chapter and thought, -Man, I wish

there had been more tips."

Standing right there in the bookstore, I thought to myself"1 wish there

were a book with nothing but tips. Hundreds of tips, cover-to-cover, and
nothing else. Now that's a book I would go crazy for.I kept looking and

looking, but the book I wanted just wasn't available. That's when I got the
idea to write one myself. The next day I called my editor to pitch him with
the idea. I told him it would be a book that would be wall-to-wall cool
tips, hidden shortcuts, and inside trkks designed to make Photoshop

users faster, more productive, and best of all, to make using Photoshop

even more fun. Well, he loved the idea. OK, that's stretching it a bit.

He liked the idea, but most importantly, he "green-lighted it- (that's



Hollywood talk.
I'm not quite sure what it means), and soon I had created

my first all-tips book, Photoshop 6 KillerTips (along with my
co-author and

good friend, Photoshop User magazine Creative Director Felix Nelson).

As it turned out, Photoshop 6 Killer Tips was an instant hit (luckily for me

and my chance-taking editor), and we followed it up with (are you ready

fOf this?) Photoshop 7 Killer Tips, which was an even bigger hit. These

books really struck a chord with readers, and I like to think it was because

Felix and I were so deeply committed to creating something special-a

book where every page included yet another tip that would make you

nod your head, smile, and think Mahhh, so that's how they do it.k However,

it pretty much came down to this-people just love cool tips. That's
why

now there's also a Dreamweaver MX KillerTips, a Mac as x Killer Tips, a

Windows XP Killer Tips, and a host of others now in development.

So how did we wind up here, with QuorkXPress 6 Killer Tips? Actually,

QuarkXPress is an ideal program to have its own KillerTJps books for two

main reasons:
(1)

The product is mature (it's already up to version
6)

and

has lots of depth, which is an absolute requirement to have enough really

killer tips to create an entire book. and
(2)

if there was ever a product

where being an absolute speed demon when using it puts money right in
your pocket,

it's QuarkXPress.lt's a page layout app,
a production tool

(if you will), and the more productive and efficient you are, the more

valuable you'll be. Perhaps best of all, knowing all the cool shortcuts, the

inside tips, and the absolute fastest ways to do everything is just flat out

fun (and
I'm

not even talking about all the bragging and showing off to

friends and co-workers. OK, I am, but that's not the point).

But finding the right software package is only one piece of the puzzle.

Finding the right author-someone who total1y"gets"the KillerTips con-

cept, is a talented and experienced writer, and, most importantly, is an

absolute expert in QuarkXPress. That's Eda Warren, and that's
why

she's

the author of this book. Eda totally "gets" it-she
probably knows

QuarkXPress tips that Quark itself doesn't even know, and she shares

them all in this book.

Eda has really captured the spirit and flavor of what a"KilierTips"book is

all about, and I can tell you this-you're gonna love it! I can't wait for you

toMget into it" so I'll
step aside and let her take the wheel, because you're

about to get faster, more efficient, and have more fun using QuarkXPress

6 than you ever thought possible.

All my best,

Scott Kelby, Series Editor xxix





When Qjob hits your desktop, Ofe you ~
crashing out of the starting gate, no ~
stopping until you're done? Ofcourse!

Get Under the Hood
setup tips

But what about those few minutes of down-

time you get now and then, when Q little prep

work can save you many minutes down rhe

line? You're likely to make fewer mistakes

without the scrambling. You're less likely to

be in a panic because everything's in place,

your tools are behaving, and your work

space is performing like a well-tuned engine.

In that downtime, you can tweak Quark

with settings that suit your Style and your

kind of jobs. And once you do, those settings

Ofe working for you every time you start a

new project. Just think-whether ir's colors,

styles, hyphenation settings, line styles, box

properties, or something else-you
don't have

to keep choosing those settings again and

again. What a relief! Working smart means

you're ready to fly, coming in first, and with

greater chances rhat you're delivering one

great product.
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. 6 8 CUSTOMIZE QUARK'S LOOK AND FEEL FOR ALL NEW FILES

.~FHeEditSry

~:"Q"'kX"'''':\t
I Services.

I Hide QuarkXPress
HideOl:lH!rs

i ~::Q::rkXprtSS

When you've got a few minutes to spare, clean up your

Quark workspace so your next deadlines are easier.

Quark's Application preferences are the secret. Improve
the scroll bars. Prevent disaster with file corruption. Get

insurance with automatic saving and backup. Customize

the Print box so it looks like yours. All these are choices

in Applicationpreferences,covered in the next five tips. It

doesn't matter whether you have a Quark layout open orKQ
I not-your choices affect how Quark looksand acts from

now on-hut only on your machine. These settings don't
travel with the file. Zip to the Preferences dialog by pressing Cmd-Option-Shift-Y or

Ctrl-Alt-Shift-Y (QuarkXPress> Preferences/Mac or Edit> PreferenceslWin).

. e 8 SCROLL
'N'

GO

["°";"'Slow

I!!ISP\'fdscroll o~i\UV'fSc:roll

When you're zoomed in to one place and need to get to some other spot on the same page

or spread,don't touch those scroll bars-at least not without enabling Live Scroll. In the

Interactive settings of Application preferences (Cmd-Option-Shift-Y or Ctrl-Alt-Shift-Y), turn

on the Live Scroll option so that you can see where you're going as you drag. Otherwise,
it's

hit or miss getting to the right spot. Be sure Speed Scroll is on, which grays out pictures and

blends while you scroll, redrawing them only when you release the mouse. Then change the

Scrolling slider all the way to Fast so that you can drag less to go farther. Do this when no

files are open to make it true for all files you create from now on.
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. 6 6 SAVE A LIFE-BACK UP YOUR PREFERENCES FILE

~"'Ubr~ry 't
~ ~ e"'w,~...i:J' flUsen,.

.Brahm.Undo....
I EdaWJ.rren',Compuu.,

Backing up your preferences file (an be a life saver.This

file stores not only all your Application and Default Print

Layout preferences, but also such custom default settings

as colors, style sheets, hyphenation and justificatjon (H&Js),

hyphenation exceptions, kerning and tracking tables, and

print styles. Also, when you're trouble-shooting corrupted

files or having problems launching Quark, the preferences

file is often the culprit Back up your Preferences file

regularly by locating the XPress Preferences.prf file in the

Preferences folder. On Mac as x,
it's in your boot drive>

Users> (usemame» Library> Preferences> Quark>
QuarkXPress 6.0. Windows users will most likely find the

Quark application folder inside Program Files,at the top

level of the C:drive (in Win XP, it's boot drive> Program
Files> Quark> QuarkXPress 6.0> Preferences). Back it up

with Cmd-D or Copy and Paste, and move the duplicate
file out of the application folder.

!!!' " -mlfTMl.-txport.prf

mlfl'lIOrtlnk..prf
\r!OId...p'f. iJtns...n
\r!jlbbof,prf

\r!~..prf
.iJlIoIW

\r!PDFfllt.f.prf
\r!"u.l>old prl

.iJl'PO
\r!o..ori<CIoIS.prf

\r!ShaP<K/fTl'ling..prf
mToblo..prf

mTYF>OTtlck..prf
I:!WIb.prl
mWlbTool,prf

\r!nlLlmpon.prf ...~.
""'... .

0- 0 (I~- ~- '[ijj.
!b<--~o,~.IJ"-~ I ...1.Typo.

I ill
~t j~ ~§~!
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. 6 e MORE INSURANCE-AUTO SAVE

A+>Plicalion
Displav
Interactive
Saw

11"<1"

~
ProJKtl.dv ,

II!I~,"..~- 'oth, SOY,
P'""

of Appli"tio"

P"''''"'~'E~ry1'8"1 mlnutts turn onAutoSave.Althoughthe best tip

T'-
for!iavingisCmd-SorCtrl-S,theAutoSave

. featureletsyourecoverfroma crash!And it

doesn't save over your original working file-thank heavens! Instead, there's
a temporary file of the same name with an extension .5$\1tacked on the end

of the filename. It's gone when you close your project. But after a Quark or

system crash, open the file and click OK to a warning dialog, which directs you to

File> Revert to restore to last auto-saved version. Another cool benefit-

if Auto Save is on,at any time you can retrieve the last auto-saved w:orsion by

pressing Option or Alt with File> Revert to Saved, which affects all layouts in your

file. In Save preferences. tell Quark how often you want an auto-save. The default

of 5 minutes is probably more often than needed,especially with large files.

8 6 ~ TAKE OUT INSURANCE-BACK UP FILES TWO WAYS

Maybe it's too hard to remember backups,
so check Quark's Auto Backup feature in the
Save panel of Application preferences.

Choose the number of backups you want

and the folder to save to.The default location

is the same folder as your project Each time
you !;ave,Quark creates one backup, up to

the numberyou specify. Becauseeach back-
up is as large as your original file, you might

want to only have two or three backups.

Each backup file has the original filename,

followed by a number-safetyNet.qxp has

the backups SafetyNet #1.qxp, SafetyNet
#2.qxp,etc. You'll never have more files than
the number you specify, but the numbers
increment each time you save your original

file. Instead of SafetyNet #1 to SafetyNet #3, those !;ame backups might eventually be SafetyNet#2S

to SafetyNet #27. Ifyour file starts to get flakey, turn off Auto Backup so the backups don't
get corrupted.

51""Undo
XTeno,o",Manaqer

~?;-
~;",rwo<;~v

868

I
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I
Kor""
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~.""'"
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8 6 0 GETTHE PRINT BOXTHE WAY YOU WANT-PRINT STYLES

Your Print box settings are saved
with each file and layout. They are
remembered even after switching

files or printers within one Quark
session and after re-Iaunching. But
print styles really make it easier. As
your file goes trom design through

production, you need different sets

ot print options. When designing,
how about a style to print spreads

~ - usingcomposite
CMYK? When

proofing text, you might use a style

that turns down your picture output to low Resolution Of Rough for taster printing.Then,
when finishing, grab a third style tor color separations. Don't choose settings over and over.
All you have to do is choose Edit> Print Styles, set up a style or two, and those styles are
available in the Print dialog for every project you open from now on, even if you had a file
open to start with.

~-""""""'''''''-

~: ~
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.

~1IOUgh
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8 e @ SERIAL NUMBER? ENVIRONMENT DIALOG HAS IT AND MORE

I

~-
, ~'"m"" I~""'

.

' ~
'

I

:::::::: -::':::-'- -- -~
I;

01"--. U~,-

--, --,..
~~

Here's a slick little trick that you can use to
impress your friends and colleagues. Bring up

Quark's Environment dialog. which is buried
in a shortcut (Option-About QuarkXPress,
QuarkXPress menu, or Cmd-Dption-Control-E

for Mac;Ctrl-About QuarkXPress, Help menu
forWin).lt tells you everything you want to

know about the"environmentHthat Quark is
running in-Quark version number, serial

number, operating system version number,

and more, plus a list otthe XTensions that are

installed. So, it you ever need to knOW,don't

hesitate to look inQuark'sbackcloset!
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Unlike Application preferences, which customize Quark as your work

space, Print Layout preferences (formerly called Document preferences)

are saved with the Quark file. Whether you set up a measurement system,
put guides in front or back, or change how layers, trapping, and tools

work, these settings can be kept intact when your layout is opened on

another computer. You can also set up djfferent preferences for each

layout in your file. But even better-customize Quark at a global level by

setting Default Print layout preferences when no files are open. Press

Cmd-option-Shift-Y or Ctrl-Alt-Shift-Y to quickly open preferences. Once

you're done and you click OK, your changes to Default Print layout prefer.

ences are true for all files you create from now on-but not for existing

files. In short, when a file is open,
it's

just a tweak. But when no files are

open, changes are sweeping.

. e @IT'S GREEK TO ME-GETTHE REAL THING INSTEAD

~ Chlc'90~ Joffrey Ballet-~ Triumphs Again . ChlcagO~ Joffrey Ballet
Triumphs Again

£.:~~ ~=:
~..: =::;;-

When you go to Fit in Window view, don't you just hate those greeking bars that Quark uses

in your layout to indicate lines of small text? (Of course, if you've got a giant monitor, you

won't have this problem,) You can turn them off 50 that Quark simulates actual text. It's not
exactly readable in Fitin Windowview,but at least your layout lookslikea real page seen
at a distance. In the current layout, press Cmd-Option-Shift-Y or Ctrl-Alt-Shift-Y, then click

General under Default Print Layout. Uncheck the Greek Text Below option on the right, and

click OK. Now, in a reduced view, your layout looks onscreen like the real thing. To automati-
cally turn Greeking off for all new projects, close all Quark projects, and then turn off

Greeking, What a relief!

~\ 8 CHAPTER 1 .Setup Tips



. 6 e TRADE IN NASTY NUMBERS-.167",.312S",OR .62S"-FOR PICAS

Picas work benerthan inches for designing a
Inchn ,typical page. Inches become decimal numbers-
Inchu Dtclm~

hard to visualize and unrelated to typesetting.

i And, you're prompted to specify indents and

paragraph spacing in inches! But in conventional

typesetting, an indent typicallyequals the point

size of the type. Paragraph spacing is equal tO,or

an interval of, the leading value,again in points.
You can temporarily override inches with points

or picas, but when you apply that number, points convert to inches, and you're back to deci-

mals.Havefun changing it later!Withno filesopen, go to Preferences.Under Default Print
Layout preferences, click Measurements, then set the Horizontal and Vertical measure to

Picas. The large tick marks in the rulers are still an inch apart, but now they mark six picas.

One caveat with picas-use the form "4p"to set margins and columns, because just
"4"

becomes 4pts-that's Quark logic!

PoInts/Inch

Clce,os/em'

o6pica,=1"

0 12p1>=lpica

Poin

Millimeters

Centimeters

Cieeros
Agates

0 Ina Qua,kdialog box.entering points and pica"

To,ay 14 points, type p140r 14
pt, 14pt Or 14

Tosay4picas,type4p

To ,ayhmd-1J2 pica',rype 4p6 (foUl pieas and ,iKpoint,)

. 6 6 DELETE BOGUS COLORS FOR ALL TIME

When you're doing print layouts, clean up your color

palette so that colors you shouldn't use aren't cluttering
up the list-or worse, getting applied accidentally. At

Quark's desktop, with no files open, press Shift-F12
(Edit> Colors)- There are three colors in the default set

that you'll want to delete: Red. Green, and Blue-defined
in the RG8 color model and inappropriate in a color
palette used for print. Click on Blue, then use Cmd-click

or Ctrl-click to add the other two colors to the selection. Click the Delete button, and now
your color list is shorter and sweeter. Should you ever want Red-Green-Blue back again, you

can easily create them. Each color is 100% red, green, or blue in the RGB Model, with 0% for
the other two values. You can also restore those colors by deleting your preferences file,

although that might be too drastic.

See iillsoUSiilvea Life-Back Up Your Preferences File" (this chapter).
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. e ft GET YOUR FAVORITE SETTINGS BUILTINTO EVERY NEW FILE

Show Clipboard

Find/Chang!

~:::... 't
HA.I<

DIll Style Item Page Applyinga color,stylesheet,H&Jsetting,or linestyleto text or
Can't Undo XZ items in your layout usually takes two steps. First, make a setting
Can', R~o oX1 using commands in the Edit menu-Style Sheets, Colors, H&Js.

Lists, and Dashes & Stripes. Second, apply those settings from a
palette or another dialog. Forexample,set up colorsbypressing
Shift-F12 (Edit> Colors). But use the Colors palette or the
Character dialog to apply color. With all this back and forth,

wouldn't it be great to have all that setup work done so when

you're on deadline, you only need to apply those settings? If the

KF answer is yes, simply choose these commands when no files are

. open in Quark.The settings will then be in effect for all new files.

y~~2 Instead of makin~ these choices over and over, do the setup work
once and enjoy it In every new layout you make.

Cut XXCopy .c
Paste xv
PaSlelrtlltaCe '\:.o.xv
Clur
Sele(!AII

. e 6 SPEED TO YOUR TOOL PREFERENCES

Setting Tool preferences ahead of time

is another wonderful way to make
your Quark life go easier and faster.

Do this when no files are open so that
your choices affect how all creation

tools work forever more. For instance,

set defaults for box frame width,

corner radius, type-on-a-path, tables,

and more. Or you can tweak the

default settings for just the specific
layout you're working on. To quickly

get to the Tools preferences, just double-click any tool in the toolbox that creates an item-
all the box and line tools, plus the table and starburst tools. You can set preferences for
multiple related tools simultaneously. Use the Similar Types and Similar Shapes buttons, Or
Shift-click to select a range of tool icons or Cmd- or Ctrl-click to select non-adjacent tools

Because the starburst tool is a Quark XTension,it has a separate Preferences dialog.

.~-~-~-~-0-~';
/ + 0 N
~6t--I;>it"..
0..
W3

~I
~I
(''''::J

~\ '0
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. e 8 GETTHE RIGHT RUNAROUND EVERYTIME-AUTOMATICALLY

r to. I ~... I fAml ~
~~~:~ ~1:fsa~I:;~~~:a~u:s~~~;~ f:~eps

text from disappearing under pictures, but

it's never enough for prime time.
Typjcal

runarounds range from 9 to 12 pts.By
setting the runaround when no Quark files

are open, your runaround works for all new

files. Double-clickthe Picture Boxtool in
the toolbox to open preferences with Tools
highlighted and the picture box icon

selected on the right. Click the Modify
button and then the Runaroundtab at the top of the Modifydialog. Quickly enter the

same runaround in points for all four sides of a box by pressing Tab to highlight the first

runaround text field and enter a number;then repeat Tab and the number three more

times to complete all four runarounds. Close the Modify dialog with Return or Enter. Now
repeat for the rectangular text box. Note, you can't set runaround for multiple tools at once.

Tyl>'!. litem

~Top

12 pi

~
RlllIII: GLJ

It

.,.

Modify

. 0 6 SET PICTURE BOX BACKGROUND COLOR TO NONE

You'll no longer see a white back-

ground when you put a text box

over a picture, colored box, or line.

In Quark 6, the default text box

background color is None. Picture

boxes, however, still have white

backgrounds-not good if want to

overlap cutout images and irregular-

shaped graphics. Even with simple

rectangular images, you don't want

an unintentional edge of white space to show when you overlap that picture on another

color. Set all picture box backgrounds to None ahead of time. With no files open, double-click

a Picture Box tool in the toolbox to open Tools preferences with the Picture Box tool icon

already selected. Click the Similar Types button to select all the Picture Box tools. You can

Shift-click to select a range of box icons, or Cmd- or Ctrl-click to select non-consecutively.

Click Modify, then click the Box or Group tab and choose None for Box Color.

IOi Plaure Frame Ru

'
BoX

Color:

Shade:

D. Black. Cyan. Magenta. Registration
10 White

0 Yellow
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GET COMMANDS WHERE YOU ARE-CONTEXT MENU

fit In Window
ActualSiZl!!

Ever need a command but don't

remember the shortcut? Not crazy about
keyboard shortcuts? The context menu

makes commands available to you on

the fly, in a popup menu on your page.
Exactly which commands pop up

depends on the tool and elements

selected (or not). 10 short the commands

are customized. For instance, if you have

a text box selected with the Content tool,

the popup menu includes Get Text, Save

I Text Send & .Bring ~ommands, Modify,

and more. With a pICture box selected

with the Item tool, you get Get Picture,

Fit Box to Picture, Cut, (opy,
and Paste,

plus more. Even when you click a blank
. I spot on the page or pasteboard, you get

another set.

Use the context menu also on lines, rulers, text paths, tables, and some palenes-wherever
your mouse happens to be, Press Control for Mac or right-click for Windows.

Conttnt

Get Picturt...
Fit Picturt To Box
FItBoxToPicturt

Cui
Copy

Paste
Paste In plan
PrtvlewResolutlon

"'
''' IHyptrllnk

Anchor

. Mac: Pressthe Contralkey-

. Windows: Clid the right mouse button.

See also (Mac onlyl~Get Back theZoom Tool Shortcut that Quark S StoltN (Chapter 3).
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. e e REMEMBERING KEYBOARD SHORTCUTS

Ways to remember those darn keys...

Cmd or Ctrl.Asidefrom the standard keyboard shortcuts listed on the menus (such as
Cmd-$or Ctrl-$to Save),and some that are Quark-specific(such as Cmd-M or Ctrl-M for
Modify), the only time the Cmd or etrl key is used solo is to allow you temporary access

to the Item tool when another tool is selected. That's really handy when you've got the
Content tool, which you probably use most.This is one of the most important tips in Quark.

Shift. Aside from helping out in the key combinations, Shift has two reasons to live-

constraining and multiple-item selecting. To move an item on one axis only (left-right or
up-down), press Shift as you drag. But if the item is already selected, press your mouse

button down first, then add Shift to avoid deselecting the item.

Option or Alt. Think of this as the kclean upkkey. All those oddball things that use just one

key, aside from the above mentioned, are always Option or Alt. What gives you the Grabber

Hand? What turns the Zoom-in tool to a Zoom-out tool? What changes Find Next to Find

First? The Option or Alt key does all this-and more!

Combos. There are a lot of combo shortcuts that use all three power keys-Cmd-option-Shift

or Control-Alt-5hift.lt's hard to remember such a mouthful. 50 turn that jumble of syllables into

something fun and memorable, like"lean on the keyboard."Scale a picture box and its image?

lean on the keyboard and drag. Fit the image to the box? lean on the keyboard plus F.lt sticks!

s..also'"FastTntdctoTntdcand KemtoTightenHeadIines"'{~8) and"KeepaTodForeYer'"(Chapter3).

CHAPTER 1 . Setup Tips 13 1r4
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. e @ LAUNCHING QUARK FASTER BY REMOVING PPDS

0""

I:JRe~ource

'-'
'0

tJContents
iJPPDsI ofHI I.." jJ PrInters
~Ubrilry

ilnp8BrahmsUndone
iii n~IIEd.Warren'sComputer
iii n~

! ~:;:~:,':.:; 1
IiITKP180Pl.PPD.ilZ I
Ii) Tkp780p4_ppd-ilZ

Iii!tkpIB5X.Ppd.9l

Iii!lkP2B5x-ppd.vz

11XI'H7401.Pm.9Z

IIIT1<I>hH04.lIPd.9l

iilnPH7801.Pf'D-9"
t=II

""-""OA~A~.

Does it take longer than it should for Quark to launch?
Having lots of PPD files in your system is making it

worse. PPDs are Postscript Printer Description files that

let you customize your Print boxsettings based on
the particularfeatures of your printer. Although your
printer PPD was installed in the operating system

when you installed the printer, there may be many
more PPO files that came with the system or were

installed with other programs. To speed up Quark's
launchtime,move allthe PPDfiles for printers you

don't own or use to another folder. Do it now and get
it over with. Reboot your computer so Quark can take
advantage of your slimmed-down list.

. MacOSX: Find PPDs in you, as X boot drive> Library>

Printers> PPDs> (ontenl5> Resources> en,lproj

. Windows: Find PPDs in (:IWINDOWS\SYSTEM31\spool\

d,jvers\wnx86.The,eilrelWofolders:2i1nd3.YouCiinput

yourPPDs into eithe, folder and QUilrk will find them

. e 6 SHORTENING YOUR TIME IN THE PRINT BOX

~ IiIII'mimI!D When you go to the Setup tab of the Print

1--':;
=="-S"- ~ .,.

.

ct from the Printer DescriPt

,.

ion

~ ::==:~ POPUP,d70YO~ havea.long list to wade

--,- :::::::::::::;:., :::::~;::::~
through, Agaln,g~trldofu~necessary

;:::::::::::::- ~~;;;;d,"" PPDs.(Seeabove
trp,)Removingthe PPD

;:~=::::::::
"'"

files from your system folder will solve this

:..::- ~=::=::~ r problem, but th~re's another way to ~hort-

--'''''''
:::::::::::::::::::::' en your printer list. From Quark's Utilities

~ ~~:::::::::::= menu, select the PPDManager,where

'''''-'
'~ ;::::::''''';

you'll see a long list of printers. Each has a
PPD in your system. Uncheck every pnnter

you're not using so that your PPD list in the Print box only shows printers you're using.
In the PPD Manager, you can click Update to have the changes take effect immediately.

Otherwise, your changes will be updated the next time you start up Quark. This method

doesn't reduce Quark's launch time, but it does make Printing easier-from now on.

~\ 14 CHAPTER 1 .Setup Tips
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. ~ 8 PICK YOUR XTENSIONS AS YOU LAUNCH QUARK

:':- When you install Quark, numerous

~: ><Tensions are placed into the

:::: XTe~SjO~folder inside the Quark

-
application folder.When you launch

:::: the program, they're all turned on- by default. XTensions are great, but
you don't need to have them all

open allthe time. Eachone uses RAMand causes Quarkto take more time to launch. But

you can turn XTensions on and off on the fly,as Quark launches. When you see Quark's

splash screen come up, just press the Space Bar and don't release it until the XTensions

Manager displays. Then uncheck to deselect any XTensionyou want turned off.Once Quark
Isalready open and you change yOUTmind,you can go to XTensionsManager (Utilities
menu) but you'll have to quit and restart Quarkfor the XTensionto be activated.

....
i

C...,omll...h00 ,

fYlI"'.lu'lon-
G<.oldt""'-,
tm.I.T'>d~
:=Mo~
~""SeG...nc.

Sugg.sllons for XT.nsions to turn off:

. Not using Qu~,k for web work'Tum off Im~geM~p ~nd PNG filter.

. Not using XML? Tum off a~enue.quark, Item Sequence

. Tum off the... features if you're not using them

'ndel(. Kern-Track Edilor,OPI
(swapping in hi-res images at output) and QuarkCMS (color management).

. ~
eXTENSION SETS FOR OIFFERENT CLIENTS ANO PROJECTS

XTensions-they're great when you need them, and when you

don't, put them away, But instead of just turning them off and

on repeatedly, create sets of XTensions to use for different

clients and projects. For instance, when you're doing full-colof

jobs for a high-end workflow, you can turn on OPI, Quark eMS,

text and picture filters, Custom Bleeds, Guide Manager,

Kern-Track Editor, and Type Tricks. By opening the XTensions

Manager when you're launching Quark (see previous tip), you

can create an XTensions set that will take effect immediately.

Just check all the XTensions you want turned on in the Enable

column. Click the Save As button at the top of the Manager,

and type in a name for that set. The new set is already in place

in the Set
popup,

where your other sets are found, If you're on your way to opening Quark,

your new XTensions set goes right into effect.

IT
:
0:.
-Korn.T..cllfd~o,
...s-WOrd6-1000f'~.,

01'1PDl'f;~.,
PNCfilt.r
Quarl<CUS
RTl'RIt.,
Sc,lpC
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Thischapter continues the themes ~of time-saving setups and working ~
systematically.Beingmore systematic
with Qlayout letsyou spend more time

The ~~~~L~2E!!!~~
creating and less time producing. For

instance, find out the best and only good

use fOf the Auto Text box. How about tips

on getting the most from master pages, on

indispensable tool fOf multi-page layouts? My

favorite is instantly aligning identical headers

or footers for facing pages with virtually no

dialog boxes. Thot's a technique that can be

used in many other situations. Or, once a

layout is underway, how do you change the

basic print layout settings you started with,

such as page size. orientation, margins, and

column guides? Finally, take Q few minutes

to set up powerful and fully developed

templates that let you rip through production

of one or more layouts. Create libraries to

hold all those things you keep using, such as

logos. Pretty soon you're on your way to being

a sassy Quarker.

CHAPTER2 . MasterPages&TemplatesTips 17



.66 GETAGRID

How many columns should you use? Based on a standard page, the two most common grid
choices are two and three columns. Two columns get the job done fast. It'seasier to layout
text and pictures because there are fewer decisions-just size pictures and text boxes to

the width of one or two columns. But the downside is that it can be a bit boring. Pictures

often end up larger than they should be. especiallyhead shots. Using three or more

columns makes a more interesting layout because there are more chokes for sizingitems
and, consequently, more size contrast-always desirable. A picture can be the width of one,

two, or three columns.That also means more items on the page, more decisions,and more
work. But, when marketing is the goar, a page with many columns is often the answer. It's
more engaging for the reader and so more gets read!

~I~
~m
E~. =- .==...---
::::: ~~:~-
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. e @ STRATEGIC MARGINS-USING WHITE SPACE

Do you use equal
margins?Theygivea

formaland static look.
8utyou can give the
page a more dynamic
look with unequal
margins. Build in more

white space with a
wide margin (more
than Bpor 1.33")
paired with a smaller

one (4p or .66").

Another idea-if you

have a facing-pages
layout where each

.i:.;t-;:; f~r: ~~~,~.
:~;:~i;::t:j~:I:ne
heading, you can puU

the pages of the
spread together by

using a large outside

margin and a narrow

inside margin. But

when there's a single
topic per page, use
margins that empha-

size the individual
page over the

spread-a "modular"
layout of unequal margins. In other words, give both pages of the spread the same combi-
nation, such as wide left, narrow right. Or try emphasizing the horizontal movement across

the spread, using big equal margins on the top and bottom and small equal margins on

the left and right. Reverse that for vertical movement.

See also "Use Margins to Clarify Your Content" (Chapter 13).

fl~}1
~~i "\t=~~

I

ri;bi~~l~:i;~
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1
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Sometimes it's
just nice to know what the graphic standards

are. Not that you have to go there, but at least you know

where you're departing and you've got a point of reference.

Setting the gutter width in the New Project dialog (Cmd-N

or Ctrl-N) for the space between the columns typically calls

for one of two numbers. When you've got three or more

columns, the gutter width is typically lp (or .167").This

number gives you just enough space to cleanly separate

columns, but not so much that your eye gets stuck in the

gutter. With two columns on your page,
you've got a longer

line length and your gutter width can be more generous-

1 p6 or .2S". And, if you're adding vertical rules between

columns, it's
likely you'll want to add another 6pts-l

p6 for

three or more columns, and 2p for two columns.

888

. 6 6 WITH THE AUTOMATICTEXT BOX. YOU GETLINKING HEAVEN

!

I!!IFaclnQPaQO.

l\"u,omolicTox'80x

The Auto Text Box is a great solution for
layouts where text runs sequentially, column

after column, page after page, throughout

the layout. Pictures can be anywhere. but

the text never quits---or not until every

word is in sight. In File> New> Project
(Cmd-N or Ctrl-N), click the Automatic Text

Box option. No need to draw text boxes.

There's one ready and waiting on page one
with the columns you specified. When you

Get Text, pages are automatically added to

accommodate all the text in the file. (Auto
Page Insertion must be on, and it is by

default. in Default Print layout preferencesJ.
linking Heaven means no linking!

P.5. If you want to import another text file at the top of a new page, but can't get the insertion
point to go there, see also "'Controlling the Layout with Special Characters~ (Chapter 10).
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. e 6 CHANGING PRINTLAYOUT SETTINGS

To change page size, orientation, or Facing
Pages format, first go to a document page,

then choose Layout> Layout Properties.

Document settings used to apply to the
entire file.but now they're only layout
properties and can be different for each

layout in your file.Wrth multiple layouts

for different but related projects,changing
Layout Properties settings affects only the

active layout Second, when changing

between facing pages and single-sided
layouts, there are additional,although

easier, steps with master pages. Switching

from single-sided to facing pages?Youroriginal A-Master A page icon in the Page Layout palette is
still single-sided.To complete the conversion, drag down the blank facing pages icon at the top of

the palette into the masters area and onto the A-Master A page icon. Switching to single-sided? Use
the blank single-sided icon instead. Ifyou've set up items on the master,copy them first, then paste
them onto the converted master.

See also NLayout Spaces. N(Chapter 10).

~I 1-

I
~::::'::~"'Oo'

0(..;0 '_1.&......

&~~.'~j~-

.
!I ~ .

~

. e e CHANGING MARGINS AND COLUMNS-SETTINGS DIMMED?

1-

I

IiI'K'"''''''-c,,"utomatiC Text lox

8iamI Layout View VI The Layout Properties dialog looks a lot like the New dialog, but

~ In. ~ howcome you can change the p~ge size,orientati~n,and facing
pages, but can't change the margin and column gUldes?The

answer is, Who Knows? But in fact, when you want to make

;_'~L"~~IIII1"~ changes to those guides, they're not in the same place as they

were when you started. Check out the Master Guides command in

the Page menu. Okay, but wait, it's dimmed! So here's the tip-to
get that command, you've got to go to a master page first. Gee,

Quark sure can be sneaky sometimes! Warning: You may have to

manually adjust the positions and even the size of your existing

text boxes to fit the new margin and column setup-unless you've

used the Auto Text box or set up the equivalent text linking on the

master pages. Note that margin and column guide settings can

vary from one layout to another in the same file,orNproject."

Display

I Pro 'v.1 Ml
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8 6 () AUTOMATIC PAGE NUMBERS INSTANTLY ALIGNED

On the left master page. make a small text box the

width of the column, in the bottom or top margin.

With the Content tool, type Cmd-3 or Ctrl-3.The

<#> sign that appears becomes the page number

on a layout page. Duplicate the selected box for

the right page with Cmd-option-D or Ctrl-Alt-D
(Item> Step and Repeat). Change Horizontal and

Vertical Offsets to zero, then click OK.Move the
duplicate box across the spread so it stays aligned

to the original. Press and hold Cmd or Ctrl to
temporarily access the Item tool, while you press

the mouse down on the duplicate box. Then add Shift, the constraining key, and drag the box

across the spread. When you're there, let go-mouse first, then Shift and Cmd or Ctr!. Now
change the paragraph alignment from left- to right-aligned with the Content tool using

Cmd-shift-R or Ctrl-Shift-R.

urwO

8 e () CENTERING PAGE NUMBERS EASILY

~ Sometimes page numbers need

~ to be centered on the page in the

~_~A'1!I1"'f>l
0.., ",,;.r~:;,:.' top or bottom margin, rather than

placed in the corners,aJigned to the

outside margin guides. Even if your
margins are unequal, getting the page numbers exaetly centered is easy when you realize that

"centered" means with respect to the live area, the area defined by the margin guides. On the
master page, draw a text box for the page number going from the left to the right margin
guide, in the top or bottom margin. With the Content tool, enter the page number marker
by typing Cmd-J or Orl-J to seethe <#> sign, which becomes the page number. Last, press

Cmd-shift-C or Ctrl-Shift-C to center-align the text to the box, visually centering it on the page.

~\ 22 CHAPTER
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. e 4:9 DRAW FEWER TEXT BOXES FASTER-DO IT ON MASTER PAGES

Got a multi-page document? Save time by drawing

text boxes on the master pages, instead of doing it

over and over on layout pages. On the master pages,

draw one text box for each column-a great layout

method because you (an size each box a linle shorter

or longer. on the spot, to make a nice rag-bottom
(uneven columns) or to avoid a widow or orphan. So

here'sa tip withina tip-no more repeat trips to the
toolbox after every box you draw! Instead, get contin-
uous use of that or any tool by pressing Option or

Alt when you click to select that tool in the toolbox.

And with the resultingready-madeboxeson allyour
pages,you'rereadyto roll. You want a box wider or shorter? Just resize it to fit the layout. Need
more boxes? Just select an empty box and duplicate it with Item> Duplicate (Cmd-D or Ctrl-D).

. 6 6 RUNNING HEADERS AND FOOTERS THAT MATCH PAGE CONTENT

1""'-'--
w~",

Some documents with listings are

set up like a phone book.ln the

margin of each page,
there's a

unique running head that matches

the top or bottOlT'llisting on that

page. On the master page. put a text

box for the running header or footer

where it will appear on layout pages.
Type

in placeholder text and style

it the way you want the header to

look. With a facing-pages layout,

duplicate the text box using Step

and Repeat, then Shift-drag across

the spread to the equivalent position

on the fadng master.Next,use the

placeholder text to set up a Running

Head paragraph style sheet for those

attributes. At the final stage of production, for each page in turn, copy the top or bottom listing for

the page and paste into the highlighted pJaceholdertextApply the style and 0f1 to the next...

See also"Automatic Page Numbers Instantly Aligned~ (this chapter).

f::'7-
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~
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. 6 6 LOCKING MASTER ITEMS-A GOOO 10EA, BUT NOT FOOLPROOF

JUd
Masterpagesaregreatforfoote~,auto-page

numbers, logos or other repeating itemS,borders,

and vertical rules that you want to appear on
most or all pages of your layout. Master items

II should usually stay put on document pages.
(Watch out when youuse SelectAllwiththe

. Itemtool-whatever youdo next,yourmaster
page items are also selected!) You can head off

,.
P"",'

Nfl A
. on 00. 'fj#..~ problems by locking master items.Selectallthe

boxes and lines, then press F6 (Item> Lock}.This
protects the master items on your layout pages from getting accidentally moved or sized. Big

but-it's no protection against other kinds of changes. In fact.a locked item and its contents can
be edited Of entirely deleted! To move or size a master item on a layout page,just unlock it with
F6. Don't worry;all the other instances of that master item are still locked.

. e 8 MASTER PAGE PICTURE BOXES-RUNAROUNO OR NOT?

~I.
~\

s~eO~':::,
s~~~~~~

I.posi'lionlDSYSQi'I

Whenyou want a picture in the same place, same size
on multiple pages, put it on the master page. If you

want text on the layout pages to wrap around it. set a

runaround for it on the master. Use Cmd-T or CtrJ-Tto
open Item> Runaround for the selected item. But on

the layout pages, you'll notice the text isn't wrapping

because the logo isn't on top. Select the togo, press F5
(Item> Bring to Front},and watch the waters part! For a

different effect, use a picture as a watermark, screened

back with the type on top. No change to the runaround

is necessary because as a master item, it's automatically

behind other page items and won't cause a runaround.

But be sure it's stacked behind any master page text

boxes. Overlapping text boxes are transparent by default

so your watermark is fully visible.
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. e @ JUST ABOUT DONE, THEN CHANGING A MASTER ITEM <GROAN>

UDU"""'n-o.,",""

On the master page, you change the footer

text;recolor,size,or move an item;change

margins or columns;add or delete items;

then go to a layout page based on this mas-

t!
t"..nd '''')'thing yo" did ooth,

~"" "uP-to-dat~. .. with one exception, and that is

"locally edrted"master items. For example,
if you make changes to the text or picture

contents of a master item on a layout page,

that locally edited content won't update if
you later change that item's content on the

master page.Ukewise, if you locally edit any

item attribute of a master item on a layout

U:

pog'.
,,,h,,

mo,'ng. ""n~o"e<olohng ~
that item won't update if you later change an

item attribute for that element on the master
page. So the tip is,watch out when you locally

change a master item-it may get left out in

the cold tomorrow!

u..~ ""..'~''';'o11

U..."""",n-o.,c,""

U">"~~~'=11

. e 6 KEEP OR DelETE CHANGES-NOW YOUR HEAD IS SPINNING

When you reapply a master to a page in the
Page Layout palene (dragging down a master
page icon onto a page layout icon), what

happens is controlled by the General Print

Layout preference for Master Page ttems-

Keep Changes or Delete Changes. With Keep Changes, the default,Quark retains changes you've

made to a master item that's been locally edited on a layout page. But,nowthere's a copy of the
original master item underneath, or, if you've moved it,at the same spot on that page that it

appears on the master. You'll probably see the two boxes with overlapped text because in Quark 6,

text boxes don't have white box backgrounds anymore. Obviously, you have to delete one of those

boxes. Because Delete Changes has fewer advantages, keep the default setting, And when you

reapply the same or a new master to a page, immediately check master items on that page for

visible duplicates.

Master Page Items

Keep Changes 0 Delete Changes

CHAPTER2 .Master Pages &Templates Tips 25
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. e 6 DON'T RE-INVENTTHE WHEEL-USE DUPLICATE MASTER

606 PaGtuvout

DCJ~IIDJ!IJ
fOi~PIIU.t.~
a&~

,,-~

00 master pages,
you've got some page footers in the outside comers

and some vertical rules.The page number marker and footer text use
different fonts and styling.Nowyou11 need another set of masters to

handle a layout optjon. You could easily create a new master in the

Page layout palette-just drag a blank single or fucing pages icon

..
from the top left of the palette down into the master pages area. But

~ ~:~~e~~:~:~:;~~O~hht~::;:I~~::~:::~h:aA~~~S~;e;. page iconinthe masterpagesarea of the paletteand then clickthe
Duplicate button (looks like two overlapped page icons).Go to the

new master pages by double-clicking the new page icon and make
whatever changes you need.The rest is already in place!

e06 P.J.geu.yaut

DQ~I1illOO

. e 6 ONE TOO MANY MULTIPLE MASTERS

Having a lot of master pages strains the mind with

names like A-Master A and B-Master B. So. when you

have more than a couple, rename your master pages.

Click once (Mac) or double-click (Win) on the master
page icon name near the top of the Page layout

I

I
palette. Then type a useful name with a matching prefix,

such as I-Intro or S-Sidebar.The prefix on a layout page

I icon tells you which master has been applied. But some-

times you can avoid making yet another master-if you

can make a simple change on the layout page that gets the same result. For example. you

don't want the header box to appear on a section opener, as it does on the basic master. If

that's the only change, just delete that header box each time you layout a se<:tion opener.
Admittedly there's room for error here, so carefully proof your hardcopy for these corrections.

'gB-BodY
I-Intro ~

as-Sldpb..~
aF-r~OfItM..1tp~
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. e 6 ADDING PAGES? APPLY MASTERS TWO WAYS

Using the Page Layout palette, you can add pages by dragging

the master page icon of your choice down into the layout
page icon area. But it's

tricky. In a facing pages document, if

t you see a down-pointing arrow cursor, you'll get a single new
page there instead of a spread. Or with a page-icon cursor,

you'll have three pages side by side and no shuffling down of
pages. If you want to maintain your two-page spreads, look for

the little right-pointing arrow cursor immediately to the left of

the page icon before which you want to insert pages, prior to

releasing the mouse. With a single-sided document, the down-

pointing cursor is fine for inserting. The right-pointing arrow

cursor gives you two single-sided pages side by side. With all

~ these variables, it's easier to use Page> Insert (no shortcut).

Enter the number of pages, where you want them, and what
master you'll base them on. Easy.

CHAPTER
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. e e QUARK'S TEMPLATE VERSUS THE REAL THING

Making a Quark"template"takes a second. But go the extra mile to make a template powerful-

you'll be paid back plenty in time and consistency. Use it to produce multiple files for a long docu-
ment (product catalog) or multiple editions of the same file (newsletter). Make anyfile a template
by simply selecting Project Template (*.qptJ from the Type popup menu in the Save or Save As
dialog. Template files open as untitled documents,so they

don't
get overwritten with the stuff

of your layout. But go further. Set all print layout preferences, layout defaults, master pages, and

especially style sheets.From the Edit menu, set up default colors, H&Js, Dashes & Stripes, and Lists.

Add the right number of page!;.Finally, irxllJde all standing items,such as a newsletter nameplate

on page 1.Although
it's time-consuming now, in the end you'll produce a better quality product

easier and faster.

~\ 28 CHAPTER
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.. e 6 DONT RE-INVENTTHE WHEEL #2-APPEND SETUP OPTIONS

"Steal"from existing files to bolster a newer file.Click
Append in five dialog boxeswheresetupworkeats up

time: Style Sheet5,Colors, H&Js,list5,aod Dashes & Stripes.

Then double-click the filenameyou'retakingfromto

~ ~ choosejust the thingsyouwant ina secondAppend
dialog. Select the colors or styles and so on in a list on

the left. Then dick the right-pointing arrow to send them

~
-

over to your side. Descriptions for selected items help you

choose. Shift-click to select a range of items in the list,or

Cmd- or Ctrl-click to select non-adjacent ones.Return a

selected item back to the left side with the left-pointing arrow. luckily, you don't have to repeat this
process to also import colors,H&Js, and the like. When you click OK,a warning announces that all

other types of appended items will automatically be included, no extra charge!

Shorttuts for Commonly Used Setup Commands In the Edit Me~

r _"""N".C
I'J"--'

~I!I

~
---""

MacandWin Mac
StyleSheet< Shift-F11

Colors
H&h Cmd.Op!ion.J

. e 8 "WHAT,WENEEDTHATLOGOAGAIN?"GETALIBRARY

D
r'-~'

,

,

°
,

''''''''.,AU'"
~All

' J
"......

I"~l_..

:~I
I~
~

Make a library to store Quark things you may reuse-
logos, boilerplate text boxes, and combinations of

items-as in a reply form. It's an external file (*.qxl),
so it's easy to share with others. Set up a library with

Cmd-Option-N or Ctrl-Alt-N (File> New> Library).

and give it a name and place. Now fill up this empty

palette by dragging in one or more selected items
using the Item tool-you're making copies, not

moving items. Double-click on a library item to

name it. You can use category names-Logos,
Pictures, Forms-and then just view all-of.a-kind
items, such as all your logos. Or make a long list of
unique names. Use the popup menu at the top

(Labels buttonlWin) to choose viewing a custom label, AII,or Unlabeled items. When you find

what you want, drag it onto the page, making a copy. To remove a selected library item, press
the Delete key.
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Navigating Quark and your projeCt is f3""1
a lot like sleeping. There's no glory in ~
it, but

ir's what we spend a lot of time

doing. That's
why rips fOf these low-level tasks

Don't Forget Your Map
quark interface tips

are so crucial, because you want to fly

through them. After all, when you zoom in

and out, scroll or change pages, you haven't

advanced your project one iota. But just try

to make a great layout without these moves.

Dig in here to find some indispensable tricks

to add to your bag-like getting tempofCJry

oeeen to the Item rool anytime, 50 you can

just hang out in the Content tool. Another

great om~-being able to keep using Q tool

repeatedly without having to reselect ir each

time. And last, an equivalent set of must-have

tips for guides-margin column, and ruler

guides. All in all, these are some of the most

compelling shortcuts, because you'll use them

over and over again.
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. e e ZOOM IN OR OUTTO A SPECIFIED PERCENT-NO MOUSING

You know that view percent field

in the lower-left corner of the
layout window? You can use it to

zoom in and out, but it's not much

fun if you have to use both mouse
and keyboard to do it. An! But you
can highlight that field using the
keyboard, then type the percent

and be zoomed to your spot, in no
time flat. Just press Control-Vor
Ctrl-Alt-V to highlight the percent
field, then type your number (no

% sign needed),and press Return

or Enter to go there. To get to
Thumbnails view, type "T~Double
your value by first selecting an
item or a bit of text in the area

where you'll be working. Then,

you'll zoom right to it. Note that
Quarknow saves your view
percent so that when you open a
file, that view percent is in effect.

. 8 6 ZOOMING WITH BIGGER OR SMALLER STEPS

Sometimes it's handy to just click the Zoom tool, rather than

drag out the tool, to go farther in or out right in the same
area. By default, when you click, the view changes by 25%.
You can set the Zoom tool preference for a different percent.

To quickly get to the Tools preferences, double-click in the
toolbox on the Zoom tool. which highlights the toot icon in

the right panel. Click the Modify button to display the View
dialog. Increase or decrease the Increment-I like 50%. less

clicking is always refreshing. Now when you click,your view

really changes. And remember, if you change the increment

when you have no files open, your change is good for all new

files from now on!

~Cjg
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. 0 ~ FASTEST ZOOM

~
When it comes to keyboard shortcuts, zooming is one

1 £ ==1

of the most important shortcuts. Not because zooming

is hard to do, but because you're doing it all the time.
Every extra bit of time it takes you to zoom in or out can

I

*
,

r . ~~

., ~'.
.

-""
-"l

'~" "~'.~~
.

r5e

~\ :,=~a:- of designing and producing a single project. So instead

i 1m ,fuw"'.,.
,":::'''''''''''

of going backand forth to the tool box to get the tool,
-..,.totnM ", accessthe Zoomtool instead from the keyboard. This

."" isone shortcut you'll be ecstatic you learned,once you
see how much time you're going to save.Then, you can

really feel like you're on a roll, no stopping you.And,to get the greatest benefit and zoom the
fastest,don't just click the tool-click and drag out an area on the page to zoom there.

Win
Control-Shiftcllc~ Ct,I.Spacebar-click
Control-clic~

Zoomout Control.Qptionclic~ Zoomout:Ctrl-Alt-Spaceb.".clic~

"lfControlkeyacfiv<rr.,C""r.xtmenu
"jfControlkeye<:!iVtltesZoom

See alsouGet Back the Zoom Tool Shortcut that Quark 5 Stole (Mac only)-(next tip).

.. e 8 ~~~~~:E
ZOOM TOOL SHORTCUTTHATQUARKS STOLE

Here's a dilemma for Mac users. Have you
been using the Control key for years to
access the Zoom tool? Now in Quark 5

and 6, it doesn't work! The Control key
instead brings up the Context menu. However, you can still get back your favorite shortcut
easily. And, if you do this just once, it's fixed for all files, new and old, even if you don't close
all your files first. Press Cmd-Option-Shift-Y or double-dick the Zoom tool in the toolbox to
open Preferences. In the list under Application preferences, click on Interactive and, in the

panel opposite, at the bottom, you'll see the button called Control Key Activates: Zoom.

Click there to restore your old shortcut. But remember, when you want to use the Context
menu, you'll have to press the Control-Shift keys instead.

5ee also uFastest Zoom" (previous tip}.

ontrol~
AcUvaln: ~Zoom OConl"lual~ U
Contml-S/>Iftar:llvaln,hfopposllffun<llOt'1.
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.6 @TOGGlEBETWEEN1OO%AND200%VIEW

Although 100% view is the most useful view, where you'll usually see a full half-page at a

time (for a standard page). there are many times you need to zoom in to 200%-for reading

and editing small or italic text, or sometimes for checking alignments. For those lucky
enough to have a large monitor, 200% may be more useful as your default view-1OD%

seems too far away. But in any case, going between these two views is a must. To quickly

shift between 100% (Actual Size) and 200% view, use Cmd-Option-click or (trl-Alt-click. Be

sure to point your mouse at the place you want to zoom to first, then do the keystrokes to

go there. When you zoom out it doesn't matter where you click if your mouse is pointing to
the page or pasteboard (not rulers, toolbox, or palettes),

86 UExKullveCOKh:A-OK 86 ExKutlveC~h:A.OK

~~~~1f~=~
ExeCutiveCoaCi

=-~=.:';
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r<mII'''''.I',I''£rn~'£''
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iI.lhrA.()"-f:ZI"''''W~'r<'lrI,.",..,.
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RiiierTips

8 e ~ ~~#T~+~I~!INWINDOW?YOU'REZAPPEDTOANOTHERPAGE!

Do you feel disoriented when you land on

the wrong page after going to Fit in Window

(Cmd-o or (trl-o)? It's not hard to do. If you've

scrolled your page and now have even one

pixel showing at the top of your window that

S ".lfk." "..dcv~b belongs to the page or spread before, then
brood,...:mNiI, whi<hprovllt. i Quark considers that previous page to be the

petilut.~,':=.=~:=:::'; one you're on. And that's where you land

' .
"..-t- when you reduce your view.If you took at

& the page number by the page popup menu,

lower-left screen, or at the Page layout
palette, Quark thinks you're someplace else!

Because Quark stacks pages and spreads
vertically in one large work space, there's a
dividing line that separates each page or
spread from the ones above and below. Make

sure you can't see that dividing line at the
top of your window so you won't feel like
you've landed in a strange land.

808 !;;IFi,:,,"g.Home.II"P:OonYoDo

...,..-,.

. e 8 GRABBER HAND IS THE BEST SCROLLING TIP EVER

If you
don't know this one, you're in for a treat because

Quark's scroll bars are very clumsy, especially the vertical

one. It's almost impossible to predict how far a scroll will

take you, because the distance you scroll the page

depends on the number of pages in your layout In any

event having to use both a horizontal and a vertical

scroll bar is a time-sink when you can be merrily scrolling

on the diagonal and get there faster. And it's so easy,

With any tool except the Zoom tool,just press and hold Option or Alt while dragging and

you've got the hand cursor-Quark's hidden tool. Push, pull, swing it, or drag it and you're

connecting between two points on your page faster than you can say
"Grabber Hand: Let

go of Option or Alt,and you're back with the tool you just had.
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. 0 6 WATCH THE ACTION ON THE FLY WITH LIVE SCROLL

f!\ LNe Scroll ~I~:~~~:~ee g~::~~;:~~: t:C:~~:S~~~i~il~yg a~~~:~~~: a::r:i:~:nd

the hand tool is just not up to the task. Here's when the scroll bars have

their time to shine, except for one small detail-you can't see where you're going, so you go

t-o-o far or not far enough. Live Scroll to the rescue!
By just adding one little old key, you

can see the page scroll as you drag. Press the Option or Alt key as you grab that scroll box,

and you'll stop exactly where you need to-no guessing games. If you find you really like

this feature,you might as well make it permanent by turning on Live Scroll, an Interactive
Application preference (Cmd-Option-Shift-Y or Ctrl-Alt-Shift-y),

See idsoMScroll
'n' Go" (Chapter 1).

. e 8 SEE 80TH PAGES OF THE SPREAD

DMounlain.qxp: Heillhts -00 - ut

mr~1riII1!J
i~

~If!,

'
I
~
r-1Page}

'I
Jj
r-1Page2
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Have you ever found this

frustrating?You've got a Facing
Pages layout in a reduced view,

like Fit in Window,and you
change pages, But instead of
seeing the entire spread of two
pages, you're looking instead at
just that one right page? Usually

you choose the Fit in Window

view just so you can see the big

picture. Having to scroll that

page over to the right to see

both pages can be annoying.

So whether you like to change

pages via the Go to Page

command (Cmd-J orCtrl-J),the

Page Layout palette, or the page

number
popup

in the lower left

of the layout window, when

you're in a reduced view, select

an even-number page. The facing

pages vista can be inspiring.



. e @FAST LANE CHANGES-ER, PAGE CHANGES

Getting from page to page is awkward. The Page Layout palette takes up space. Then there's

the page number field and popup
menu in the lower-left corner of the window. But it doesn't

always work when you highlight the number, type a page number, then press Return or Enter.

So you find yourself scrolling through a long row of page icons. Cmd-J or Ctrl-J is pretty good

for the Go to Page command, but try these:

b1endedkeyboard:

. PreviousPi'geo'nextpage

Shift-Page Up Or Shjft-Page Down
(lOp ofth.. page)-drop Shift to go a screen at .time"

. Gotofimpageorlaslpage(topofpage):

M."Shlft-HomeorShift-End!End,only,togotothebottomofthelastpage)

Win:Ctrl.Page Up or (tr!-Page Down

NotuslngextendedkeyboardlMact:. Previous page Of ne><tpage:Control-Shift-KorCoJ'ftrol-Shift-l IDrop Shiftgobylwos)"

. GOlOfi~!pageorl~s!l»ge:Con!rol.AorControl.D

'M~r
u"'"

~ave c .«end option: Cmd.Pl1<)eUp 0( Cmd-Pt1ge Dowl1

"Mem~ry lip: L~ok at rfle .eybocrd, 1\ i, ol1lf1e left of r~e IWO;i.e.
"'gori~ bcri<. err.

. e @ GOING BETWEEN A LAYOUT PAGE ANO MASTER PAGES

Tweaking the master pages can take time-it's a work in progress. So you often have to go

back to the masters when you're on a layout page. Here are some speedy tips for getting
there, and if you like master pages, you may be using multiple master pages and want to
cycle through them:

Win

,Gobetw n~ I~youtpage Shift.f4
ilndm~stetpages

GotoneXlm~slerpages Option-fl0 Ctrl.Shift-f4

Gotopleviousmilsterpages Optioo.Shift-FI0 Ctrl-Shift-F3
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. e 8 UNDO-UNDO-UNDO-UNDO...

Rfilo~: [Cmd+5hlft+Z CI

Youcan breathe a sigh of relief-Quark 6 offers
multiple levels of the Undo and Redo commands!

The easiest way is still using Cmd-Z or (trl-Z n-Z
Undo," I always say), but now you may like the Undo
History popup menu at the lower-leftedge of the
layoutwindow, right next to the page popup menu.
By default, the Undo menu holds up to 20 actions that

t
can be undone-but not out of sequence. If you want

f to undo the fourth action back, you'll have to undo
Y the three that came after.Redoisnow Cmd-Shift-Zor

Ctrl-Y and also has a Redo History palette, right next
door to the Undo History popup. To extend your

Undosand Redosup to 30 actions,or change the

Redo shortcut, go to the Undo Application prefer-

ence-Cmd-Qption-Shift-Y or Ctrl-Alt-Shift-Y.

!~
lrIdoT."8..~
lrIdoT thoneo
\MoT...,..o-ao

"-1'80'.lrIdoT,..o.g
lrIdoTJPog

d!i!!I::::"

MaximumHistoryActions; ~

. e @GET PICTURE WITH THE ITEM TOOl?

From:! tJMarquuasllland.

Everyone knows that the Item tool is the

move tool. It's the tool that knows the

boxes, not inside and out, but just the

box-no content, So why is it that while

you must always have the Content tool

to Get Text (some things are sacred),

when it comes to pictures, anything

goes. Sure, go ahead, use the Item tool

to Get Picture (Cmd-E or Ctrl-E), it works

fine! There's no logic, but happily
it's less

to do when you're getting a picture. You

probably won't have to change tools.

n
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8 6 ~ TEMPORARY ACCESS TO THE ITEM TOOL ANYTIME

0
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At any time, with any tool except Zoom, you

can get to the Item tool but skip that trip to the

toolbox. Typically, you have the Content tool-

format, edit text, and adjust pictures. But to

quickly move a box, just press the Cmd or Ctrl

key and presto, you've got the Item tool for as

long as you're pressing the mouse down. Ever

try to move a guide with the Content tool when

you're over a selected picture box? Now you
know how. Or, got the tool you need next but

you forgot to select or deselect an item? No

stopping to run to the toolbox just to get the

Item tool to select or deselect. And no second

trip back to the toolbox to reselect your original

tool. No, you just press that magic key, click on or

click off, then forge ahead.

8 6 6 CONTENTTOOLIS NOT JUSTFOR CONTENT

t+

i
~
~

Quark is finicky about some details and could care less

about others. The Content tool is a good example. It's
supposed to know contents-the text or picture inside a

box-but not a lot more. Yet, with the Content tool, you

can scale a box or move a line by dragging or nudging!
You can select multiple items (use Shift or marquee),

move them, or even group them (Cmd-G or Ctrl-G) with

the Content tool! But. by some other logic, to copy and
paste a line or multiple selected items, you need the

Item tool. And here's a gem. With the Content tool, you
(an cut or copy any item-box and all. Cmd-option-X or

Ctrl-Alt-X to cut. To copy, just replace the X with a C.So

there you have it, the new user is befuddled, but those

in"the-know lap it up, and life is easier in the end.
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. e 8 TOOLS WITHOUTTHETOOLBOX

Youcan get to be such a Quark-geekthat you virtually never go to the toolbox. Instead, rely

on the keyboard to take you down and up the toolbar. But doing a fast switch between the

Item and Content tools is what we do most, so naturally there's another shortcut just for

that-Shift-F8. Although you can get to the Item tool temporarily, pressing Cmd or (trl,

there are some things for which Quark simplyinsistsyou have the correct tool or you just
can't do it-the Item tool to nudge a box a few points in any direction and the Content tool
to get some text and nudge a picture inside a box. Of course, occasionally you might need

some other tool. Follow the chart, and give these shortcuts a try!

Go between Item
and Content tools

Go down taoHw

Go up tool bar

Shift.Fa
Shift.Fa

Cmd-option-Tabor Option-F8 Ctrl-Alt-TaborCtrl-F8
Cmd-option-Shift-Tabo,Option.ShifH8 Ctri-AIt.Shift-TaborCtrl.Shift-F8

.. 6 8 FASTER ACCESS TO"FLY-OUT"TOOLS

"" ~
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Are you sometimes caught second-guessing

wherethat"fly-out"tool is buried in Quark's

toolbox? Or maybe you keep using one of

those hidden shaped text or picture box,

line,or text-Qn-a-path tools? Here's a great

tip to expand Quark's toolbox so that the

tool you need is visible on the toolbox. Just

press and hold the Control key (for both Mac

and Windows) as you press your mouse

down and drag out to select a fly-out tool.

When you release the mouse, that tool has

been added to the top level of the toolbox. If

you
don't delete your preferences file, your enlarged toolbox will be displayed every time you

launch Quark.To tuck that tool back in,just Control--click on the tool icon. If you're really

obsessed, you can do this 18 times to display all 28 tools at one glance.
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. 6 8 KEEP A TOOL FOREVER!
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Have you ever noticed that when YOU

.

use almost any

tool except The Big Two-Item and Content-you get
only a single shot at it and then it's gone? It's morphed

right back into the tool that you used last. Butyou

weren't finished yet? You've drawn a box and want to
do another, but now you're back with the Content

tool? You've rotated an item, but to do it again, it's
.:.::::::::.:.:::::::---: back to the toolbox? These are familiar stories in the

legends of Quark, but there's a shortcut in shining

armor who can solve your problems In no time flat.

When you go to the toolbox to select a tool you want

to use more than once, press Option or Alt as you click the tool. Now you can draw lines and
boxes, rotate items, and make multiple scissors cuts to your heart's content.

See alsoUSave Endless Time When You've Got Lots of Links~ (Chapter 7).

. e ~ SEE THE PAGE WITHOUTTHE MESS

Quark is a busy visual environ-

ment. You've not only got the
margin, column, and maybe ruler
guides, as wellas allthe text and
pictureson the page, but there

are also all those boxes with

their dotted-line edges, when

they're not selected. It's a
wonder you can see what you're
doing! I find myself constantly

using this shortcut to get a quick

take on the state of the page or
spread, especially when

I'm in

the Fit in Window view. Press F7 to quickly hide all the non-printing stuff and the box edges. Call

it"PrintPreview."Thistip worksgreat with the tum-off-greeking tip.

See also U!t'sGreek to Me-Get the Real Thing InsteadW IChaptti!r 1).
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. e e ~~~~E;~~I~~~~~~N
MASTERS ENSURE

Everyone knowsthat putting text
and pictures on master pages means

~ they'll show up on every page. But
putting a ruler guide on a master
page can be just as useful to indicate

an exact place where the tops or
bottoms of items can snap-to on

some or all layout pages. Let's say you

want a layout where various-sized
pictUres will hang from the same

point on every spread. By marking

that spot with a horjzontal guide that
goes across the spread, you (an snap

all your picture boxes to it. Go to the

master pages, but don't drag out a

spread guide. It won't work. Because
spread guides on masters don't show
up on layout pages, you've got to
make two separate ruler guides for

the left and right masters-and line them up exactly. Check the Y position of each ruler

guide on the Measurements palette to make sure they match up.

. e ~ SNAP-TO-GUIDES IS FOR 99% OFTHE TIME, BUT...

Snap-to-Guides (Shift-F7) in the View menu is on by default.

That's good because almost every time you move a box or a

line, you're snapping at least part of it to a margin,column,
or ruler guide. When you're just pixels away, the guide keeps
the item aligned by sucking that thing in like a vacuum

cleaner-clean, neat, and fast. But sometimes that magnetic
pull is just what you don't need. Maybe you're using a ruler

guide to line up body copy by the baseline across columns. But just as you get that baseline
close to the guide, the text box snaps instead to another guide. You can nudge the box one
point in any direction by pressing an arrow key a few times when the Item tool is selected.
Or quickly turn off the snap-to by pressing Shift-F7.But don't forget to turn it right back on,

you'll need it.

~now
"'UIO~S tf

~:~~~::~~
Grid

~~,
Hld~Rul~rs .R
Showlnvi$ibln XI
Hld~Visuallndicalors
ShowfuU-rnpreviews.
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. e 8 POSITION A GUIDE NUMERICAllY WITH X AND Y
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picture on the page and you want to top a!lgn

f-
'-

Ire oemoj{rapnlC other pictures to Itlfyou ~se the s~~e/Align

-. pi:tUAldth.280.coo box, you may end up moving theonglnal item

spectl1!01Softefsoldvert&- Instead. A perfectly positioned ruler gUide

"", CO"""". """",SOlS." easily does the trick. Start by noting on the
bondatbn5aclll.nce b Measurements palette the Ycoordinate of the

~X,
- ",I''''''pi,,",,,i"pi'''mi",h",,~m,"''

Y: ~ howmanydecimalplaces.Then,withanytool,

I
drag out a ruler guide from the top ruler
and read its changing Y position on the

Measurements palette as you drag. When the number it displays exactly matches the number

you noted for the picture box, let go. Now snap in the other items and they will be identically

aligned.The tip also works for spread guides. For vertical guides, use the X coordinate.

. e 6 ~~iE;il~lSl:g;~ZONTAl
DR VERTICAL GUIDES IN

---

.

=~. -~~~ -=~~-_'h-. .=---:::.."':'.':;::.. .=;;;.

- - - -. . -- ---_.,.~~::='.__:::-.~'::-':

Some people just love using guides. You can temporarily

forget numbers and just snap things to a guide to align

them. But, before you know it, you've got a ton of guides

on your page. This tip is great be<ause you
won't have to

decide which is worse-dragging each guide back into

the ruler or leaving your workspace a mess. Instead,

with one swoosh of the magic wand (oops,
that's

Photoshop!), you (an kill them all with one blow. well

okay, maybe two. First, scroll your page so there's no
pasteboard between the page and the horizontal and

vertical rulers.Then,simply Option-click or Alt-(Iick on

the top or side ruler and the guides are history-that is,
just the horizontal guides or just the vertical. But it's just

iIs-"- a small step over to the other ruler and repeat the
shortcut again. By the way, this only works for pages,

not spreads.
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8 e 6 LIMIT GUIDE CLUTTER-SETA VIEW THRESHOLD

You often use a guide when you're zoomed in and can really see what's going on. Then you
zoom out to a larger view and behold, your page is ridden with guide clutter because you've
already dragged out a few others. Guides you make when you're zoomed in, however, don't
need to be visiblein a more reduced view.PressShiftas you drag the guide out from the

ruler. When you're done using the guide, no need to delete it, because it's nowhere to be

seen when you zoom out. But zoom back there agajn, at the original view percent or higher,
and it's right there where you left it!
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. e e PLOWING THROUGH THE GUIDE MANAGER MAZE

Quark's Guide Manager (Utilities menu) let's
you divide up a page or spread into equal

units, marked by ruler guides, There are many choices (read "ways to go wrong"), Start out

on a page with a single column (using ruler guides with column guides is confusing). In the

Guide Manager, choose Horizontal orVertkal for guide Direction, then Current Page or All
Pages. Avoid the Spreads options, unless you want guides on the pasteboard. Most likely,

you'll want to use Number of Guides rather than Spacing; you can't use both. To divide
the entire page into three equal areas,enter"4"for Number of Guides, then choose Entire

Page/Spread for Origin/Boundaries Type. Then click Add Guides. The outside guides fall on

the page edges. The Remove Guides button is on the dialog's other tab-Remove or Lock

Guides.Then flip back to the Add Guides tab. So how do you put guides just in the live area

within the margin guides? Clicking the Use Margins check box is not the answer. Instead,

choose Absolute Position from the Type popup, and for your Left/Right or Top/Bottom

values below, enter the X position of your left and right margins (for .5"
left/right margins,

left is.5" and right is 8"), then click Add Guides.

IdePiaument

Direc:tlon'~OLockfliGuldes

tCurrentpage 1:1

I OSpao;lng

I,HOriZOn,...:o's" VerliClI:O:~

Il~::::~ "","'~
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Eventhough you rend to go to other ~programs to create drawings for your ~
layouts, there are many rimeswhen
you con use QuarkSdrawing tools fOf a

Parts Is Parts
lines & boxes tips

quicker solution. Lines alone offer a world of

opportunity with many styles to choose from.

Not to mention that you can create an infinite

array of line styles in the very rich Dashes &

Stripes editor-thinner, thicker, bigger or

smaller gaps, dots or dashes; stripes of equal

or unequal weights; and on and on. But don't

stop there. Quark's Bezier tools, all those line

and box tools that feature a draftsman's Pf!n

as part of the tool icon, can be wielded to

make almost any kind of line Of box-

anything from a heart to complex shapes you

have to see to believe. And if they're boxes,

then you get to fill them with text or pictures.

Once you get into these drawing tools, there's

no telling when you'll come out.
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. e 8 WHEN YOU WANT A STRAIGHT LINE, DO IT RIGHT
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Although the defaultLinetooldraws"straight"
lines, it's the Orthogonal Line tool that draws the

lines we use most-horizontal, vertical, and 45°.

It's easy and fast, no keys required, just click and

drag.Whenyouneed that tine longer or shorter,
just drag the handle, it keeps the line at the

same angle. By contrast, the default Line tool can

be forced into drawing perpendicular lines, but

it mostly likes to draw straight lines at other
angles. It can draw like the Orthogonal tool but
only if you hold down the Shift" key. And if you

extend or shorten that line,you need the Shift
key again. So make life easy for yourself, go get

the Orthogonal tool once by dragging out to
that fly-out tooL From now on. it will be the

default tool in your toolbox.

. e 8 RESIZE LINES ATTHE SAME ANGLE

How do you extend or shorten lines drawn

at any angle with the default Line tool?

Ifyou drag a handle. the angle changes.

But it works when you press the Shift key!

How about for a set of lines? Grouping is

the answer. Drag a marquee to touch all

the lines with the Item or Content tool,

then Cmd-G or Ctrl-G (Item> Group). Now

with one set of handles. you can size the

lines together fairly easily. With horizontal

or vertical lines, just drag a center handle

to resize. But to resize and keep grouped
...

fines on some other angle. your only
choice is proportional sizing. dragging a handle with Cmd.option-Shift or Ctrl-Alt-Shift. The lines
keep the angle and width (weight), but the spacing between them changes proportionally. If the
original spacing is important,then use Step and Repeat to make a new set of lines at a fixed

distance (Cmd.option-D or Ctrl-Alt-D).

:&1t...I. Ioog,-

: ......
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. e 8 FIVE WAYS TO CHANGE A LINE "WIDTH" DR WEIGHT

In Quark,"width" is lineweight,which you often need to change. It's easy to make a mistake
because the quarter-point, half-point. and one-point rules all look the same on screen at

100% view. Don't use Quark's Hairlinewidth with high-resolution output. It's only .25pt-too

thin. Specify .25pt instead. You (an change line weight and other attributes in five places. The

Style menu is slowest. The line Modify dialog (Cmd-M or (trl-M) is great for setting attributes

for multiple-selectedlines, as well as for coloring and runaround. Other options are handier
in the Measurements palene. That leaves the Context menu (Control-dick on a line/Mac or

right-mouse-clickIWin).lt pops up right where you are, has all the attributes, including the
Modify command, and even lets you change a line Content into a text path! last if you just

want to change the weight visually, use the keyboard.

Using Set Ineremenll from the Widlh Menu: Hairline, 1.2-4-6-8.12
M.~ Win

Increase Cmd-Shift-> Ct,I.Shift->

Decrease Cmd.Shif!-< Ctrl.Shift-<

Using 1pllnuements (Add Option or All)
M.~ Win

Increase (md-option-Shift->

Oe<:rease (md-option-Shift.< (trJ.Alt.Shift-<

. 6 6 MATCH A LINE LENGTH TD A BDX WIDTH

Try a different look for your boxes using a heavy
line, top and bottom, the width of the box, but

little to no weight for the sides. First draw your
line, set a good weight. then select the box. In the

Measurements palette, double-click the X value
and copy it (Cmd-C or Ctrl-C). Then switch back to

the line. Choose left Point in the Modes menu.
Then paste the number into the Xl field (Cmd-V

or Cui-V). Do the same for the boxY value,past.
ing into the selected line's Y1. Then, copy the

el::;,,- ~ ~I ~'7 '"
..",

box's W value and paste that into the line's l-
with the default "mode" of Endpoints, you won't

see the
klfl (length). For the line at the bottom, first copy the box's H. Select the top line you

just positioned, go to Step and Repeat (Cmd-Option-D or Ctrl-Alt-D), set Horizontal Offset to

0 and for Vertical Offset paste in your number.

IF YOU

YOi~DTH~

oi.l);;r&-r
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. e 8 GETIDENTICALLY STYLED LINES EVERYTIME

If you've got one line in your layout,

chances are you'll have a bunch. For
consistency, you might want them to look

the same, so set upa default line style.

It's easy. If you've read parts of Chapter 1,

"Setup Tips,"you know that when you
have a file open and set a tools prefer-
ence, your choice is good just for that

layout. If you want that default for all new

layouts,closeyour current files, then set

the preference. Double-click the Line or
Orthogonal line tool in the toolbox to

open the Tools preferences. You can click Similar Types to select all the line tools or Similar
Shapes to include the corresponding Text-Path tool. Then click the Modify button, and

choose the Style, Line Width, Cotor/Shade, and perhaps Arrowheads. Now all your lines will

share the same look the instant you draw them in any new file.

Add some flair with subtle or crazy

lines using Edit> Dashes & Stripes. Vary

a line style by duplicating it, then give

it a name. Or choose New Dash or

I

Stc,,,..M,k,
0°""''''

md"h
by

dragging in the ruler-the more

.

you
drag, the wider it gets. Add another

somewhere else. Change the
gap

space by dragging a dash or stnpe

with the hand cursor. Or delete by

I, dragging it beyond the drawing area.

J The Repeats Every field, below, sets the

frequency of the repeat. Higher num-

bers increase the gap. Fit your line style evenly to your line or box length with Times Width. Or

use Points for a fixed interval. Check Stretch to Corners to fit the line style symmetrically to your

box, which I recommend! Try the Endcap styles. Looks good in the Preview area? Apply your

line style to a box frame with Cmd-B or Ctrl-B. or to a line from the Measurements palette.
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. e 6 YDU LOOK DASHING!
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. 6 6 DESIGNER FRAMES

Here's a contemporary
look with two-<olor dashes

and gaps of equal length.
Duplicate the Dotted line

in Edit> Dashes & Stripes.

Then type: Designer
Frames.~Below that there's

one black bar with the
right arrow at 60%. Move the arrow left to 50% so the dash and gap lengths are equal.

Position field says 50%? Click OK. then Save. With a box selected, open Item> Frame (Cmd-B

or Ctrl-B). Set a width, at least 2pts, and select Designer Frames style. lower down, choose a

darker color for your frame and another fOf the gap, then OK. For extra drama, add one or two
boxes whose frames surround the original box. Draw a box to the outside, about a .5pt frame
width, with box background color None. Then duplicate the box (Cmd-D or (trl-D), and size

and position it so that it fits the inside dashed-line edge. Zoom in to check for gaps. The
layers palene makes it easier.

~
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Let's
say you want to draw a bunch of boxes of different

sizes, making an arrangement of them as you go. Now, you

could draw one box, then duplicate it (Cmd-D or Ctrl-D),

size it, and move it. and then repeat all those steps for each

box in your design. But, you know, sometimes it's
just easier

to draw them the way you want them in the first place. But

Quark takes away your box tool after you draw one. ;-(

This tip solves that problem by letting you keep your tool

and draw as many as you want without the annoyance of

return trips to the toolbox. Just press Option or Alt when

you click the box tool in the toolbox to select it. Now

you've got continuous use of that tool.
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8 6 ~ PERFECT SQUARES AND CIRCLES

1;8
Square and circle boxes can give a layout a very geometric

look, which can be sporty, punchy, and contemporary. As

you're drawing a rectangle or oval box.press the Shift key
and that square or circle just snaps into place. You can also

take any existing rectangle or oval box and turn it into a

square or circle by Shift-dragging a handle. Then when you

fill a square or circle picture box with an image, the shape

of the box immediately pops out on the page. Using a

square and especially a circle text box takes more work.. Don't use paragraph breaks. If necessary, use a pa.ragraph
specialcharacter

(§
or1l) so that the text can continue on

the same line. Then size down the type---the smaller the
size, the more closely the text approximates the box shape.

Justify the text to push it out to the edges.

8 6 ~ NO"X"ONTHATNICE,COLOREDPICTUREBOX

Making colored shapes on your page puts more color in the layout. Text boxes can have

colored backgrounds with the text overprinted or reversed out. Box backgrounds can also
have blendedcolors!But when you have color in an empty picture box, there's an X running
through it and your page looks busier, It's an extra step to remove it, but it's much easier to
see your layout as your work. So just select the box, then go to Item> Content> None. Even
faster with the Context menu-Control-clickJMac or right-clickIWin. Now the box has a

clean-look, even whenguidesare on!

See alsoNOptical Effects with Blends in Box Backgroundsw and NPut Blends into Lines N(Chapter 11).
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Here's one that's fun and an easy
way to create variety in the layout.

Change an everyday box into some-

thing with more pizazz.Justselect

any box on your page, then go to

Item> Shape> and pick one of the

nine shape choices (okay, eight

others besides the one you have).

You can even change a line into a

Concave-Corner box, so long as the

line is at least 1 pt! And don't forget

when you've settled on a box "look,"

make sure you repeat the treatment

elsewhere so it's not just an unrelated

"doo-dad."

. e 0 MAKE A WACKY OR SUBLIME PICTURE BOX

Break out from a blocky look by

reshaping a selected box. Pick the

Freehand box style 0 in Item>
Shape. Now drag any box handle

to reshape it.lf necessary, turn on
Shape Editing (Shift-F4/Mac or

Fl O/Win). Option- or Alt-click on a
path to add points, or on a point to

delete it. Drag a selected point or

move it with arrow keys, or enter
new XP and YP coordinates in the

Measurements palette. Change a

selected point to a Corner, Smooth,

or Symmetrical point by clicking one of three buttons in the palette. With Smooth or
Symmetrical points, rotate an endpoint of a handle to change the curve angle or make the

curve fulleror flatter by extending or shortening the handle from an endpoint, Convert a

straight line segment into a curve by selecting between two points, then click the bottom-

row buttons on the palette. Shape the curve by dragging out from between the new
smooth points.
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. e @ DRAW A HEART-SHAPED OR SCALLOPED CURVE

The top and bottom center points of a heart are comer points with curve handles. Start at the

bottom,click-drag to the right using a Bezier box tool-use Shift to constrain horizontally. Next,

move your mouse northeast and Shift-drag straight up.Then move the mouse back to the left.
roughly aligned to both previous points. Shift-drag down. Now, at the heart of the heart, you'U

break the handles so the curve goes back up. To make that a comer point, drag from the point

pressing Cmd-Control/Mac or just press Ctrl-Fl/INin. Press Cmd or Ctrl, and drag back up the

bottom left endpoint of that curve handle so it looks like antennas. Now move your mouse

farther left and Shift-drag down. For the close,click-drag on top of the first point looking for

the circle-close cursor- Pressing Cmd or (tfl, reselect that last point and repeat the keystrokes

to make it a comer point. Again adjust the handles up and in, like antennas-

j)L)Jr~CJ.~Q~
. e 8 BEZIER DRAWING SHORTCUTS

Here's a bunch of quick ones for making drawing easier.

Move or edit the path as you draw (before or after drawing a pointl:. Pres, Cmd or Ctrl and drag

Delete your lut (selec:ted) point:. DeleteorBackspace

Completing a Buier line:

. Change tools, Can use Shift-FBJMac and Win, and Cmd-Option-Tab
0'

Ctrl-Alt-Tab. Constrain Bezierstraight lines to horizontatvertical or4S"an gle"Shift-click

. Constrain the handles of Bezier smooth poim, to horizontal,venical or 4S'angles: Shift-drag.

Breaka handl..to mak.. th<!curv.. go back th.. other way:

~
(L

. Mac:Cmd-Control-dragthehandle

.Win:Cul-F1tochange,electedpointtoacorner,thenpressOritodragthehandle

Gofrom a smooth point into a straight line:

~\

. Click the square end 01 the out (leading) handle with Cmd-Option orCtri-AIt.then

make your next corner point
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. e @ BEZIER EDITING SHORTCUTS

Editing paths is as important to the end result as drawing. Here are some good ones.

ChanGe a Point After DrawinQls Complete: Select the Point. Then Change...

"'<Ie
Win-

Option.F'" Cul-F1
Oplion.F2 Ctrl-Fl

TOlymmetrical Option.F3 orl-n

Change a Path Segment: Click on It First with Item or
'0"le"1100I, ThenChimge...

Mac Win-
TO<lstraight-linesegmem Option-Shift-F1 CUI-Shjft-F1

To"curved-line~gmen~ Optioo.Shift.F2 Ctrl.Shift.F2
Thendragoutthelinesegmentberweenthe new curve points.

.Win: Change Mlast point drown can al", b<'
made while drowing.

- M"",
Clwng" IIpoint to COrne' whiled'awing

by dragging
/I hondl. with Cmd-Cort"oJ

. e @ FLIP HORIZONTAL AND FLIP VERTICAL

J()
;;;""W:~.6.--O" ~)(%:

-H:"'i"6PiO f€:.O;--[lJV'.!II:

There is a way to reflect a Bezier or Freehand

shape, but it's not direct. Unlike the nice
'n'easy arrow buttons on the Measurements

palette for flipping an image inside a picture

box, reflecting the shape or box itself takes a

bit more doing. First of all, if you're seeing

points on the shape, press Shift-F4/Mac or

Fl0/Win to be in non-editing mode. Now

you should see the eight item handles

that surround a selected shape.To flip

horizontal, copy the W (width) value in the

Measurements palette and for vertical, copy

the H. Then drag a center handle across the

shape to literally turn it over. Oh, but you're

not sure when to stop dragging once you

get on the other side? Never fear, after

you're somewhere on the other side, then

just paste the W or H value back into the

shape and press Return or Enter. Neat trick!
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. e @MOVING A SHAPE OR EOITING POINTS?

-

~\ 56 CHAPTER
4'

Lines & Boxes Tips

Trying to move the path,but

changing the curve instead? Or

you want to pull out a straight line

segment, but you're moving the

whole path instead? First check

Item> Edit> Shape. Is it on or off?

If you're not editing shapes, turn it

off. Use Shift-F4/Mac or F10IWin

to go back and forth. Next, you
gotta notice the cursor.To move

an item,look for the Item tool

cursor + when you're on the
path, not over a point. If necessary.
press Cmd or Orl to get that

cursor-even if you have the

Item tool. To edit a path. find the

pointing-finger cursor with a dot

~ when you're over a point.To

move a path segment,. position
your mouse over the path to see

the pointing finger with a \ ~.
Deleting points is easy. Just

Option- or Alt-dick on a point to

remove it. The cursor looks like a

circle with an kX"through it. The
point is now gone, but the rest

of the shape is still there.



. e e FOR COMPLEX SHAPES. MERGE
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You can create very unusual shapes that

are made from combining multiple

items with the Item> Merge commands.

Select two or more items, including

boxes, lines,or Bezier shapes. Do a quick

Duplicate (Cmd.D or Ctrl-D) to keep a
copy handy, because the merged item

replaces your starters.There are six

commands (!;even if you count joining

points), but your most likely choices are

Union, Exclusive Or, and Combine.

Union makes one shape following the

outside outlines of the selected shapes.

Exclusive Or and Combine are similar-

the areas where shapes overlap become

see-through windows after merging.

But with Exclusive Or, there are editable

corner points where the shapes originally

intersected. So there's more to work

with. Because the merged shape has

the attributes of the item farthest back,

you might Send To Back (Shift-F5) the

item whose background color,frame

weight, and color you want for your

merged shape.
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Let's face it-Quark is 0 boxy progrom. I[A1l
Virtuallyeverything in Quark is Qbox ~
or is in a box. And if it's not a box, it's

Fine Tuning
selection & transfonnation tips

another item that works very much like a box.

You'll find a lot of hidden power in your Quark

work when you master all the ins and outs of

manipulating items-selecting, moving,

stacking, grouping, using the Measurements

palette, transforming items (sizing, rotating,

skewing), and deleting. Just fOf instance, do

you know how to select 0 buried item without

tearing apart your layout? Can you move Q

selected item in one direction only-and do it

two different ways? Try moving one item in Q

group without ungrouping. Then there's a ton

of ways to make the Measurements palette

calculate for you. Make an item or just its con-

tents three times its size or one quarter, move

it over .125", or use the palette to align items.

Can you size type and pictures incrementally

and stop just when it looks good? These are

just some of the gems you'll find here that will

make your work more creative and fun!
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. 6 @ SELECTING A BURIED ITEM

~
.~

One of the pitfalls in an object-oriented program such as Quark

is that you have items overlapping, or stacked, and you can't
select the one you want. You click there, but something else gets

selected. Happens all the time. Some people use the Bring to Front

and Send to Back commands just to get to that buried item. Or

worse, they start dragging the top items out of the way. But you

don't have to move a thing to the side, front, or back. When you

click, but don't select, just click again in the same spot, pressing

these keys;

. Mac:Cmd.Option-Shift

Now each time you click with these keys, your cursor selects the

item at the next level back in the stacking order. It doesn't change

the order, but you can get to anything on the
page,

no matter how

deep
it's buried or what layer it's on.

. e 8 DESELECT ALL ITEMS

Sometimes it's handier

to deselect all items

using a key rather than

clicking off-especially

when you
can't click

off because you are

zoomed way in and

you've got nothing but

items in view. It's usually

whenyou'reprenyfar

along with your projeet

and have plenty of

items on your page. Maybe you need to click off because you want to edit or format text with

the Content tool, but the Item tool cursor is stjll displayed because multiple items are selected.

Can't click off? When the Item or Rotation tool is in gear (or the Content tool, if more than one

item is selected}, try Plan B, your second line of defense-the humble Tab key. Just one hit of

Tab and instantly all handles have vanished. Did everyone go on vacation?
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iKiiierTips

. e e NUDGE AN ITEM DNE PDINT IN ANY DIRECTION

Youwant to move a selected item a little bit

more. It's almost there, but sometimes it's hard

to be totally precise with the mouse. Or,in
another quandary, the snap-te-guide keeps
pulling your item in too far. These are excellent

times to use the arrow keys to nudge a selected

0 item a few points in any direction-north,

"
iedawarten~ go-rraining.com! south, east, or west, so to speak-but only when

~ 0 x: I]~I W: 11p'.iaS .:1
0"

theltemtooJlsseJect~d!(Wi~hthe~o~tenttool

~I Y: np~ H:~ cOI,,"l. ~~I;~:~~,s:~~~~;~~Itni~~::~~~~~n~;:~faa~Ox
~ arrow keymoves the item 1pt, regardless of the

view you're zoomed to. If you add Option or Alt when you press an arrow key, your item

moves in a '/1opt interval. Arrow keys are an excellent alternative to Shift-dragging to move

an item on the same axis, horizontally or vertically.
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. e 8 ~~~~A~~~:AA~g~;;;BRING
FORWARD AND SEND

I
Stacking order means that items in the same

': spot are arranged in front-to-back order, like

~ stacked objects on a table. A headline on a

Sendhckward '\i:.Q.F5.

.

"
. picture is a text box in front of, and on to

.

p of,

_~,'~;': .~~...~ ~-'I ~
'

::~~:~~e i~:~ ~:~tn~:~:; ~~:~~;~r ~~~;r~~
a

Shape .. I the stackingorder (on a given layer)with the
Contenl .. Bring to Front (FS) and Send to Back (Shlft-FS)

commands in the Item menu. But what about
Bring Forward or Send Backward? They're just one step forwardor back.Windowsfolks
already have these commands in the Item menu. Not on the Mac-but press Option when
you view the Item menu to see the "hidden" commands, Or go all the way with keyboard

shortcuts-option-FS (Bring Forward) or Option-Shift-FS (Send Backward). The Context
menu iseasiest of all-press Control and select from the popup menu.

lock
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8 e e CONSTRAIN A MOVE WITHOUT DESELECTING

===--
C::':;':.'::~ §§~;~], ~§§:

~
~:;':.'::::::§§.§§]- f:E§:

Becauseso much in graphic design is about alignment,

it's a lifesaver to move an item in one direction only, so

that it stays aligned horizontally or vertically to its original
position. Constrained moving is really great with Step and
Repeat, setting the offsets to zero, then Shift-dragging the
duplicate to move it so it stays aligned to the original.*

The infamous Shift key, the constraining key in computer
graphics. keeps an item"inline Noshenanigans!But

it's tricky. When you hold down the key, then drag,it
deselects! That's because Shift-clicking adds to a selection,

or deselects it if the item is already selected. Youhave to
fool Quark so it doesn't realize you're Shift-selecting. Press
your mouse down, then add the Shift, then drag. With the

Content tool, use Cmd-Shift-drag or Ctrl-Shift-drag.

~
!;~;:;.:.S;:;;;g§]- f::f.~~§:

'On",you'veS~roffsd. ro uro. u.. Cmd-O

(){

Crrl-O to mok- rh~
copy righr on

rop,throU9houtthor,~"j""ofQuorX.

. e 8 KEEP 'EM TOGETHER

You often want to keep several items
together, easily and repeatedly-for

a product catalog, for example. Each
catalog item has a photo, a caption,

and another text box with all the specs
and prices. And maybe a logo. When

you're juggling these product sets in a
layout, save time by not having to select
all the things that go together each

time. Instead, Group them once. Click on
one, then Shift-dick to add in each one.

Or simply make a marquee by dragging

from a blank spot with the Item or
Content toot and touch those items you

want to select. Then do Cmd-G or Ctrl-G
to Group.Now all items in the group are
selected when you click just one. To
Ungroup, use Cmd-U Of Ctrl-U.
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.. e e SIZE ITEMS TOGETHER

When you have a bunch of text or picture boxes that you

want to size together, use grouping-it's almost perfect.

Say you have a large finished poster that you now want to

make a smaller 8.5 x 11" flyer. Instead of recreating all the

items on a smaller scale, collect them altogether using

Shift-and-click or a marquee (drag from a blank spot to

touch those items you want to select). Then use Cmd-G or

Ctrl-G to make them a group with one serofhandles. You

can resize a grouped set of items visually and proportionally

by dragging a handle while pressing Cmd-Option-Shift or

(trl-Alt-Shift. There's only one catch-the frame widths of

your boxes (if not zero) don't scale, nor do line widths.

If that's not a problem, then grouping is perfect.

Seealso~SavePageasEPSSavestheDay"(Chapter12).

. 6 @ MOVING ANO SIZING ITEMS WITHIN A GROUP

II...
eJS as",
elight'

~~

Just because you've got a group (Cmd-G

or Ctrl-G) doesn't mean that you
can't

work with an individual item in that

group. Perhaps you grouped each picture

with its caption, then discovered that one

caption is too far down. Without ungroup-

ing. you can select one item, move it or

even resize it with the Content tool. To

move an item with the Content tool,

press and hold Cmd or Ctrl to temporarily

access the Item tool.Actually choosing

the Item tool won't work! Size an item

proportionally by dragging a handle

while pressing Cmd-option-$hift or

Ctrl-Alt-Shift. When you need to use the

Content tool to do what it does best-

adjust a picture in a box or edit/format

text-first deselect the group, then click

back on the item you want to change.

1t4

BII eJS as+

_G~:lig~t ~

.
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OpffiordoseP<'lette F9 F9
Opeopa!ette Cmd.option-M Ctrl-Alt-M
Select fi'51 field if Cmd-optior>-M (t,I-AIt-M
palette Isalreadyopen

Hig~ljghtfont field Cmd.Qption-Shift-M Clrl-Alt-Shjft-M

~Iectnextfield Tab Tab

Shih-Tab Shift.Tab

Execute Retum Enter

Deactivate highlighted field Cmd-period Ese

. e e ZOOM AROUND THE MEASUREMENT PALETTE

Getting to know the Measurements palette intimately is one of the first jobs a designer or

production person ought to take on. It will serve you well because this thin palette is the

one you use over and over again, every time you work in Quark.

Mac:

. e e MEASUREMENTS PALETTE CALCULATES MOVING AND SIZING

The Measurements palette is a calculator. It can't

handle your taxes,but it can calculate distances
and scale factors. Sayyou have a boxon the
page and youwant it to be 2p6 (or .417") farther
to the right. In the X field, type" +2p6" (or +.417")
after the current number. Then press Return or
Enter to execute. To move it left, subtract the

number,"-2p6.uTo move it down or Up, add to

~ ~:c~~~::a~ ~:~e:~: :hv:~~~'r~~: ~~~;~~~~~~~

the W or H field by adding or subtracting, as in

"+3p3"
(or -.125"). Or to scale by some percent, type"".s" (multiply by 50%, reduce)

or""1.25"
(enlarge to 125%). If you have a picture selected, you can modify the X% and Y% fields by any

amount, such as +20 (%), -40, "2.5
(multiply

=
250% larger) or /3 (divide by 3).
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8 6 8 ALIGNING BY X AND Y

The pros and production geeks align items by X and Y for three reasons,Quark's
Space/Align dialog is a muddle. Using the Measurements palette is fast and ready to go.

Best of all.you choose which item stays in place and which one moves to align-a privilege
Space/Align doesn't offer. Top- and left-aligning afe easy. Select the item that stays put-
item #l.ln the Measurements palette, highlight and copy the Yvalue to top-align and Xto
left-align. Select the #2 item. Paste into the same field you used to copy, then Return or

Enter.You're done. For bottom- or right-alignment,copy the Y or X of #1, then select #2 and
paste into the same field. Now they're top- or left-aligned. For #2, the one that's aligning,

subtract its H from its Y.Then add the H of #1 fO the Y of #2.0n second thought,just use X

and Y for top- and left-alignments!

III
J:,;;;::= :~:::=

..
~:,~::= :~::~

860 WHEN RULES NEEDTOTOP ALIGN TO OTHER ITEMS

This tip isn't for paragraph rules, but for lines you draw
with the Orthogonal (perpendicular) Line tool. The
problem with a line is that there's no way to specify its
location except from its vertical center line. Because

the thickness of the line lies on either side of that

center line,a picture can't be top-aligned to it.Ah,
but you can if you change the line to a box having

the same dimension in H or W as the line NwidthN or
weight. So when it comes to production, select each

line and in the Measurements palette, change the Line
Modes popup from Endpoints to anything else. Copy length l and paste it into the Wfor a

selected horizontal box or H for vertical. The other box dimension is the line width. For 12pt,

type"p12."Now the upper-left corner of the box can align by X orY to another item.
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. e 8 LOCATE AN ITEM FROM THE BOTTOM OF THE PAGE

~
I like to position the page footer and page number at
some pica unit from the bonom page edge. Moving

the zero point to the bottom of the page makesit
easy!Zoom way in to the lower-left corner of the page.
Thendrag from the inte~ection of the rulers in the

top-left corner of the layout window to the lower-left

comer of the page. You see a floating perpendicular

axis as you drag. On the Measurements palette, watch

the dynamic X and Y locations of the axis. When it says

0 and 66p (11" standard page),releasethe mouse.
Because X and Y still refer to the box odgin, upper-left
corner, put a horizontal ruler guide down for the base-

line of the footer at 1p6 (.25') from the bonom.Asyou
drag the guide, watch the Y location until it says -1 p6

or -.25", Now position the baseline of the footer on
the guide.

' '-u--'-'
v-"--'..'-'-y---g_.'_...
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8 6 @ SIZE A BOX AND ITS CONTENTS PROPORTIONALLY

Trying to size an image or graphic by the
numbers is a very long-winded process.Try
one number after another, typing the per-
cent twice each time in the Measurements
palette, once for X%,again forY%.lf you

eventually hit it right, you're still not done.

You've got to get the box to the same size.

Instead, grab a handle of the box while
pressing Cmd-0ption-Shift or Ctrl-Alt-Shift as you drag out to make it bigger or drag in to

make it smaller. Try the same thing with an unlinked text box-the box and the type get

proportionally bigger or smaller. It's quite useful if you're trying to get the type to fit a specific
space on the page, like the width of two or three columns. When you let go, you can check the

point size in the palette, which reflects its scaled point size.

~URVIVil
'1f5IIrIHollllli1lll.e 0
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. e e SIZE TYPE OR PICTURES INCREMENTALLY

Sometimes you're not sure how you want it until you can see it right. Here's a tip to help you
try on various sizes to see which size fits best-without dragging. Hold down all three power
keys and repeatedly press> to go larger or

< to go smaller.. Mac:(md-Dption-Shift.>or<

. Wln:Ctrl.AIt-Shift'>or<

With pictures. you can have the Item or Content tool. The X% and Y% change in 5% incre-
ments (and the box stays the same size). With text, you must have the type highlighted with

the Content tool-The size changes in 1pt increments.

t~
xx:m;--"1- !!EXT~
~~EJY+~

.do
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8 6 t) TRANSFORMING BOXES

Use the Measurements palette to numerically control box attributes by typing new numbers

or using calculations. On the left half of the palette, the Item side, change the box Width (W)

or Height
(H),

or rotate a box and its contents. Rotatejust the contents on the Content side, the

palette's right half. Size type there, or use X% and Y% to size images and graphics. but not the

box itself. In the lower-right corner, skew an image within a box. With rotation and skewing,

the direction indicated by the icon is a positive number, in .001 degrees. To rotate clockwise or

skew northwest, type a negative number. Change the corner radius of a picture box or, with

the black arrows, flip its contents horizontally or vertically. 00 these also-plus skew text-in

Modify (Cmd-M or Ctrl-M) or double-click the box with the Item tool or, with the Content tool,

Cmd- or Ctrl-double-cljck.

See ~lso"'Measurements Palette Calculates Moving and Sizing" (this chapter).

Distanceae'a"fromzeropo;nt Flip Ho.;zontal

1

Width-Box Rotation-Item I Picture
"'ale

Pktureoffsetacross Rotat,onP,cture

laX,-!;~,iI41. 1~"7-
l-w-~rri::t.'% -I!IBJ.~ 1 ~

Y'~H.~,.o:;O;-- ~~ ~y+~ I~

Height-Box Plctu,eSC<lle
Vertical %

FlipVerticalDi,tance down from zero poin!
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8 e 6 ROTATE AN ITEM FREELY OR IN FIXED INCREMENTS.
~-
+ '. ,,".,' . .;m . ~

'""'''1'1' H'"''
I<.

"
m

==-

Grab the Rotation tool (Option- or Alt-click the

tool to use it more than once). Pressyour mouse
down at the point around which you will pivot
your selected box Of item. Choosing this point is a
key advantage of using the Rotation tool over

entering a number in the Measurements palette.

Then drag your mouse away from that spot. With
your mouse still down, drag the mouse clockwise

or counter-clockwise to rotate that thing in

thousandths of a point. (If you drag with your

mouse close by the pivot point, it's hard to control.
because each tiny mouse move is many degrees.)

Pressingthe Shiftkey, the constraining key in computer graphics,youcan constrain the
rotations to 45. intervals-O',45., 90., etc.-some of Mourmost popular" rotations.

. e e EXPERIENCE THE REAL THING, NOTTHE BOX

~
"~

.

)
;/ ~

(
']

~-

Here's where"the pause that refreshes" pays off.

When you rotate an item using the Rotate tool, usu-

ally you press down, drag out, then swing counter-

clockwise or clockwise-with not a moment to lose.

And what do you see as you rotate the item? A

black-outlined empty box? Hmm.. .hard to imagine

what it's
really going to look like. Instead, after you

press down to mark the point of origin, pause for a

second. (MLook both ways and then proceed.") That

pause gives Quark a chance to collect the image in

RAM so that when you rotate, you see the image,

graphic, or text that's inside, not just the box. Hurray!

@) ~n~~~:~:5~~~t:'e:~::~~~eeIY
or in Fixed
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8 ~ 6 DELETE AN ITEM WITH THE CONTENTTOOL

DoOII lID
SI "" 'CIID
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This tip is definitely on my short list wherever I go.
Quark can be so finicky about some things. For
example,you need the Content tool to do Get
Text. But then it can be so lax about other things,

like not needing the Content tool to do Get

Picture. However, deleting an item is one thing
Quark is strict about. Thou shalt select the Item too/

to delete an item. So there. Well, the dictum does

seem impervious except for one little fact. From

the Item menu, there's a Delete command with a
keyboard shortcut! So when you're in the Content

tool, which is at least 50% of your time, you can

delete an item by simply pressing Cmd-K or Ctrl-K

(NK"for"KiU the ball," in racquetball).

8 ~ 6 DON'T ACCIDENTALLY DELETE A LOCKED ITEM

Seemscontrary to allcommon sense, but in fact it's true-you can delete a locked item!

Heavens! What's this world coming to? Well, in Quark, locking has a very specific meaning.

A locked item can't be moved and can't be sized. But anything else is okay. You can edit the
text, you can color the box, you can delete the contents. and you can delete the box. So this

is just a fair warning of what you can expect if you don't watch out!
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8 6 0 COMIC RELIEF-DELETE WITH MARTIANS OR MElTDOWN

This tip might even fit into the category of "party pleaser"- it's so unexpected! Definitely

an inside-track effect. Draw a big picture or text box or select one on your page. On the

Mac, your delights last longer if the item is on the right side of the screen. Then press...

. Ma(:Cmd-Optioo-Shjft-K

. Wln:CtrJ.Alt.Shift.K

...and see what happens! (Okay, you can undo.)

k

CHAPTER5 .Selection &Transformation Tips 71 Jr4





If type is rhe King of Page Design, pic- ~
tures are Queem. Everyone's probably ~
hod their fair share of all-text layouts.

Enjoy the Sc~nery
picture tips

Formattingis redious,and you work hard (0

make the page fively. Bur plunk down a few

colored pictures-it's swing time! We've got

tips here on how and what to import, tiffing

pictures to their boxes, cropping, and sizing

multiple ways. And how ro deal with scanned

and digital images without killing image

resolution. Those differences between

bitmaps ond vectors Ofe profound with many

prices to pay if you're not careful-the worst

being fuzzy images and type! Then, lots of tips

on picture effects, warping, making them

negative, coloring them, faux duo tones, and

skewing. Tips on making clipping paths in

Quark-we can finally see what we're doing

with the new full-resolution preview for

images and especially for imported EPS

graphics! Finally, importing images to keep

file size low and updating pictures. Here's a

chaprer you can really sink your teeth into.

Happy imaging!
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. e 6 DID YOU KNOW YOU CAN IMPORT A PDF?

Yes, finally you can import a

s..!:~
~rs-A'",' ~

PDF into Quark and make one

{
Im~n...' ! bpat...}

~e~~i:~~~~T:~~~I~;~' :~:t pU~~

Import tab at the bottom of the
dialog, then enter the page

number you want {if there's
more than one).To export a file,
go to File> Export> layout as

PDF.lt'sthePDFFilter,aQuark

XTension that's on by default,
which makes it so easy. You
might find one day that it does-

n't work, however, if you happened to turn it off in XTensions Manager or switched to a dif-

ferent XTensions set. Go check the XTensions Manager (Utilities menu). Click in the Enable

column to turn it back on. But you'll have to relaunch Quark for the XTensionto take effect.

XTln'I""''''''_r

"''''10
.......

-~ ?f~:~,~..

.~ ~~~
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Thi.XT.n,icn, module
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load«l properly
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. e @ GOT A TWO-COLOR JOB AND FOUR-COLOR IMAGES?

You're doing a two-color newsletter or

three-color brochure, and your client gave
you full color images. You could go into
Photoshop and do the mode conversion

to grayscale, but why bother. You're just
getting started. The pictures could change,

all kinds of things could happen that
would make that work unnecessary.

Don't bother, Instead, do an on-the-fly

color conversion. Got your picture box
selected, with the Get Picture dialog open

and your picture file selected? Then, for

the Mac, Cmd-press and hold until you
see the image in your box;for Windows, Ctrl-click the Open button, That full color image
now looks just like a grayscale TIFF for your camp-and it even prints that way. But in fact,

the file on your hard drive is still full color. That's the only thing you've got to remember jf

and when the picture makes it to final production-go convert it!~
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. e e f:~~~: ~Z~~
PICTURES FROM YOUR DESKTOP
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If you have a bunch of pictures to import, open Windows Explorer or, from the desktop,

open the folder with the picture files and position the window offto the side of the screen
so that the filenames show.Back in Quark, size the window down so that you've got a few

inches. You can further clear that area by collapsing any palenes-double-ciick the title

bar.Nowyou should be able to see that window with the picture fileson the side.Go to Fit
in Window((trl-0) or a more reduced view so you can see the greatest number of picture
boxes. Then just reach out and touch that first picture file and drag and drop it into a box!
Repeat until done.
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. e 6 FITTO BOX AND BOX IT UP...
[j'-I"'"'::""l~' - I!I-";~"'''

..;;.-
ID~". ~, ID~~ ~".--

QUick-fitting an image to its box proportionally is a neat way to get an oversized image to a

manageable size in one leap-great for those 8 x
10"

mug shots that need to be only 1 x
2".

You've always been able to do Cmd-Option-Shift-F or Ctrl-Alt-Shift-F ("F"for"Fitta Boxl.

In Quark 5, it became a command in the Style and Context menus-Fit Picture To Box

(Proportionally).
Here's the idea. Make a picture box on your page roughly the size and shape

you want when done, perhaps sized to the width of a column or two. Get Picture, press the

Fit to Box keys, and now it's the right size. But the box doesn't fit on all sides. Because
it's a

proportional fit, it fits one dimension only. So
here's the second tip--<lo Fit Box to Picture,

very fast from the Context menu (press Control/Mac or right-dkk/Win). Now it's
just right!

8 e @ CROPPING-UP CLOSE AND PERSONAL

Don't
go changing copy that the editor or client gave you. But

"hands oW doesn't
apply

to pictures. Artistic license is a must!

Leaving space around the subject psychologically distances

the viewer from the subject. Lay photography, rampant in not-

for-profit and government work, is the worst-grass, ceiling

fans, the car next door, you name it. Instead, crop in on images

so they seem to explode at the edges. heightening the drama.

If a subject is in three-quarter view, crop the back tightly and

leave more space in the direction the subject's facing. Crop off

the top inch or two of someone's head-it's not a lobotomy.

Just drag the picture box handle in on the image-no keys.

Then, with the Content tool, drag inside the box to position the

image dynamically. Polish it with the arrow keys to nudge it a

bit more, with the Content tool in hand.
.~
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. e ~ GETTHE PICTURE CENTERED
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. e ~ EYEBALL IT

Centering an image or graphic in a box

seems simple,but it's
quite difficult to do--

that is, without the Center Picture command

(Style menu) and the shortcut Cmd-Shift-M

or Ctrl-Shift-M.Very useful if you want to

have a flat or blended color surrounding

your image. I prefer a bar of color at the top,

or top and bottom, but not on the sides. For

a bar at the top and bonom,do the Fit Box

To Picture command (Style menu).Then use

the Measurements palene to extend the

box down two times the height of one bar.

After the H value, type," +p9*2"{or +.125"*2).

Then press Return or Enter. Finish with

Center Picture and color the box back-
ground.For a bar above,dropthe

*2 and

just add the height of the color bar to H.

Then change me Y+ field to mat same

number,"p9"(or.12S").

When it comes to sizing images and graphics on the page,

numbers are great for the second, third, and fourth ones in a. set. But for the first one, you want to see it the right size, not
guess at a number. When you type a percent, and that's actually

t one percent typed two times (X% and Y% in the Measurements

. palette), you're guessing-one number after another until "it's
, good enough." Instead, drag the picture by any handle, press-

ing all three keys-"Iean on the keyboard"-Cmd-option-Shift

or Ctrl-Alt-Shift. Special perk-the box and image are both.
sized together. The handle opposite the one you drag stays

fixed. To size a picture to the width of a column, when the pic-
1 ture is snapped to the left column guide, drag from a handle

on the right side. Keep a picture centered in your layout-drag
from the top or bottom center handle.

CHAPTER
6'

Picture Tips 77 Ir4



fit 6 8 NEED THE PICTURE BIGGER,BUT NDTTHE BOX?

This is one I use all the time. I often draw a picture box the size I

want for the layout. Bring in a picture, do a Fit to Box. But now the
picture needs to be bigger to successfully fill that box, allowing for
some cropping. You can size just the image and not the box, in 5%
increments by pressing:

. Mac:Cmd-Dp!ion-5hift->Of-<

0 Win: Ctrl-Alt-Shift.>or-<

Sound familiar? It's exactly what you do to size type in 1pt incre-
ments!Word of warning-your best quality image comes with
no sizing, 100%. With a 300ppi image, however, you can safely size
up to about 120% and still have acceptable quality. Based on a

lSD-line screen (Ipi) or less, a 225ppi image is all you need for most
brochure and magazine work.

. e e THOU SHALT KNOW THY BITS AND PIECES

iiiI£~---
'...

Bitmaps and vectors. photographs and graph-

ics-the most fundamental concepts in com-
puter graphics are no place for fuzzy thinking

or you (an ruin a great layout. A bitmap image,
like a TIFF, consistsof rowsof dots or pixels,hav-
ing a fixed resolution, measured in pixels per

inch (ppi)
and output to dots per inch (dpj). By

contrast, vectors, like a "trueN EPS, or drawn

objects. have no resolution. They'rejust a set of
instructions and the quality is determined on
output by the resolution of the printer. An EPS
from Illustrator, Freehand. or Corel DRAW can be

scaled to any percent in Quark, big or small,
and it's fine. But scale a TIFF image in Quark

to 200%-a 300ppi resolution drops to half
(150ppi)! As for the faux EPS-if it looks like a photo, it's a bitmap, whether or not the
label says EPS-buyer beware! And if it's a real EPS but has an imported bitmap within,

the same rules apply.~\ 78 CHAPTER 6. Picture Tips



. 6 6 ULTIMATE SYSTEM FOR AVOIDING BAD RESOLUTION.' . A~jocd;I'm~;""y;"goutp;""'~-
when you scan images, you don't know

,

-

-
- '

_

how big

.

or small Y

.

OU11U

.

se them i

,

n the lay-

out Ifyou enlarge them in Quark, they can

be ruined and with reducing. there can also

be problems.Try this three-pass system.

Scan all pictures at 100% at 72dpl-the

. low-res ISfaster With thiS method and the

-
100% scale makes the math easier! Import

. , ~ ~~::\~~~~~~:~:~~:p:~::~e:e.
percent of enlargement or reduction,

reading the X% and Y% in the Measurements palette for the seJected box. For enlarged pictures,

rescan them at the percents used in the layout,at 22Sppi or higher.Re-importthem into the same

boxes. no additional scaling./fpicrures are digital tostart.trysizingthem up or downinPhotoshop
with resampling o(f.You can gain resolution by sizing down or, ifyou have 300ppi, you can increase

the dimensions, but don't go below 225ppi resolution (for 150lpi output, that's usually fine). For

pictures you've sized smaller, rescanning isn't necessary ifyou've used hi-res images to start.

However, if you have multiple hi-res images sized down, printing can really slow down.

. 6 6 FUZZYTYPE IN YOUR PHOTOSHOP IMAGE?

iii. If you want to add text to your image in Photoshop, but it's
going to be straight type-no Gaussian blurs or other filter

effects-add that type in Quark! Then you'll know the type

will output properly, be vector-based Postscript, and not have

fuzzy, anti-alia sed edges. The fact is, there are numerous ways

to go wrong with type in Photos hop. Best bet is to save the

file as EPS, but you must never, never open that image back

up in Photos hop. The text layer rasterizes and becomes a

bit map at the resolution of your image. Instead, if there are

changes, go back to your master .psd file, make the change,

and save a new EPS to replace the first. But other reasons to

do it in Quark? You can move the type around independently

of the image, and when there are text changes, there are no

trips back to Photoshop.
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. 0 @GRAPHICS AS FUN-HOUSE MIRRORS

B a fi3t'ti
This is one of those weird effects-sizing a box and

its picture together non-proportionally. You're more
likely to use this one with an EPS graphic. not 11TIFF.

Photographic images, being snapshots of the
"real

world: usually require fidelity. But graphics are pure

metaphor and rarely attempt to be realistic-and

when they try to be, they usually fail miserably. The
beauty of graphics is their boldness, their ability to

make a point with impact by emphasizing the main
thing. That makes them good subjects for non-

proportional scaling, besides having no resolution

issues to deal with. Go ahead, Cmd-drag or Ctrl-drag

a handle of an imported true EP$. As you drag wide,

the graphic, well, puts on weight. Drag it narrow,

the graphic quickly loses it. Someone please

Cmd-drag my hips-in!

. e @ ACCESSING IMAGE EDITING COMMANDS (MAC ONLY)

;;;;:~~:'n
CoIOlTIFfs: .,. 32~bit

The following two tips are fun ways to work with images in
Quarkusing the image editing commands from the Style

menu. However, on the Mac, there's one hitch-a Display

Gr~ Tiffs, 2SSIewIs. application preference setting that imports TIFF images at

32-bits (color depth). Change this setting (Cmd-Option-Shjft-y)
to 8-bit.Then import the image again and you'll be able to use

the Negative and Contrast commands. Don't worry, the original picture file on your hard

drive won't be altered. The 8-bit preference is only for screen display, and it doesn't affect the

bit depth when printed. On a different front, Mac users get more options using the image
editing dialogs. Use Cmd-Z to undo your last move so you can try something else without

dosing the dialog. Apply your choices with Cmd-A.

See also "Negative and Positive Together" and "Faux Duotones
n"

(next tips).
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Very cool effect to pairpositive and negativeimages.
Duplicate a picture box on top of the original by pressing

Cmd-option-D or Ctri-AIt-D.ln Step and Repeat, set the

offsets to zero, then click OK.Move the copy over so it's
butted-copy the Width (W) field in the Measurements
palette. Select the duplicate, add the W to the X position (or

add the Height (H) to the V). Now they're side by side. Make
one negative with Cmd-Shift-Hyphen or Ctrl-Shift-Hyphen.

Black tums white, red turns cyan, green turns magenta,and

so on. Then flip it horizontally using the Flip Horizontal

arrow on the palette. Try a checkerboard of four! Works.
for TIFF (not l-bitJ,JPEG,GIF, plus a few more-but not EPS.

Using these image editing commands only affects the way

the images are displayed and printed from Quark. Picture

files on your drive are unaffected, It's better to use Quark's
image tools fOf camping and do the final in Photoshop.

NEGATIVE AND POSITIVE TOGETHER

. e 6 FAUX DUOTONES #1

This spectacular and unusual effect is not a

duotone.Think of duotones as images in

which two inks, usually black and a spot color,

are mixed together in some proportion. In a

classic duotone, the image is a grayscale of

mat mixed color, going from white down to

black, so it looks pretty realistic. By contrast,

the faux duotone is like a grayscale image

with a veil of flat color dropped on top. In

essence,afl the white in the image is replaced

by the second color. This is easier to do in

Quark than in Photos hop! First, set up your

spot color in Edit> Colors (Shjft-F12).Then import a grayscale TIFF image into a selected picture

box. Now for the surprise finish-in the Colors palette, change the box background color to

the spot color. Presto, your image is utterly transformed. For a softer look, use a tint of the

background color.
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8 0 e FAUX DUOTONES #2

For an even more surreal effect, let's do

another tip for grayscale images, using black

and a spot color or two different spot colors.

With your grayscale TIFF image in a selected
picture box, go to the Colors palette (F1 2).

Click the top-middle button to apply
a color

tathe image, and, with the button on the
right, apply a second color to the box back-
ground.Wow!Ifyou're using black and one
color,try makingthe box background color

black and the image the second color. Either

of the two colors can be tinted. Word of warn-
ing from my service bureau-if pictures like these are going into a multi1)age layout that will
later be imposed at the printers (making printer spreads, not reader spreads), the background

color drops out! It's not Quark's fault-the imposition software is to blame.

8 6 e TURN A BORING IMAGE INTO A GRAPHIC

~.Ij
' '

'.~---

<>"'"-'-" ~-"'"'"'-'-I-~'
-,.~."~;o:..

~. o-
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~~~
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Make lackluster images experimental and fun using

Quark's Contrast dialog. Select your picture, which

can be any of the file types named previously. Press

Cmd-Shift-C or Ctrl-Shift-C to open Picture Contrast
Specifications. Tryout any of nine buttons along the

left edge. The Posterize button reduces all the tonal

and saturation values (color or grayscale) to just six
gray/color levels. The Posterizer lets you set 10 levels
that you can adjust in the graphing area. Click the
Inversion Button to flip the graph of input and
output-similar in theory to Negative, but different

results. For a totally wacky, psychedelic look. draw an

up-and-down mountainous graph with the Pencil

tool. Use Apply, then reset the image with the
Normal Contrast tool, six down from the top.
Again, you'll get better quality with comparable

techniques in Photos hop.

See alsoUNegative and Positive Together" (this chapter).



SKEW A GRAPHIC OR IMAGE WITHIN A BOX

Give an image a more emotional

and intense look by skewing it-

changing it from a rectangle into

a parallelogram. You can make the

effect more subtle by skewing just

the image, not the box. Select

your picture box, then in the

Measurements palette, way over

in the far lower-right corner,enter

a number of degrees for Picture

Skew. If you've got other tricks you

want to do in the Modify dialog,

you can also do your picture skew

in the Picture tab (Cmd-M or

Ctrl-M).rt doesn't take much to

make a statement-l 0 to 15 degrees goes far, unless you want a really exaggerated effect. The
last step is optionaL You can leave the edges of the image as a parallelogram, or size down the

box from the sides so that the overall shape of the picture 5tililooks rectangular.

. e 6 MAKING A CLIPPING PATH

r
Quark clipping paths (Cmd-option-T or Ctrl-AIH)
drop out a light or white background around

"!-'-=-_-1 - ' ~~:;~~~~~:;::~:~~~~~:~~;
- '--. TIFF,EPS,orJPEGimages,selectEmbeddedPath~

"

_"

D
,., ,.,

,',. .

- ~ inTypepopuporwithTlFF,alsoAlphaChannel.)~I ,_.
~ Otherw;se,selectNon-WhiteAreas.Decreasing

: .;..- Outsetand increasing Threshold do the lion's
~

''''~' -- -"..- shareofdroppingbackgroundpixels.Decrease
? ;~.l ~: Outsetbysmallamountsusinganegativenum-

ber to remove pixels at the path edge.Tolerance

affects the number of background gray levels that drop out overall. Ifyou have too many points,

increase Noise and Smoothness in small amounts. Click OK. then you can manually fine-tune the

clipping path,just like a runaround. Press Option-Shift-F4 or Ctrl-Shift-Fl0 (Item> Edit> Clipping

Path) to see the dipping path right on the page. Drag the path (pointing finger with"\"cursor)

or a point (with a"."cursor).Click on a point and adjust its handles or change the type of point
from the Measurements palette.
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. 6 8 SHORTTIPS FOR CLIPPING PATHS
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Putting that image on another

color? Before you open Clipping

Paths, apply
the box background

color you're planning on using

behind your outlined image.

Having that background in place

lets you see how good your

clipping path is when you click

Apply in the dialog. Those light

pixel halos at the edges of your

subject really pop out with a
colored background!

Holes in yourImages?Many
times the subject you're outlining

with a dropped out background

has <lreas within that also need

the background dropped out,

like pretzels. Easy to do-just

uncheck Outside Edges Only in
Clipping Paths dialog.

Fill the shape of your clipping
path with another Image.

Here's an attention grabber-how many times have you seen the shape of an outlined
image filled with another image? It takes only two-steps. First, in Clipping Paths, get your

path set up, then click Invert and Apply.You should see the background of the image, but
the foreground subject is dropped out. Click OK, then do Step and Repeat, setting offsets to
zero, to make a duplicate box #2 on top. Do Get Picture to import another image into that

box. Then send #2 to the back using Shift-FS so #2's image is now only visible through the
empty clipping path of the first box, now on top.
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. e 0 FULL-RESOLUTION PREVIEW FOR IMAGES..-'" -
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view. tnthe past,making

~ . .
- . . 1ii

clipping paths in Quark

was for com ping only,

because how could you.
make an elegant edge

. . from a 72dpi preview?

'

...
"','J, .."

, ., ...z Now images can be
seen looking their best,
even when you zoom in

on them, assuming they're 225 to 300dpi. However, there is an uneasy twist-getting to the pre-

view has two levels. First,go to Preferences (Cmd-0ption-Shift-Y or Ctrl-Alt-Shift-Y), click Full Res

Preview,anApplicationpreference.ThenuncheckDisableFull Resolution Previews on Open so

that all your pictureswill automatically import with the potential for hi-res preview.Butifyou have
a lot of pictures,you might also want to check SelectedFull Resolution Previews. Ifnot,choose
All Full ResolutionPreviews.Now,whetheror not the picturedisplays at hi-res also depends on

the View menu setting: Hide Full Res Previews. Ifthis says Show instead, your imported pictures
display at 72ppi. Finally, if yoIire not sure what resolution your pictures are at,.just select one or

more, then go to Item> Preview Resolution> Low or > Full Resolution, and make your choice.

See also"Full-Resolution Preview on the Fly~ (next tip).

. e ~ FULL-RESOLUTION PREVIEW ON THE FLY

~~
Althoughfull-resolutionpreviewisahugestepforwarcl,, ,

~,~ ~'" '-~'~
~ ,

~~;'s::;~~;;~~i~~s~=~~i:~:~;j:~~~:

-
. . .

- ofpictures.lfthey'reall viewing at full strength.thatcould
certainly slow down Quark's performance as you scroll,

change views, or change pages. How about turning on

the preview only when you need it? Go to preferences
(Cmd-option-ShifHor Ctr1-Alt-Shift-Y) and click the Full Res Preview preference under Application

preferences.On the right,dick Selected Full Resolution Previews under Display Full Resolution

Preview. From now on,only picturesthat you've selected preview at full res. Practical! Set the

Full Res Preview for any image on import (or from Item> Preview Resolution> Full Resolution).

See also"Full.Resolution Preview for Images'" (previous tip).
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. e 8 LOWER THAN LOW-KEEP THAT FILE SIZE DOWN

Everdo a product catalog? Or an annual
report? When you import a lotof pictures
into a Quark file-{>ven though those
representations on your page are low-res
bitmaps (72dpi) linked to hi-res files on
your drive-all those low-resbits add up

and your Quark file can put on weight!
Keep your file sizedown and speed up

scrolling by importing those imagesat
36dpi.ln the Get Picture dialog, select your

picture file, then press Shift and click Open.
(Mac users, keep pressing Shift until you see

the image on your page.) Now that set of dots on your page, though not quite as clear, is add-
ing only half the calories to your file size! The file on your hard drive is the same as it ever was.
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. e 6
QUARK, SERVANT OF MINE, ALERT ME TO PICTURE CHANGES

Here'sone way you can slough off a bit. By

setting a little preference, you can put Quark

to work checking for pictures that have been
changed or are missing.Go to Preferences by

~ ~ pressing Cmd-optfon-Shift-y or Ctrl-Alt-Shift-y.

Click the General {print Layout) preference.

Then check Verify under Auto Picture Import. From now on, when you open that Quark file and

the linked picture files have changed (but retain the same filenames), Quark alerts you and
asks you if you want to update them in one fell swoop. Click OK Or, if you want to examine
each instance, click Cancel and go to Utilities> Picture Usage after the file opens. Of course, if
you want this feature to be in effect for all new files you create, close aff open Quark files before
you go to Preferences,
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. e @ UPDATE THAT PlaURE AND RETAIN CROPPING AND SIZING

~
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You've got a bunch of pictures

on your page that have been
sized,cropped. rotated, skewed.

reversed,inverted,orwhatever

the heck you did to those
things. And now many of them

have newer versions (with the

same filenames). Oh dear. If you

use the Get Picture command,

you'll have to first record the
modifications you made to each
picture so you can reenter them

again (in the Measurements
palette or image editing com-

mands in the Style menu}. But

halt everything-spare yourself

the grief.Instead,update all your
images in Utilities> Usage,

Picture tab (Option.F13/Mac

or Shift-F2/Win) and everything

you've done to those images is
remembered. Just select the file

or files in the list whose Status
says Modified, then click Update.

After getting your okay,Quark
brings in the new and keeps

the existing sizing, cropping,
rotating, and whatever.

You can relax,
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Textis the backbone of virtually every ~
designer'sjob. Just think how much ~
time you spend importing text, linking

text, cleaning up text, highlighting text,

Gas Keeps You Goin'
import text & ""ord processing tips

formatting text, editing text, deleting text,

searching text, and maybe even proofing

text In short, you're coming and going text.

Which is why I devote three whole chapters to

the subject, including some of the longest in

the book. This chapter deals with the most

tedious end of thot spectrum. The farther

down the line you go, the more interesting
type becomes. With a great style sheet, you

can practically fly through text formatting.

Bur bock to now. Yes, importing, linking,

and doing those word processing rhings Ofe

boring. And that's precisely why you need

these tips more than practically anything

else-so you can get through them faster

and onto other more fun and creative

exploits./f you just allow all those people who

give you text files to run amuck, your type will

look like it belongs in Word. (What an insult!)

Take charge, make that type look good.

Digging into the trenches is the only way out.
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. 6 ~ WHENGmINGTEXT.lINKFEWERBOXES
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Typically, people use larger type when

they're trying to write something. But put
that same text into a multi-column layout

and the point size should be smaller,

because now you've got columns, not text

running the full width of the page. So why

link a bunch of boxes on multiple pages

when you get text, and then find, after you

size down the type, that you have more
boxes and pages than you need? Imtead,
get text into that first box but before you

link,size down the type. Click the Content
tool in the text box. Then do Select-All

(Cmd-A or Ctrl-A,or click five times) to highlight not only that text, but also all the text in

the file that you can't see yet on the page. Pick a smaller point size. Now when you start
your linking, you'll have fewer boxes to draw and link, and fewer pages to add.

. e 8 SAVE ENDLESS TIME WHEN YOU'VE GOTLOTS OF LINKS

--
linking can bea snap or real

tedious. By default, you can make

a single link with two clicks and

then you lose the link tool-
instead, you've got the Item or

Content tool, whichever you had

last. If you have a lot of text to

link and you keep having to

return to the toolbox to pick up

the link tool,it's aggravating.
Instead, keep the link tool for as
long as you like by pressing

Option or Alt when you click to
select the tool in the toolbox. Now you can just do a single click on each box to flow text
there. Click on the first box, then the next box, then the next, and so on. No stopping.

- =- -=_L
~~~ ~~~~
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RiilerTips

. e @ WORRY-FREE LINKING AND UNLINKING

<~..

After all these years,Quark has finally changed our

lives for the good on a smallbut important point.
When you use the Link or Unlink tool, you (an

now undo! Yes,it seems so natural,so right that
you wouldn't even bat an eye. Yet, it has never
been true before Quark 6.1 used to counsel my

students to savebeforelinkingor unlinking, then
use the RevertTo Saved command to recover

from a series of bad links or a drastic unlink. After
all,one unlinking click on the head or tail feathers

of the link arrow between two text boxes not
only breaks the link, but all the following text is

instantly swept up from your pages and replaced

with that redNX"saying "more text to link.HNow,

however,we can proceed blithely through the

roses without a cafe in mind. (Why did they wait

so long?)

. e 6 YOU'RE LINKING AND YOU'RE OUT OF PAGES

E~.~ Unless you're using the Automatic

Text box or doing a one-page
layout, you'll be adding pages

when you start linking.Shortcut

to the Insert Pages dialog to add a

bunch of pages at one time, pick

the master page
they'll be based

on, and specify exactly where

~ ~ ::~:;::;:~;i~~~ep:~~ey~-:-

name or at the end of the layout.

This is way shorter than dragging the master page icon in the Page Layout palette down into

the pages area for each page you want to add, Instead, drag the master page icon down into

the pages area, but only once and do it while pressing Option or Alt. Then once you're there,

release the mouse before Option or Alt and the Insert Pages dialog
pops right open. Easy!

~ In..~'
E=')~

ffi O...odofloyout

,
m, ' -""".'".~".'".'
~-,..'-'~

ltj
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. e 8 DON'TLETYOURBODYCOPYGOWANDERING

.---....
''''''-'''''-...I:=~=="'__1_-'__"'0_-

-~~-==~-~-;::..~rw--......
':,'.:=:....1_.__-
"""'P''''''''''''--,,,,ItIO.....

. e @TO UNLINK OR NOT UNLINK?

Writers often combine various text elements into

one text file instead of having to track a bunch of

small files-one fOf body copy and others for
captions, sidebarS,ete. But when you layout that

text in a series of linked boxes, you've got trooble

waiting to happen. Ever done a job with no edit-
ing changes? So you're adding a few more lines

on page one. failing to notice that a few more

lines of body copy have been pushed back into
your first caption box and the first few lines of

that caption have now drifted into the second
caption box, ete. Trouble, trouble, trouble. Save

yourself headaches. After you link text boxes,

before you do anything else, check to see what

follows the main story. Cut and paste each cap-
tion, sidebar,or what~ into its own text box so

it stays puL

You need a picture area with a text box filling the column that's part of a larger text chain.

If you unlink the box from the text chain-oops! All subsequent boxes are drained of text.

(You can Undo!) Instead, delete the text box with the Item tool or change its content (Item>

Content> Picture). Presto! The text in that box passes into the next box in the chain. Here's

another one-you want to make a sidebar or pull quote with a box that's now occupied

with body copy. You can Shift-click on the box with the Unlink tool to unlink it from the text

chain and force that text into the next linked box.Now you've got an empty text box to

work with. Finally, check the last box in the chain to see if text is overseL See a red-X?"

t";- - :F;:""
. - .ft m.. U~ir

.'"-'".~

-

"
, .:

:,Cil'"
'..'V~

~::::- ~:,mu~
.ny....

~E~~'I
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. e @ HIGHLIGHTING ALL THETEXTTHAT'S THERE? DON'T DRAG

Everyone uses the Select Allcommand

to highlightallthetextofa story for
formatting.first clicking the Content

tool in any text boxofthe story. But

when it comes to highlighting all the

text ina headlineor caption, don't you often resort to dragging the Content tool across the text?

Not a great idea,because you don't just do it once, you do it all the time.That's a lot of stress on your

hand. Did you know that every time you drag the mouse, you're constricting the blood vessels in
your wrist, which over time acceleratesthe oosetof those repetitive motion symptoms we all dread?

So here's one place where you can use better ergonomics, at no extra cosUust do Select All with

Cmd-AorCtrl-A after you click the (ortent toolon the box.andpresto-all the text is highlighted.
Nothinglikeit

8 e 6 DON'TDESELEaTHETEXTTOSEEWHATYOUDID

This is absolutely one of the neatest things about Quark and entirely unique in page layout

software, to my knowledge. When you've highlighted some type and made some styling
choices, you want to see how it looks without the highlighting. But don't click insidethe box

to deselect. Okay, that does the job. but when you want to make further changes, you've got

to re-highlight the text after you've had a look. Remember that every single extra motion is
magnified into dozens or hundreds of moves through the life of a job. Instead, click outside
the box to deselect the box and see the text without highlighting, then click back on the
box, and the highlighting is remembered for your next styling move!

0
Wfhe general nea,

f~~cla:\a~:~,
"istoseethat 0..

no shirt or collar ev

CO~=.~I
[1812-11I1fJ 'iiiI

'><>'"<, /

.

~

'
.

'""The general nea, . WJhe general idea,
of course, in any of course, in any

firs.tclass laundry,,, fmrt class laundry, .."
:jr~ :ero?I:rt ev . 0..

lho:~ :e~t ever ~

'~~.,::,!re.8 : !~~.'::'!"'1'
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Previouswmd* Cmd-$hift-Ieftam>w Ctrl.Shift.left,,"ow

Nexlword* Cmd-Shift-right (Irl-Shift-right

Previousparagraph* Cmd-Shift.up (trl-Shift-up

Next par~graph' Cmd-Shift-down Ctrl-Shift-down

To start of line (md-option-Shift-Ieft C1rl-Alt-Shift-left

To end of line Cmd-option-$hift.right Ctrl-Alt-Shift-right

To start of story Cmd-option-Shift-up Ctri-Alt-Shift.up

To end of story Cmd-()p~ion-Shift.down Ctrl.Alt-Shif~-down

. 8 8 SELECTING A WORO, LINE, OR PARAGRAPH AND MORE

Selecting a word, a line, a paragraph, and a story:

Wordwithpuncl-
u~tionfollowjn9

Line

Paragraph

Story

Double~lickit

Double-dick betw.-en the word and the punctuation

Triple-click

Double-clkklwke(fourclichl

Clkkfive times; (md-A mC\rl-A

Selecting text backward and forward using arrow keys:
Macand WlndoW$
Shift-Ieftarrcw
Shift-right
Shift-up
Shift.down
Mac

'Thephro,e'previou'porogroph"i"honhortd,!f)'OUrin,enionpoirtU,irtlhemiddleofopomgroph,rhi"hortcu"elect'tothe
beginningoflhct'omeporogmphlfyourin'enionpolm i, at ,he W'rybegi""ing ofoP<lmgroph,it

''''''I.

,heenlireprl'Viou.
P<lrogroph.l/e~lpo!ogropl>,.,lew IOlheendofrhecurrenrparogmph.elc.Previou, aF!dnextwordworlc'imi!orly-previou,

..!ew fromlhelmenionpoinl
'0

Ih.ebeginning of'he,ameworcl, Ifyouorebeforeorofrero worclspore, il,e/ecu ,,,eemire
previou,word.
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. e @EASYTEXTEDITS OVER PICTURES-OPAQUE TEXT BOX EDITING

In Quark 6, text boxes no longer have a white
background color-instead, it's None. That's good

news. When you put text over an image, you

won't have to remove that box color every time.
But, when it comes to editing that text, it can be a

strain. Get the best of both possible worlds-
keep your see-through text boxes on top of

pictures. but automatically give them white back-

grounds when youedit the text.Goto Display
application preferences with Cmd-option-Shift-y

or Ctrl-Alt-Shift-Y,and check the option Opaque

Text Box Editing. Now, when you edit your lovely
transparent text box that's sitting on a picture
magically turns white! And even if your type is

white. your text is still readable. Pretty coot.

See also"Set Picture Box Background Color to None~ (Chapter 1).

1!\0000q"" Tnt Bo; Edillng

. e ~ DRAG AND DROP TEXT-ALWAYS AND SOMETIMES

She walked ahead of him, without

rJij~:r~: :eh

~
he~t:;da:hOW

fher-why not jus I h into the next

s: ~~o TItS t~~ t~~~d
mavbe she wouldn't lake him for
~anted anymore. Yea, thai sounded
like a Itood idea, at least at the lime-

Did you know you can edit text by using drag

and drop with the Content tool instead of cut-
ting and pasting? Set this up for all time by

first closing all open Quark files. If you have a
file open when you change the preference,
drag and drop is good for this file only. Press

Cmd-Option-Shift-y or Ctrl-Alt-Shift-Y to open
Application preferences. In the Interactive
Application preference panel, check the Drag

and Drop Text option. Once on, you can not
only drag and drop highlighted text, you can

make a copy simultaneously by Shift-dragging

it. Note that you can do drag and drop only
within a single story.

Mac users also have the choice to just do drag and drop on the fly;. Cuttextasyoudrag:Cmd-Control-drag. Copytextasyoudrag:Cmd-Control-Shih-drag

I!fll;°ragand OropTul

CHAPTER
7'

Import TeKt &Word Processing Tips 95
r4



. e 8 MOVING THE INSERTION POINT USING ARROW KEYS

Use with Arrow Keys Mac

Previo",eharacler left arrow

right
up

NeXtlin"

Previous word

NeXiword

Previous paragraph

Next paragraph

Start of line

Cmd-left<1lrDw

Cmd-right

Cmd-up

Cmd-down

Cmd-Option-Ieft

Cmd-Option-.ight

Cmd-Option-up

Cmd-Oplion-down

Cnl-Ieftorrow

(Irl-right

Ctrl-up

Ctrl-dowo

(I.I-Alt-left

Ctrl-Alt-right

(iri-All-up

(Iri-All-down

5tartofstO<'y

End of story

. e 8 DELETING CHARACTERS-SIX SHORTCUTS

Beingadept and fast when editing makes the whole thing go a lot faster. Stopping to
use the mouse is a real time sink. So get to know these shortcuts for highlighting type,
moving the insertion point, and here, deleting characters. That way you can get to the

fun parts sooner.

Highlighledch.raClers De~!e

Previouscharacte,

Bachpace
Back~pace

Delete
Extended keyboard

Previous word"
Nextwo,d

Forward Delete (keypad)

Cmd-Delete Ctrl-Back~pace

Cul-Shift-Backspace

's.-I~r,rneMrirewordiffhein'errjonpofnfj,jntheWOldorinfne,paceofterif
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8 6 @ TYPING DUMB QUOTES-INCH AND FOOT MARKS

TheSmart Quotes Interactive preference is on by
default, and it gives you curly quotes instead of inch
(12") and foot marks (1'). That's great most of the

time, but what do you do when you actually need

to have the inch and foot marks? Go back to the
preference and turn it off, type, then turn it back on?
Goodness n01 Do this instead:

Win
Footmark Comrol.' Ctrl.'
Incnmark Con!rol-Shift-' Ctrl-Alt-

. e 6 GETTING A QUICKZAPF DING BAT (MAC ONLY)

Sometimes adding a ZapfDingbat gives a little extra sparkle to the page. Then again. it's a
drag to have to manually change the font. This tip lets you do it all with no highlighting and

no mousing. It's perfect fOf bullets! Just type the combo-keys at an insertion point using

Cmd-Option-Z to change the font to Zapf Dingbat. Then type the letter of your favorite
dingbat from one of the four sets of characters:

. Typingthelette,withnoextr~key

. Typing the letter with Shih

. Typingthe lellerwith Option. Typing the letter with Optioo-Shift

. Doesn't
2. Youcan
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. e 8 PROOFINGTEXT?SKIPTHEPICTURES

~~I

When you're proofing text edits and typography,

you've got to look at the printed page-the screen

just doesn't work for final edits. But,when you print,
why wait for the pictures on your pages to be
imaged? Instead,go to the Optionstab of the Print
box (Cmd-P or Ctrl-P) and at the bottom left, for

Picture Output, choose either Low Resolution or
Rough instead of Normal. The low Resolution setting

prints the 72dpi bitmap that Quark uses to represent

your image on the page. You get a look at your image
next to your text, but not at the full resolution that

comes from referencing the original picture file on
your drive or network. The Rough setting is another

step down from LowResolution. SelectingRoughjust
puts a box with an"X"through it for every picture on

the page, along with your text. Either way, you'll get

faster hard copies, and that's all you need forthis
stage of your workflow.

8 6 @ MAKE SPElL-CHECKING GO FASTER ANO DO MORE

[!J
==~~-~

~

~\

If you tend to use the same technical words, industry jargon,
or foreign language words in your text, make things easier

and more accurate when it comes to spell checking. Rather
than stumble over certain words repeatedly, add them to an
Auxiliary Dictionary so Quark will bypass them unless they're

misspelled. Go to Auxiliary Dictionary to open an existing
dictionary or make a new one by typing in a name and clicking
New. Whenever you spell check, open the dictionary first so you
can add words to it. Otherwise, the Add bunon is dimmed.

To add a word, just click Add or bener, press Cmd-A or Alt-A.
Another approach-correct all misspelled words. Then, if the

remaining"suspect"words are legitimate and you want to
add them all to the dictionary, press Option-Shift-Done or

Alt-Shift-Close.
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. e 8 SPELL CHECKING FROM THE KEYBOARD

Checking spelling isn't exactly a fun task, but it's sure necessary. In fact you should do it

once or twice for each job-after you've imported all the text, and again, as a final step,

especially if there have been text edits. So when you can make the spell checker less
drudgery with a few shortcuts,

it's worth remembering!

OpenChe(kSp.llinq~ (Utilities Menu) To

Mile Win

(ul.W

CheckSlOry Cmd-Option-l Ctrl-AII'W

Choxklayout' Cmd-Option-Shift-L Clrl-Alt-Shih-W

o"younavemOterhancneJcyouljnyOurfiJe.youcon'tcheckthf'enlirepmjecraronerime.

CheckSpeUingTasks
Mac

Replace word Double-click
correct word i"list

Skip word

Lookup'

Done

Cmd-5 Alt-s

Cmd-L Alt-L

EscorCmd-.(periodi Ese

"5om.timeIodd,moreword,rhanoriginollyoffered-

. e e SKIPPING PORTIONS OF YOUR DOCUMENT WHEN YOU SEARCH?

~
~
~
~

Searching has been one of the worst and most inexcusablepitfallsin
Quark.Ifyou just want to search your current story (the linked frames of

one word processing file or one unlinked box), you'll want to press and
hold Option or Alt to see the Find Next button become Find First. Clicking

Find First starts your search at the top.Then continue with FindNext.But
why doesn't Quark.wrap around"its searches? Nogood reason. In Quark
6, they took a small step in that direction. Now, if (and only if) you click

the layout option to search all text in the current layout, the program
brings up a dialog asking if you want to start at the beginning when it

comes to the end. Good work guys but why not go all the way and just

make the wrapping dialog come up for any search that's incomplete?
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. e ~ ~~~~~~ -;:;~~~~K
LIKETYPESmlNG WITHOUT
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Face it there's only one word space, not two,

after a period or other punctuation. Some
people will kill over this.We're not in type-

writer days anymore with mono-spaced type

like Courier. Since 1985, we have the propor-

tional type of true typesetting where using
two spaces was never the rule. So instead of
arguing about it with your clients or bosses,

be a clandestine rebel.Goahead and remove those Hdouble"agents-globally.Open
Find/Changewith Cmd-F or Ctrl-F.Type two spaces in the Find field, then one space in the
Change field. Press Option or Alt to Find First. then click Change AII.Run the search repeat-
edly until no more changes are found. With each search, the number of spaces goes down
by one, To close the dialog, press Cmd-Opt-F or Ctrl-Alt-F.

Essential Searchesfor"Tut Cleanupw
Find Change

Multipleword spaces (2word spilces) (1word space)
Multipleretu,", Iplp \p

Multipletabs Itlt

.. e 8 REPLACE UNSIGHTLY UNDERLINES WITH ITALIC

;::,~ ~-. ,=--~ l:~::'.. ;:"...:;;",~
0- - o~. ii_""", '::'-".-

-i~~r

"Searching on attributes"is great for getting

ridofthose nasty underlines that cut
through the descenders of letters (g,

1
Q,g,

'J;
etc.), making little knots on the page-a

hold-over from typewriter days. Replace
underlines with italic. In the Find/Change
box (Cmd-F or Ctrl-F), uncheck Ignore

AttTibutes to expand the palette. Under Find
on the left side, check Type Style. Click the U two times to make the search conditional on the

Underline style. On the Change side, again check Type Style, then click"l"twice to make italic the

required result.To replace underlines that also occur with other attributes, such as bold, click once

on the styling button for each added attribute,both under Findand Change,so the searchwill
also find bold, underlined words and replace with bold italic.

See also .Use True Fonts, Not Bold and Italic Type Styles8 (Chapter 8).
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8 6 ~ CLEAN UP TEXTTHAT'S PASTED INTO AN EMAIL
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When "you've got mail,"the copy for your layout has

often been typed or pasted into the email and it

needs help. Emai! text often has a return character at

the end of each line, not just after paragraphs. Pour

that into a layout and it looks like %#@"+$!Luckily,

blank lines indicate where the"real"paragraph

breaks are.To fix this up, do three passes, automated

with the Find/Change command using Cmd-F or

Ctrl-F. First, search out the blank lines. Copy and
paste two consecutive returns from the text Of type

"\p\p"intothe Find field.Typea tilde (-) or another

obscure character into Change. Press Option or Alt

to Find First, then Change All.Now it looks like one
big paragraph, but you stHl have a return at the end

of each line. Press Cmd-I or Ctrl-I to see the invisible

characters. Do the lines end in a word space or not?

Remove all the return characters with Find:\p,
replacing with either a word space, if you need one,

or nothing if you don't. Find First and Change All.
last step-restore the "true"

paragraph breaks. In

Find, types-wand in Change, type"\p~ChangeAII.

Miraculous!
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. e 8 REMOVE STRANGE CHARACTERS IN YOUR TEXT

When text has been gone cross.

platform or been pasted in an email,

you can get some pretty strange look-

ing characters in your copy. Never fear,

they are quickly removed Just copy

and paste any word or stray character

from the text into the Find field. But

take a good look at these anomalies.

Sometimes they are substituted char-

acters for something that got 105t-

such as the apostrophes havebeen

replaced with commas,or perhaps an
open or close quote mark now displays an.~"mark.lf so. then search for the wrong character and

replacewiththe correctone.You'll often need to look at each case and avoid Change All.But

sometimes these characters simply need to be removed--empty open box characters at the start

of lines, for example. leave the Change field empty or possibly replace with a word space. Then
Find First and Change All-the weirdos are gone.

N&~b:mBerv]oo&B&n },lliBmcentWQXk&t.t.ber

aenl;a~OFmeArtlloe~a),buili.iDBone&I'bE

overtbecourseofh:i!twetlt¥"~career,UIK1erscores
stAture l1li Q

r::' IE
oomerDII, OLov<>«I OWtlo,"Wo.d Iflll"o"
=~fCllang""''''H"d'~

eecooolilmoo:lbreJCC81'tDD&lte&cherswooaa.nproVir:
t.beJevelofexrerbie tbat:iB IlDteasvw OO1!lllbvwdav:

8 e 6 YOU JUST DID CHANGE ALL, THEN REALIZED YOUR MISTAKE :-(

I

io:J
""",~,",,,.,,,,,. What a relief, after you thought

you made a horrible mess in the

Find/Change box by clicking

Change All when you shouldn't

have-and you
can't even

consider using Revert to Saved,
Style Item Pi e ~ because you haven't saved the file

for over an hour-you can relax.

The Undo command (Cmd-Z or
Ctrl-Z) can reverse an almost unlimited number of changes you just made with one little 01'
fateful click on the Change All button. Thank goodness! But you do need to close the
Find/Change box first, before using Undo. Redo is Cmd-Shift-A or Ctrl-Y,

-I
Can'rRedo
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. e e REPLACE EDITORIAL STYLE TAGS WITH STYLE SHEETS

Converting your editor's style tags or codes into style sheets puts you way ahead. If you

have <subhead> tags preceding your subheads, on the same line, you (an automatically

remove the tags while applying the subhead style.Beforeyou set up your search,apply the
body copy style to all the text, starting with Cmd-A or Ctrl-A (Edit> Select All). Open the

Find/Change box with Cmd-F

or Ctrl-f and uncheck Ignore

Attributes. Under Find at the top.

check Text, then copy and paste

the tag or code, like <subhead>,

from the text into the Find field.

Under Change,also check Text but

leave the text field blank so the tag
will be removed. Back under Find,

click StyleSheet and choose the
body copy style. Click Style Sheet

again on the other side, and choose

the subhead style. After searching,
all the subheads look typeset and

the tags are all gone!
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. e 8 CHANGE ALL THOSE 11 PT HOBO SUBHEADS TO 1 OPT BRUSH

Use the Find/Change command to make styling changes lickity-split. (But if you're using
style sheets,just edit the style when you want to change the look.) To give a fast facelift to a

set of deadbeat subheads or other type elements- automatically-open the Find/Change
box (Cmd-F or Ctrl-F). Uncheck Ignore Attributesto expand your search options. On the left
under Find, click the check boxes and existing styling attributes you want to change. On
the right under Change,click the check boxes and new type attributes you want instead.
Skipthe Textoption at the top, but do check the Font, Size, Color, or any of the type style

buttons-Plain, Bold, Italic, and the like. Press the Option or Att key, and click Find First.
Look at a few instances to be sure you set up your search correctly, then choose Change All.

See alsoMReplace Unsightly 1l.ndftIlnu with Italic~ (this chapter).

~- ~
WHAT ARE THE OBJECnVESr

~\ '04
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. 6 @ MAKE SNAZZY BULLETS WITHOUT GROANING

You can automatically

convert every bullet in
your brochure into a

colored Zapf Dingbat

or another picture font.
Open Find/Change

(Cmd-F or Ctrl-F) and
in the Textfield under
Find, type in the bullet
character (Option-8 or

Alt-Shift-8) or whatever

character is used in

O~, 0-- .",_eo..
018""-""

yourstory.Then,in

~ rDoMgo
~-' fChoo9<M' Change,typethelener

you want to use for

your Zapf Dingbat

CoNfor square bullet). UncheckIgnore Attributes to expand the search options. Under Find,

click Font and choose from the popup menu the font used for your existing bullets.Switch
over to Change, and again dick Font, but choose Zapf Dingbats or other picture font. You

can also replace blackbullets with colored ones using the Colorpopups. PressOption or Alt
to Find First, then choose Change All to quickly transform all your plain.Jane bullets into

eye-catching attention-getters.

See also ~Getting a Quick Zapf Dingbat" (Chapter 8),

elterBl.llkingHome.ECjuJry.Loan.giveyou
these-advanlagesover-other-typesofloam'
.. Ann.aiYeinteretit-rates1
.. Longnopaymenl.perlod'
.. Tax-deduaibleinlereu'

UTneed

Ill". ."05tylo~..!;
'1100"".

!ih- '''''010,1., titQ§j.. 1.p,

Dc""",, 8i11",i
OfWoose,lo:

".'!lV"'''..''"!!''''
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. 0 e BETHOROUGH-SEARCH TEXT ON MASTER PAGES

~ - Ikaowyo'g'y""o'tth,,,,p'tt;ag;,,-
.#>tnerglze.

W::'
a-M,-,-, ho"", m'k;ag '-o-a-opmj,,,,

0 e
'1M - with multiple formats,and naturallyusing

r:::. l r:::..::.nn multiple master pages. Butdo you know

~ 0--- !!I '...!!III thatYOUrF,jnd/Changesea~ches(Cmd-Fof

fc~
" '

~ (! Ctrl-F)don t automatically Includemaster
f pages?

It's a small extra step to hop through

all your master pages with any search.
Doing complete passes with searching is the most sensible method so you

don't have to
keep track of which story Of master you've searched. After searching the layout, leave all the

same settings in Find/Change, but now go to any of your master pages. The check box in
Find/Change that just a minute ago said Layout, now says Masters. Check that, then press
Option or Alt and click Find First, then Change All or examine numerous instances first, not a

bad idea, Quark will search the current master page and then move on to all of the others.

. 6 6 WILD CARO SEARCHES FOR NUMBEREO LISTS

Got a manual with a

ton of numbered lists?
Jazz up those numbers
with a contrasting font

and color. But what a
job to locate and
highlighteverynum-

ber! With wild card

searches, your worries

are over. To search for a

variable character, type

thestring"\?~For
numbered lists, make a character style sheet with your font and color. Then in Find, search

for each one digit number, followed by a period: \?-better yet, because this search finds
the last letter and period of each sentence, add a return character before: \p\? Uncheck the

Text field under Change to keep those characters. Below, still under Change, click Style

Sheet and choose your character style.To search for two digit numbers, use \?\?or \p\?\?-

and if there's a tab before and after the two-digit number, use \t\?\?\t.

Join Nature1sPathways now.. F~
Forthese great benefits, r:,':"", ..Have-lunexerd6lngwlthfr1end~ :::::.

~~[ l~:il~=Ei
~'"-, c-.,..". !!!I eu. C!............-..- '0-".,,,,",,,,,,,,' .~ 0-0....
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8 0 8 SEARCH FOR SPECIAL CHARACTERS

Paragraph marker

New line marl<.er
(§oft return)

Newcolumn
(singledownarrow1

New box
(double-downarrowl

Displays in Field or
Can Just TypeThis
\t
\p

\n

Ctrl-keypadEnter Ie

CUfren!auto-page

number

Ne><tlinked.boxpage

number (continul!'d on)

Ctrl-Shift-
keypad Enter

(1,1-3

.
Ctrl-4

Previomlinked.boxpage Cmd.2

number (continuKlfromj

Flex ,pace'

(trl-I

\.(Mac)
\f(Win)

\\-

P'S,lfthislistseemstoomuch,justcopyandpo,teintotheFindfl('ld.

"Fixed'p"ceyou'p«ifyinChorocterprne,encf!S
"ForMoc&Win,youconolsojustrype1:
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This chapre! gets you to the heart of
f7i':

any well-designed page-typeserting. l,,{..I

Without exquisite type handling, your

gorgeous graphics will crumble with clay feet.

Your Own Bumper Stickers
screamin' type tips

With 50 tips, here's Q nitty-gritty gold mine to

sink your teeth into-starting with character

attributes, which deliver the bulk of the type

Nlook,
6

everything from getting a font fast to

penetrating the secrets of rhe track editor.

Type effects will inspire you with gradient
type, hanging punctuation, perfect drop caps,

grunge type, and more. How about those

authentic geek type things-soft returns,

dashes, and spaces to make your pages look

truly professional, down to the last em- Qnd

en-dash. Then dig down in the trenches to

deliver true "typography6 for maximum read-

ability-paragraph attributes, including tips

on leading, paragraph spacing, and global

word spacing. Can't forget about hyphen-

ation one of the most importanr and least

understood features in Quark. Finally,

everyones favorites-tabs and indents

<ha>, including doing equal-interval tabs.

Mastering these tips will take your type to

new heights-and not just with baseline

shift! What does that mean? More people

will actually read more of your message.

That's progress!
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800 GETTHE FONTYOU WANT WHEN YOU TYPE IN A NEW BOX

I

"---
'o. .."".- :'
.~

""'''''''''.>.~'~''''''

When you make a text box and start typing,

would you like that default 12pt Helvetica or

Arial text to be more to your liking? You
won't

find the answer in Quark's preferences fortext

box tools. But you can control the default

, type specifications by editing the Normal

w paragraph style sheet With no files open,
press Shift-Fl1 (Edit> Style Sheets) to open

~:: 6= the DefaultStyleSheetsdialog. With the

D- C c.o, 'Normal stylehighlighted,clickEditto open a

~~'
I"
~"':' ~:="

i second dialog. Click Edit again, in Character

-- I
Attributes, to change such options as Font.
Size,Type Style, and Color. Change paragraph

~ 11M attributes
by dicking tabs at the top of the

dialog: Formats, Tabs, and Rules. Now in every

new Quark file, when you enter text, you'll get your favorite type attributes-or at least your
company's favorites! And, it can be just as helpful to do this with a given project or layout open,

il
C I

'-' ITC_;"-"'''''...~..
:.--~..- ,...---.

"..
''''"-

.!oiii'"
-.----

~

8 e 8 AVOIDING LONG LINES FOR FONTS

I'll bet many of you have I-o-n-g font lists. When you're scrolling through dozens of fonts

in the Measurements palette, your highlighted type could already have a new face. Every

time you want a new font, use the keyboard to highlight the font field in the palette using

Cmd-Option-Shift-M or Ctrl-Alt-Shift-M. Then type the first letter or two of the font name.

Chances are the font name you want is already displaying. Typing the first letter pops up

the first font starting with that letter, and so forth-it's alphabetical.Press Return or Enter

to apply. When you don't know what you want, just cycle through your font list. Going down

towards Zapf Dingbats, use Option-F9 or Ctrl-F9. Or, going up toward Adobe Caslon, add

Shift-Option-Shift-F9 or Ctrl-Shift-F9. Your type automatically changes each time you

press those keys. Return or Enter not required..

Highlightfont n~me Cmd.()ption.Shift-M Ctri-Alt.Shift-M

Nextfont down Option-F9 Ctrl-F9
Nextfont up Option-Shift-F9 Ctrl-Shift-F9

~\
'Notethoron,.rhefirsrfonISlorringwirhrhelf'rtetyoupressedisdispiayedyoucanu;eth~up/downarrow.eysfa9auPo'

dawnlh"fontli,t-Th<lNexrFonlDowna'UpkeY'fto""~1i5redbelaw,dan'tWOf"inthi,wse.
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.6 e USE"TRUE"FONTS,NOT BOLD AND ITALIC TYPE STYLES

~bo'idfunt
RFJU9!rRanmwlthl:oldslyie
ag bold style
Century Expanded Regular Italic fant

ag italic font
Cl'ntury Expanded Regular w'ith italic st)1ing
ag italic font

For print documents,you shouldalwaysspecify
bold and italic type by using a font instead of

bold or italic styling (Cmd-Shift-B or -lor Ctrl-

Shift-B or -I). Most importantly, you're seeing on
screen the actual font you'll get when the job is

output. 50 when you use tracking and kerning

to tighten up letter and word spacing, your

decisions are based on the actual letter forms,

rather than a simulated version of those letters.

In short, you're not working blind. And, on

another front, problems can occur when outputting high-resolution files that don't use true
fonts, especially with older imagesetters. Using the real thing gets you more predictable and

trouble-free results. Unfortunately, it takes longer to choose a font than press a button or use a
keyboard shortcut. So use paragraph and character style sheets so you're only choosing the

font once.

. e 0 GETTING A GOOD POINT SIZE

The point size popup menu
offers only 11 sizes from 7 to

72 pts. but you can choose
any whole number,as well as

tenths, and even thousandths

of a pointGo ahead, type in a
number. Don't even use your
mouse. Highlight the font

field in the Measurements
palette using Cmd-option-Shift-M or Ctrl-Alt-Shift-M. Press the Tab key to highlight the point size

field to type your number.What'sa good sizefor type on a standard page? Serif type (Times,

Palatino) setsabout a point sizesmaller than sansseriftype (Helvetica,Arial, or Gill Sans).And,

with more columns and a shorter line length, the point size should be smaller so you have
enough words for a readable line of type.Choose a point size in relatioo to the length of the

line, and based on whether it's serif or sansserif type.

HIII..VETn:A 10-NO T1IACK TIM.. 11-NOT1lACK

Then. slowly.he took her hand as Then. .Iowly. he took he.-hand ao
hegllifloedb&ld<ltherforonelast bglancedbackatherforone]ut
loall,bl!f(J'"e6hllfadedintolt1edi~ look, befor".hefadedinleth"di.-
tanceolalonglOlStdrea'Tl,Hehad tam.'eofaloogI08tdream Hebae!
hopedthltSlemightbeabieto hoped thatllb"lI1ightbe ab!e to
stay with him as he made his way my with him

"'

he made hillway
3Iongthetreadlerousplth.but alonathctreacheroulpatb,but
then he knew. ~ was rlOI:to be then he knew.

it""'.
not Ie be

TWQ-columo

Thr~olumn

Serif
10-1l pt
9-10 pt

9-10 pt

6-9 pt
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. 0 e FIND THE PERFECT SIZE-VISUALLY

The best tip around for sizing type til it looks good is keyboard shortcuts. After all, when you're

not sure how big that headline or body copy should be, why try one number, then another
and another,Instead go larger or smallerincrementallyand when it'sright,stop!Thereare
two sets of shortcuts to sizetype up or down. ShortcutsfortheNstandard"incrementsthat are
listedin the popup menu makejumps in point sizeup or down,with only 11 choices from 7
to 72 pt. So. when you're starting with 12pt text and know it's

going way bigger, use the large
increment shortcuts.Then, when you're in the ball park. switch over to 1pt increments to fine-
tune. Polishing is easy-just add Option or Alt to the previous shortcut.

Win
St.lnderdlncrem.nt.-
Larger Cmd-Shift->
Small Cmd-Shift-<
1pt incr.m.nts-add Option or Ait
larger Cmd-option-Shift-> Ctrl-Alt-Shift->
Smaller Cmd-option-Shift-< Ctrl-Alt-Shift-<

.U,esme,jzesU'ted.
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. e @ QUICK TYPE STYLES

I know I just said above not to use bold and italic type styles but to use true fonts instead-

that's a production tip. But when you're
designing,

it's better not to get bogged down in

production detail because you're noteven sure that the design will fly. Besides, design and

production are different mind-sets. It's much easier to use type styles in the design stage.

Applying type styles from the keyboard saves a lot of back and forth mousing. Later on, you

can use Find/Change or Font Usage to switch to the true fonts.

TypeSI)". Keyt..tt.r ShOrlcutMillc ShortculWln

Plain P Cmd-Shift.P Clri-Shift.P

Bold B Cmd-Shift.B Ctrl-$hifl-B

Italic I Cmd-Shift.1 (trl-Shift.i

U Cmd-Shifi.U Ct.I-$hift-U

Word Underline W Cmd-Shift.W Ctrl.Shift.W

Strikethrough I Cmd-Shift-I (t,I-Shift-1

Outline 0 Cmd-Shift-O Ctrl-Shift-o

S Cmd-Shift.S Ctrl-Shift-S

K Cmd-Shift-K Ct,I-Shift-K

H Cmd-Shift.H Ctrl.Shift-H

Cmd-Shift-+ Cnl-Shift-o

Cmd.Shift.. Ctrl.Shift.9

Ctrl-Shift-V

All Caps

Small Caps

Superscript

Subscript

Superior

See also uUse True Fonts, Not Bold and Italic Type Stylesu (this chapter).

See also UChange All Those 11 pt Hobo Subheads to 10pt Brush" (Chapter 7).

See also UBatteries Not Included-Picture and Font Usage~ (Chapter 12).
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. e 8 SUPERSCRIPT OR SUPERIOR-WHICH IS WHICH?

Do you use Superscript with footnotesS,

ordinals (15t), and $? Pressing Cmd-Shift-+ or

Ctri-Shift.O (zero) for Superscript raises up the
text, but doesn't make it smaller! But Superior

does it all. Use Cmd-Shjft-V or Ctrl-$hift-V to

raise it up, shrink it down, and automatically
top align the footnote or text to the cap

height, which is ideal. But occasionally, jf

you're a type geek, you need more control

--'---,
over the offset. Use Superscript because you

can control that distance text is raised up

from the baseline and it affects aU instances

in the file. Press Cmd-Option-Shift-Y or

Ctrl-Alt-5hift-Y to open Preferences. Click
Character,a Print Layout preference, for
Superscript, Subscript, and Superior options,

Change the default 100% VScale and HScaie settings to size up or down the superscript (or
subscript). Change the amount of the offset from 33% of the point size to a number appropri-

ate to the body copy font.

I~"'~S::~
-up or
. p~r

u

- upersa

upe!'8Crij:t

-
p

--

Stranger in the elevator

. e 8 FASTTRACK TO TRACK AND KERN TO TIGHTEN HEADLINES

Stranger in the elevator

Whether you're in the design or production
phase, you need tracking and kerning for

word and letter spacing. Otherwise, your

headlines look, well, flabby. So kick in the

track and kern for largertype,sayover
16pts, highlighting the text to track,and

starting with an insertion point to kern.

Butwhen you track or kern with the

Measurements palette, does it drive you
nuts that it goes from zero to" -10. when you click on that left arrow opposite the tracklkern field?
Overkill! But ifyou add Option or Alt when you click,it changes in units of one. Even better, use

Cmd.option-Shift-[ orCtrl-AIt-Shift-[ to remove space in units of one (without Option or Altfor units

of 1
0),

To add space, replace "[N with
'r: Vo'hen

you use style sheets, you can include a track setting for

your headlines to tighten spacing.but kerning must be manually applied.

Strallser ill the e(evator

StratItJer ill tfte elevator
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. e 6 TRACK BODYCOPYTO FIX SHORTLINES

Printa hardcopyfirstto do this crucial level of proofing.

Examine the body copy,lookingat the last lineof each
paragraph. Ifthere'sa short last line ending in a three- or

four-letter word or, worse, an "ing" or other hyphenated
syllable. prepare to tackle. Get rid of short linesand
hyphenated syllables with a quickhit of tracking.
Highlight the entire paragraph by clicking four times

in succession with the Content tool-lickety-split
timing not required. Then press Cmd-Qption-Shift-[ or

Ctrl-Alt-Shift-[ a fewtimes to tighten up the letter and

ward spacing until the short line is bumped up to the
previous line. Bonus! You've gained a lineof space.

Don't
go to more than a -4 setting without checking it

on a proof. Avoid tracking just the last couple of linesor
words, which makes the paragraph spacing uneven and

more likely requires a higher setting.

8I-'-'-'---:~-;;;;;;;
,

ID~~III!J

. e e TRACK A FONT FOR All TIME WITH TRACKING EDIT

Futura Extra Bold Track your favorite foms once and for all. Set

a sample headline in the desired font. Record

your track settings for up to three point sizes,

plus a fourth smallest size below which track-

ing won't occur. To track your font for all new
documents, dose your Quark files, Go to

Utilities> Tracking Edit and select your font.

Click Edit to display a chart of the font's track-

ing by point size, Across are the point sizes,

down are the track settings, with a horizontal

line at zero to initially indicate no tracking for

all sizes, Click-and-hold down right on the

zero line, near the Y axis to make your first point for the smallest size below which no track-
ing will occur. Move the mouse slightly to adjust the setting until the display, in the upper

right. has the desired point size with a zero track value. Repeat for three more point sizes,

using negative track numbers. For Futura Extra Bold, I have 14pt-Track 0, 20pt-Track -3,

36pt- Track -5, and 48pt- Track -7.

~
::'--'-'.a"

,_.t..

~
"

, ,... ,_."

"' ~
-"U' ~:: =

.m ~--
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. e e TWEAK BAD LETTER PAIRS WITH KERNING TABLE EDIT

BI~~~t"~2i~:~~~~
BO

l
ld

I 1181"'_.'8:><1 «PI.i"~> i:.:
illo_OIIV ""I_loId«Plilln»

I!
Hrl ~

.e

~ -~"'-
~~

The pairkeming editor can fix bad Ietter~cing

for spedfic pairs of letters in a single font,suchas

AGaramond Italic.For pair-kerning body copy,
style a long imported text file in the font you

want to edit and at a typical point size.Orclethe

worst letter pairs on a hard copy.(For pair kern-

ing changes to affect type in all newfiles,dose

all Quarkprojects.) Go to Utilities> KemingTabie

Edit,selecta font,.then Edit You1l see existing

kern pairs available for many fonts. Select a pair

on the left to see it displayed opposite with the

current Kern Value.Change the amount of kem~

~ ~ ~ ~ ingbelow,pressingRetumorEntertoapply
the newvalue to that pair and seethe display

update. Negative numbers tighten space, p0si-

tive numbers add If you Option- or Alt-dick the up-down arrows,kerning changes in units ofone.1f no

kern pairs are listed. type in a pair, enter a kern value and press Return or Enter.Your kern values for this

font are applied to all type over 4pt To avoid auto-keming at body copy sizes. increase the point size in

the Auto Kern Above option (Character preferences).

8 e @ REMOVE MANUAL KERNING

If you're involved in workgroup

publishing or you work in a place

that gets lots of Quark files, like a

prepress house, you've probably

seen some lousy over-kerned

type. Kerning on steroids. Getting

rid of kerning used to be a royal pain. If you tried to highlight the text, then changed the
setting to zero, you were actually removing tracking, not kerning. So then you'd have to dick

between every pair of letters to reset the kern value to zero-too much work! Happily

there's a new command bestowed upon us to solve this very problem. Go ahead and high-

li9htthat ugly text, then go to Utilities> Remove Manual Kerning-a big leap in the right

direction of quality typography and shorter days.

,
Tratl<irtgEdll'

~K.'njngT.b~"Edlt

~~-, ~~:;":<k'.. ~

Co"...nOldUndoriin..

Making a Mess
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. e @ ADJUSTTYPE VERTICALLY WITH BASELINE SHIFT

~
~

~

Baseline shift is used to raise highlighted type up (positive
number) Of down (negative number) from the baseline of

the type. It's usually applied to small type elements, just a

bullet Of special character, never to a whole paragraph.

For example, sometimes the bullet character is too klutzy-
looking next to text in the same font and probably more so

when using a contrasting font, such as a Zapf Dingbat or an

ornament. So you size down the bullet, but then it's too low
and needs a boost Typically,a bullet is top aligned to the
top of the lowercase letters. You can also use baseline shift

creatively when designing logos and other specialty type

treatments. Because baseline shift is in the Character dialog,

it's much easier to press keys.
BaseUn.Shift Mac
Uplpt Cmd-Dpt-Shift-+ Ctrl.Alt.Shift-o(zero)
Dowolpt Cmd.Opt.Shift.hyphen Cnl.AI!.Shift-9

8 e @ INCREASE DRAMA WITH REVERSETYPE

Illi"iL"IrlrvlilC1',',,,,,,,~,!oI.!I8

It' !IOU thought
thl. year was tough...

What would I take to a desert island?

Reverse type! That's .whiteH type on a

black or color background-to be
exact,. it's just the paper color. It's a
great way to get dense areas of color

on the page, even if it's black Very effective for positioning two important statements close
together without competing. For example, you can put the name of a repeating newsletter

column like"President's Message" in reverse, but have the specific headline,.Stormy Weather,"
appear in positive, black-on-white type.To make reverse type, highlight the type. then in the
Character dialog {Cmd-Shift-D or CtrJ.Shift-Dj, select White for Color. Or in the Colors palette, click

the"A"button at the top, then click White below. Give the box background a colOl"so the type
pops out,. or put the type on a picture-Text Box Background Color is None by default in Quark 6.

See also "Type with Gradients" (this chapter).
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. 6 @ SMAll CAPS WITH A TWIST

WHAT WENDY WANTED

WAS A WHISTlE

Headlines in small c.apscan bean elegant

touch in a more formal-Iooking design.

L..etters that aretyped asc.apitals remain

as large caps, while the lowercase letters

become small caps. It's
easy to just high-

light the headline and apply the small caps

style (Cmd-Shift.H or Ctrl-Shift-H),butyou

can get more unusual effects by experi-

menting with the height of the small cap

letters in relation to the large caps. Go to

the Character preferences {Cmd-Option-

Shift-Yor CtJ1.Option-Shift-Y} and mange the Small Caps V5ca1e and HScale from the def.3ult of 75%.

For tall spiky caps, reduce the percent,or to make the small caps almost the same size as the large

caps, increase the number.For variety, try djfferent percents for VScale and Hscale.When you go to

Preferences, it doesn't matter whether your type is highlighted because your manges affect all small

caps text in the file.

. 6 @ TRACK TYPE FOR A WIDE-OPEN-SKYlOOK

Although you tend to think

of tracking as something to

tighren word and letter spacing,

it can be just as enhancing, for

~~~:;;7 sEg[i; ~~~?2~ ~~~;:~~:~:~~~~~Oaav~~:~~~en
look.Try it on a running head

where you want a nicelydesigned treatment at the top of each page, but not so obvious that
it competes with important headlines placed just below. By adding generous space between

letters, you get a very airy feel-attractive but subtle. Dress it up with all-caps to give more
contrast to the main headline. But the key is to add enough positive tracking to make it look
deliberate. Otherwise, it looks like wishy-washy and badly set type. After highlighting the type,

press Cmd-Shift-] or Ctrl-Shift-] to add tracking in units of 10. For 1pt intervals, add Option or

Alt.To close up space in those large increments, usetheH[" (left bracket) instead.

~~~~,~"i~g, ~.~~.~.i.~.~
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. e 8 HANGING PUNCTUATION-LARGE QUOTE OR BULLET

.. ~ {Ita! ('flit file IY; oMeN/iai kbel1y

It, (.btaiN
a- hllit') len'P'ra';f rY/etj'

d&Jel'Ut! lU:il/teJ' !ilJfJ1! /IN
~J'."

-
BenjaminFranklin
[1706-1790]

Typographers agree that the page looks
better and cleaner when quote marks,
bullets, and similar non-alphabetic

characters hang outside the text box,on

the left. sothatthe type vertically justifies

ina clean line. Doing this in Quark is a bit

indirect but not hard. First put a word
space before the quote mark or bullet.

Click with the Content tool to make an insertionpoint between the space and the quote
mark.Usingrepeat hitsof Cmd-option-Shift-[or Ctrl-Alt-ShifH you can kern back the space

incrementally so that the quote mark is rlO longer visible-until you print the page. And there

it is.hanging out inthe margin in all its glory, and you've got a nice, clean vertical left edge.

8 0 ~ TYPE IN A BOX WITH A NEW ANGLE. Beyond the Blue~ ..
ByBethanieByron

Byron's book recalls the 50's and early

60's when life in the US had a carefreE
lifestyle. prior 10 the sex, drugs and roc

'n-roll onsJaught, not to mention the

Vietnam war- whkh hmlll!"hl our count

Make your type more like a graphic-
very useful with a text-heavy layout

that's lackluster.This technique works
best for accent type, a keyword or
phrase, rather than a headline. Start
by drawing a text box using one

of the six shaped text box tools
(Rounded-, Concave-, or Beveled-

Corner; Oval, Bezier,or Freehand), or

the Starburst tool, at the bottom of

~ the toolbox. Toconvert the default
T

T

:X

"

t

, ~... ~...

Ie

.
:

~
n

3a

. starburst picture box to a text box,go

-
,- to Item> Content> Text. Choose Get

Text paste or type in yourtext.With
the Content tool, Cmd- or Ctrl-double-click on the text box to open the Modify dialog. Click on
the Text tab and right at the top, type in a newText Ang!e. Click Apply to see it change on the
page. Small numbers such as 15-250 go a long way. Fill the box background with a color or
tint. The ragged edges on the type are just a screen display thing and print out fine.
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tit 6 ~ PERFECTING THE DROP CAP-PART I

E er)'Jneagreed that his stat. Dropcaps are a piece of cake in Quark.Their

ent was shocking. Buthk5
purpose is to draw the eye down from the

»tentlon left room forc~oos
~:::~~~ ~~v~~.gAt~;:a~a~:~ :~i~~~~~~;t

into

specutatiol1. Had he rNllylntendedto
the drop cap is to style the first letter in a

in~[tth{' Prim{> Minist:er?Probablynot, contrasting type face-something heavy in
Onthe othM"hand,lt certainly ishard to weight or having a decorative quality. Then,

fathom.Evl'ryone from thp Q.I{>en on with your insertion point in the paragraph,

down shook th{>irh{'adsandtlttE'Yed. go to Formats (Cmd-Shift-F or Ctrl-Shift-F).
~~~_~~.I~ :~~i~~~~.~::~:~~::;,~:t~~~a~:~;;~Ph

,
drop the cap into 2 or 3 lines. The longer

your line length and number of lines, the more lines you can drop into and the bigger the

resulting cap. After you click OK, kern the space between the drop cap and the next letter
by clicking an insertion point there. Then press Cmd-Option-Shift-{ or Ctrl-Alt-Shift-( to

tighten, or press Cmd-Option-Shift-] or Ctrl-Alt-Shift-] to loosen

. 6 8 PERFECTING THE DROP CAP-PART II

Il'ftrc

Hadhl'n>al~

PrlmE'Mlnts"

othE'l'hdt1d.

[VE'tyol1E'fn

thE'trhE'adsi.
er"-;;-~

'1iI~1!IE-tr-'-

VE'r)U
Makingadelectabledropcapcantakeabit more.Thespacingthat precedes

wass a drop cap is often too big, preventing the cap from making a clean vertical

alignment with the lines below.To push the drop cap to the left edge of the
box, go to Formats (Cmd-Shift-F or Ctrl-Shift-F) and give it a Character Count
of 2.Then enter a word space in front of the drop cap and, with your insertion
point between the space and the cap, kern back the space until the cap is
perfectly aligned to the left edge of the type below. (See the previous tip
for kern units.) You may also need to adjust the cap's vertical alignment if it

sits too low. It should top align with the cap-heights on the first line.Apply
baseline shift to the highlighted cap to move it up or down.To go up by lpt:

Cmd-opt-Shift-+ or Ctrl-Alt-Shift-O.To go down lpt: Cmd-opt-Shift-hyphen

orCtrl-Alt-Shift-9.
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. e @ PERFECTING THE DROP CAP-PART III

--
Believe it or not, there'sanother step that's often required to make a great
drop cap. With somefonts,when you drop the cap,

it's a bit too large or
small.Too small is the worst, the top of the cap is lower than the x-height-
the top of the lowercase letters on the firstlineof copy. And sometimes it

sticksup too much,although that can be an interesting look. In either case,
you can change the sizeof the drop cap using the Measurements palette.

Firsthighlight the cap, then go to the point size field inthe palette and

you'll see the cap size as 100%.To enlarge or reduce it choose a percent

over or under 100%. Fine-tuning par excellence!

Ev","",n,
wds!!t1o
leftrool

Hadhprt'allyir
PrimeMlnlstel

~1!tJ.it(
~~.-

. e 8 FANCYTYPE WITH TWO COLORS USING TEXTTO BOX

Make an eye-catching,color-blastingheadline by

converting text intoa picturebox,usingdifferent
. colors for the box background and frame, First style

your type the way you want it to look-minus the

two-tones. Track and kern, you can't do it later.Then
highlight the headline-with multiple lines, highlight

just the f1rst line. Go to Style> Text to Box. and your
type is one shaped picture box. Repeat the process
for a second line. Add a frame width. Select the

picture box and go to Frame (Cmd-B or Ctrl-B).Then
apply different colors to the frame and box back-
ground using the Frame and Box tabs of the Modify

dialog (for multiple boxes, it's the Group tab). Your

letter-shaped picture box can be stretched and

squished! In addition to the new picture boxes, you

still have the original editable text. Move it to the
pasteboard for possibletext edits lateron.
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8 e ~ TYPE WITH GRADIENTS

.,..In' Ja;
I ?llrrn~1 ~

For a more dynamic look,fill headlines or

other type with gradients, or Quark Blends,
by converting them to picture boxes using

Text to Box. In the Colors palene. click

on the top right button forthe box
Background Color. Just below, horn the
popup menu that says NSolid,Nselect a type

of blend: linear, Mid-Linear, Rectangular, Diamond, Circular, or Full Circular. Just below that,

there are now two radio buttons for#1 and #2 blend colors.Clicka color in the listbelow,
then select the #2 button and choose another color.Withthe two types of linear blends,you
can enter 90° or-90' in the degree field to blend vertically orO' or 180. to go horizontally.
Or experiment with other angles.To get rid of the big distracting NXNacross the letters that
indicates it's a picture box, select the box, then go to Item> Content> None.

See alsoMFiilncyType with Two Colors Using Text to BoxN(previous tip).

8 e ~ TYPEONAPATH

6,

~\\\ day,o
.. ~~,i:tr~

~\
. ~

~!I. ~~

For text on a straight-line path, click-drag the

line- or Orthogonal Text-Path tool. The latter
makes easy lines on 90° and 45° angles. For an
irregular path, drag the Freehand Text-Path

tool. The Bezier Path tool provides maximum

control but it's the least intuitive if you're

new to pen tools. Draw a set of straight-line

segments with corner points using a click-

and-release method, moving the tool to a

new spot each time. Curves are harder. Click-
drag to draw a smooth point with a set of

control handles that set the curve's slope and fullness. Drag in opposite directions-click-
drag up, move the mouse, click-drag down-for one curve. The more you drag, the fuller

the curve. Control handles should extend about one third the length of the curve segment.

End a line by double-clicking on your last point or changing tools. Enter or paste text on the

selected path by clicking it with the Content tool. Style as usual.
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8 e 6 WRAP TEXTINSIDE A SHAPED BOX

l':"'~.
.",~'.~~..E't-~n,h'~n;1I

£f.~~~Jl;j~c":~~i::
douds roll-in'-b~t (th" ~u,

I"'sitsw,,.iofsur',,~
in)!.. ju,;t in tJfd'

Did,'ol tin...
Oh ",,1

Grab the reader's attention with text in an unusually

shaped box-great for a set of testimonials or a "New

Item" accent. Draw a square or circle text box (Of pic-

ture box..for that matter). With the Rectangle or Oval
Text Box tool selected, press the Shift key as you drag

out When it looks the right size, release the mouse

before the Shift. Of course, the oval text boxyouget
without using Shift is also fairly unusual. Use Get Text.
type or paste your text in the box. To get the text to
visually create the shape of the box, without using a

. background color or frame weight, size the type

down and justify it. More adventurous? Change the
shape of a selected text box with Item> Shape, then

select from the five shaped boxes. Or, with one of the

line types, your box is converted to text on a path!

See also~Make a Wacky or Sublime Picture Box~ (Chapter 4).

. e @ "GRUNGETYPE"-VERTICALLY OVERLAPPING TYPE

.

I believe it was Robin Williams, the

desktop graphics author and guru.

who coined the term Hgrunge type"to

describe type that looks Hon the edge/

or maybe she just brought the term

to my attention. A funky typeface can

have a lot to do with an edgy look,

but so can leading. It's called minus

leadin{Js when type is set so that that

the leading value is smaller than the

point size and the descender5 of

one line touch or overlap onto the

cap-heights of the line below. In traditional typography, this would be verboten. But in our

topsy-turvy world, it has a dramatic, eye-catching look that may be great for headlines or other

type. So, for example, if your headline is 20pt, try a leading value of 10to 14 ptOfcour5e. this

may not gel with a classic. corporate identity, but it's
great for a contemporary, agitated look.
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.. 6 0 STRANGE TYPEEFFECTS

Here's another funky
approach to grunge type-

non-proportionally scaled

text-though type purists

will cringe! The easiest way

to judge how far out to go

is to scale the type visually.

With the headline or other
text in its own box,press Cmd or (trl and drag a box handle to alter proportions. To scale just
one dimension,Cmd- or (trl-drag a center handle in or out Ifyour headline shares the box with

other text,you can horizontallyor verticallyscalethe highlightedheadline using Cmd-] or Ctrl-]
in 5%increments,or add Optionor Alt for 1%. Whatever scale type you last used, horizontal or

vertical, is what you'll get using the keyboard.To match those settings for other type, check the
Horizontal or Vertical Scale percents used in the sample highlighted text. Press Cmd-Shift-D or

Ctrl-Shift-D to open the Character Attributes dialog and note the Scale type and percent.

~~

.. 8 @ THE REAL SHADOW TEXT

Shadow style? Here's the

real thing. With the text in

its own box, do Step and

Repeat (Cmd-Option-D Of

Ctrl-Alt-D). With Repeat Count 1, change the ofuets to 0, then close. Now there's a duplicate

box on top. Flip the highlighted text vertically, clicking the big up arrow in the Measurements

palette. Next set the Runaround to None (Cmd-T or Ctrl-T). Shift-drag it down to vertically

constrain the move-press Cmd or Ctrl with mouse down, add Shift. then drag. Stop when

the baselines of the two reflected lines are aligned. Set the Text Skew to about (--60°) in the

Text tab, Modify dialog. If needed, extend the width of the duplicate box, dragging a center

handle. Then move the box horizontally to realign the slanted text. Increase the shadow

effect by shortening the box height: Cmd- or Ctrl.drag up the bottom center handle, then

again readjust the box position. Tint the shadow text color (Cmd-Shift-D or Ctrl-Shift-O),

Effect doesn't work with descenders!
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LIGATURES WITH CHARACTER PREFERENCE

Filbert finds the
flea and flows the
fickle floozy.

.1ToP.I~'11

Filbert finds the
flea and flows the
fickle floozy.

.

I~~g:::. ~ ONot"ffl-or'ffl-
I

Wrth seriffoms,likeTImes and Palatino,ligaturescan

be the finishing touches to elegant typography with

a handcrafted IookA ligature is a single character of

text combining two letters thatfla.vtogether. With

fonts like the Adobe Expert Collection, you can get
uptoM ligatures, but even with regular everyday

serif fonts, using Quark on a Mac.you can get two
ligatures automatically inserted into your text

Go to Character PreferencesunderPrintlayout

(Cmd-OptiorrShift-Y orCtrl-Ait-Shift-Y).Oick the

Ugatures check box to automatically replace all

instances off-i and f-l with the ligatures fi and fL The

Break Above setting isthe track value above which

no ligatures occur, i.e, wide letter spacing iscontrary

to ligatures.lf you add ligatures when no OJark files

are open,ligatures show up in your serif fonts for all

new files.Note that Quark can still spell check and

searchtextwithligatures.

8 e @ FANCY PRICING AND FRACTIONS

Getting snappy prices and fractions is easy as 1t (pi) and just a

matter of two steps. First type a price, $29.99, or a fraction,

'is;you can only do one price or fraction at a time. Then high-

light that and go to Style> Type Style> Make Price or
> Make

Fraction. It looks great, but your new fraction may need some
tweaking. If the denominator is touching the slash mark, add

some kerning using Cmd-0ption-Shift-] or Ctrl-Alt-Shift-].
Also, if the fraction looks big, highlight it and reduce the

size. Easiest way is Cmd-0ption-Shift-< or Ctrl-Alt-Shift-<.

One or two hits of the shortcut keys does the trick. And 10

and behold, you have something that actually looks real life!
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8 6 @ SOFT RETURNS-MORE READABLE HEADLINES

Your formatted headline may be wrapping

around to a second or even third line. How
editorially readable is it with the current

line breaks? Does your headline split up a

E"""'''''''''''--' '''''''WI ,''''''''
,.."-,,.. phraselike,"bythe-accountingoffice?"

?,-""-...::.",..~:,, ....~-...
,::-
..~.:... ~§:€~fE]F; :::::~ ~:i~~~~;~~~~~:;;;~rO~:~h~~f~,:~:~~~~;

-.
""-''''''~''-'''''-

"",...........
Insert your own line breaks with a soft

I

:~~':~;~~;.:~:;~~~: ~~:~~;~"::;::

, paragraph. That means you don't also get
the paragraph spacing or indenting that
happens if the headline has those attrib-

!E::~:E=7' ;=;"~!'=7::::001 ~~~~t;r~~e~~;~a~a:f~:~~~:h~~~r~~:
bybringinga word from the end of one

line down to the next. But with editing, that

line break can occur in the middle of a line.

Instead use a discretionary hyphen before
the hyphenated word.

See IIlso NOnthe Spot Hyphenation Fixes-Discretionary HyphensH (this chapter).

Accounting ErrrII'w Run
Rampllnt

~CCDUnting. Erra"":l
un. Rllmpllnt
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. e 8 LONG AND SHORT DASHES (EM AND EN)

You've heard of M&Ms, and of course Eminem? This is Em and En!

There are at least three major varieties...

Hyphen. When auto-hyphenation is on, Quark automatically inserts them.

Em dash. A long dash that's used to separate thoughts as in "He faltered-but stood his

ground." An em is a typographic unit that equals the point size of the type. So an em dash

in tOpt type is 10 points.

En dash. A dash that's longer than a hyphen and half the width of an em dash.Think.

an
"m"

has two humps, but the
"n"

has only one, half what the
"m" has. So an en dash is

half the width of an em dash. Use an en dash to separate dates and times as in

"January l-December 31"or"2-5 pm,"

Whether you like spaces around dashes or not doesn't matter, but be consistent.

Stand~rd hyphen. breaking

St~nd~rdhyphen,nonbreaking

Enda,h,nonbre<!king

Emdash.breaking

Emdash.nonbreaking

Discretion3rY($oftlhyphen (invisible)

Hyphen Hyphen

Cmd-= Ctr1-=
Option-hyphen C!rl-AI!-Shift-hyphen

Option-Sh;ft-hyphen Ctr1-Shift-=

Cmd-Option-= Ctrl-AI!-Shift-=

Cmd-hyphen Ctrl-hyphen

See also"On the Spot Fixes-Discretionary Hyphens" (this chapter).
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8 6 8 SPECIAL WORD SPACES

Don't end up with Southern Bell on two lines-use a non-breaking space between words of a

company or product name. Four varieties of spaces here, from small to large-punctuation,
standard, and en, as well as the flex space, which you can specify for any width in Character

preferences. And you've got five non-breaking spaces. Of those, all but the standard space are

fixed spaces, meaning when type is justified, those spaces don't expand or contract. (Caveat:
only jf you set all three Character spacing settings to .Owfor Quark's H&J Standard setting,

Cmd-option-J or Ctrl-Shift-Fl1.) Use fixed spaces for a constant interval, such as on a fancy

menu where the prices follow right behind the entree listings and are hard to spot! For a

"true"
industry-standard em space, check Standard Em Space in Character preferences-

Otherwise, you get Quark's concoction.

Breaking standard lpace

Non-breakingltandardspace

Breaking punclualion space

Non-breaking punctuation Ip"ce
Breaklngenlpace

Non-breaking en space

Breakingem space (type Iwice) H H

Non-breakingem space (type IWice) H H

Breaking Rexiblespace

Non-breaking Rexible space
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Space

Cmd-S

Shift-Space

Cmd-Shift-Space

Option-Space

Cmd-option-Space

orCmd-option-S

Oplioo-Space

Cmd-Dption-Space

orCmd-option-S

Oplion-Shift-Space

Cmd-Oplion-Shift-Space

Space

Ctrl-S
Shift-Space

Ctrl-Shift-6

Ctrl-Alt-Shift~

Ctrl.Shift-6

Ctrl-Alt-Shift-6

Ctrl-Shift-5

Ctrl-Alt-5hifl-S



. e @ LEADING-NOT AUTO LEADING

Did you know that leading (pronounced
ledd-ing) enhances type readability

more than point size? Body copy looks

more inviting and easier to read when
leading is generous. Many people, how-
ever,fall back on using Quark's default

Auto leading, which is probably the

smallest acceptable leading value for
body copy. With Auto,a 1Opt body copy

has 12pt leading,(say"lO on 12").Try

instead a 3 or 4 pt spread between

point size and leading, such as 9 on 13.

But with headlines, the opposite isoften
true. When a multi-line head is followed

by body copy, leading far that head should be tight so its multiple lines are easily spotted as

one unit. A 24pt head with Auto leading gets you close to 29pts of leading. Try leading at 24

to 26pt instead. A few extra points of leading, at that point size, is still tight.

Leading
Increasebylpt Cmd-Shift-" Ctrl-Shift-"
Incr""seby.lpt Cmd-Option-Shift-" Ctrl-Alt-Shift-"
Oecreasebylpt Cmd-Shift-. Cui-Shift.
Decreaseby.lpt Cmd-Option-Shift-: Cul-AII-Shift-:

1"'1I
:r'1111~1

~__Iora_""""
pcn:ierinawbethorohewaapeo-
haplaworiookirwlOlI2IImJ.But
thmI.inaf\ash,ahou-itw..
aUm.-waiti,.

WJ.n'"
tmed thec:tImII!I;

at.""IOID8thi"lthatrnad.
I.-saan.h_alO 1:8wili.8ri",

that"'.o:>UIdnol_~
itlD sn.~cn'-
I1aaIa.whilllmaulthadccrand

:=;.~::,;=~e:~
thadcc.andlccJ.tin t.r
P "",...8:l8haw..1ci1ad
qainNcc:htnp.

1iI1I.'I~.~...:r:1IJm~

~-~lrJrarm_nI

pcndoIri"lwhllllwslww...pIIf-

AaplCO'8l!ccki"'lOmothi1J.But
tlwn,inaf1aah,8haknawilw"
allo-oqjtirw:

W!.n,w,1IIm>d1lwc:on'lli!t

8ha"WlOmatbi"lthatmada
I.-otan.It bawiliari"l
thatoheaWdnot d.c:ri>e

illDtenelf.SheWno!ll:lcnm

"-!t.wh_doutthadccrV!d
Iookcllfcrfle p/Io:1M
booth.NolOC..rlwd.at.dc~

thedcQr&ndb:>J.t..t.r
purw, 8:lat.waaIci18:l

apjnNcc:J.np
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. e 8 PARAGRAPH SPACING. THE "HIDDEN" ATTRIBUTE

Paragraph spacing can be as crucial as lead-

ing for delivering a message. Used properly,

paragraph spacing expresses the hierarchical

organization of the copy. A subhead, for

example, needs more space before and less

after to visually announce the body copy below. Using equal spacing weakens the editorial

message. Unfortunately, paragraph spacing is in the Formats dialog, not on the Measurements

palette so it's tempting to use blank lines with various leading values instead. This is a mistake

waiting to happen. With multiple-linked text boxes, one of these blank lines will likely fall at

the top of a column, causing a drop in the white space that-guess what-goes unnoticed

until printed! Get to Formats fast: Cmd-Shift-F or Ctrl-Shift-F. Press Tab four times to highlight

Space Before, one more for Space After, then Return or Enter to dose. When it comes to

production, use style sheets to apply paragraph spacing
hassle-free.

Laod;"9 IiP1
~.IoI_: I!E:

i ~.- ~

. 6 6 PARAGRAPH SPACING AND INDENTS-SPECIFY IN POINTS

The conventions of traditional typesetting are a
great foundation. When you specify paragraph
spacing and indents in points, you're talking the

left Indern. Op language of aU other type attributes. Space Before

~ ~:~~f~e:a~~:.s:th:~~~:nt: :;t~n2~;;;::~~~~h~i9ht

have 20pts after (full-line space} or 10pts (half-
line). For the standard first line indent, use a number equal to the point size so 10pt body
copy has a 10pt indent. If you're set to picas, and go to Formats (Cmd-Shift-F or Ctrl-Shift-F),
Op is the default-just add the points after-Op20 for 20pts of spacing, or simply 20. But
with inches, it's more awkward. You can enter points by typing.p"then the number of
points, orNpt" after the number: p20 or 20pt. When you click OK or Apply, however, the
points are converted to a weird decimal number-in this case .278".

See also NTrade in Nasty Numbers-.167", .3125", or .625"-for Picas" (Chapter 1).

~\ '30
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. 6 6 RESET QUARK'S DEFAULT GLOBAL WORD SPACING OF 11 0%

~
~

For good-looking type, know this fact-by default.
Quark is adding 10% extra space between all
words, whether you use Get Text, type, or paste,

or whether the type is set flush-left or justified.
Check it out.Go to Edit> H&Js with Cmd-Option-J

or Ctri-Shift.Fl1.With#Standard default" setting
highlighted. click Edit and look, on the right, at the

110% Optimum (word) Space setting under

Justification Method.The Minimum and Maximum
settings automatically affect the spacing and

consequently the hyphenating of all justified text,

which is fine, but...the Optimum setting at 110%
expands all word spacing in yOUfQuark file, flush-left or justified. Make this fix for all new files.

Close your Quark files, then go to H&Js again. Edit the Standard setting with Optimum word
Space set to 100%. Or, if you're squeamish, make a new setting calledN1 OO%"to apply to text
using Formats or a paragraph style.

PNC..,...IIII"..Projecte -Saes
m-mi1li1asCI

. e e TRYING TO SET TABS AND NOTHING'S WORKING?

:IDIn~ 2D04i' 2OOS+
198~ J9S~ HIt

94> 188~ ]7~.

5~ 119t2JIIt

.:-= ~. :"42. as.
32~ 641-
12~ 241-
JG. 6.

FlndlCI

Cotpcroltfl
ComJll1lda1~
Chlt

~Re9.Statf-..atlonab .
IntunatloM\!. .

' 0--r':,~,~'

O~u'
'II

O"""""""d~~

Ever dick Apply in the Tab dialog and nothing happens?
Many people who type in word processing avoid the tab

ruler. They keep hitting that Tab key to push the text over.

When you get that text in Quark,and apply a tab, the text
sits there because it's actually at the second or third tab!

Be a detective, check this out.Tum on Invisibles with

Cmd-I or Ctrl-l (View> Show Invisibles) to see the hidden
characters. Watch those forward pointing arrows pop

up, each one a tab. Rather than a select-and-delete
approach, use Find/Change (Cmd-F or CtrI-F).Copy and
paste two tabs from the text into the Find field. looks like

"\t\t"Paste them again into Change, but then delete the
second tab. Looks like"\t."Press Option or Alt to Find First,

then Change All.Repeat the search until all multiple tabs

are replaced by just one. Now you're ready!
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. 6 8 TABS-liNE'EM UP EQUALLY

~~~Mf ~h' ~
I

cn~
I
~;g:O"

II ~:\~:~~t~~~~~nt~~~:~::~i:~I~~~:~
click Clear All in Tabs (Cmd-Shift-T or

Ctrl-$hift-T). Add your first and second
tabs, clicking on the tab ruler on the
page and noting their locations in the

Position field. Click Apply. [)Qes the interval between them seem about right? Subtract the first

tab number from the second.Nowadd that intervalto the second tab valuein the Position
field: lOp3+3p3 (inches: 1.708"+.542"). A third tab pops up on the ruler. (If you moved the exist-
ing tab, Undo-Cmd-Z or (trl-Z.) Then,crucial step, click the Set button or better,Cmd-S or

Alt-Shift-S.That totals the numbers and deselects the tab marker on the ruler so you can make
another tab, and not move the existing one. Repeat the pattem-add the interval, Set,add the

interval,Set...until you're done!

Po,ltlon: 1~3+3P31~

FIIICh~,~",,"' ~

8 6 @ ALIGNING NUMBERS WHEN SOME ARE IN PARENTHESES

It's annual report season. How do you get those
infamous loss numbers ($29,000,000,000) to align

with the gain numbers that aren't in parentheses?

You can't use right-align tabs! First, loss numbers are
usually rounded off, no decimal points. So why think

of using a decimal tab? Because it acts like there's a

decimal point after the number and lets the close
parens hang out to the right. Or try an Align-Dn tab,

. which can be used to align on any ol'thing-a close
IIIght

Do'f"'
Com~ paren, bullet, long dash, question mark. whatever.

Just copy your align-on character in the text ").N
[I

~~
I

c~~
I

..:.., 1".:"",,1
c':'"

~, TheninTabs{Cmd-Shift-TorCtri-Shift-T},dickthe
AlignOn button and paste or type your character

into the Align On field beiow.Afteryouclickon
the tab ruler, then Apply, your tabbed text is now

miraculously aligning to that whatever. And with

loss numbers, the parens still hang out.

~

=@i)
~
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8 e 6 BULLETCOPY-CODENAME:"HANGINGINDENTS"

Need hanging indents for bullet copy?Turnon Invisibles
(Cmd-I or (trl-I) to see if there's a word space or a tab charac-

ter (right-pointing arrow) after each bullet. If you have word
spaces, quickly replace the spaces with tabs using Findl

Change-"o" (word space) in Find and ",\t" in Change. Bullets
are Option-S or Alt-Shift-8.For hanging indents, highlight

your bullet copy and open Tabs (Cmd-$hift-T or Ctrl-Shift-T).

See the two small black triangles stacked at the left end of

the ruler? To indent the whole paragraph, drag the bottom

triangle to the right and the top triangle (first line indent)

~ . ;;;: ~f~':eU;~I~~;;~'~~~~y:ue~:~et:~~~~~~:~ke~~~~~~:ft

Ipl0.612:':::'~"'::',1indent numerically in Formats (Cmd-Shift-F or Ctrl-Shift-F).

~
The left and FirstUne indents should be the same number,

~
except the first indent is a negative number.

8 6 6 DESIGNER CHARTS-NO LEADERS, PARAGRAPH RULES

Make cool charts with paragraph rules, not

those old-fashioned leader tabs After your

tabs are set, no leaders, highlight again, but not

the column headers, and open the leading, say
18pt leading for lOpt type, if your paragraphs

are only one line each. (If not, use tighter lead-
ing with paragraph spacing above, instead.)

Then open Style> Paragraph Rules (Cmd-Shift-N

or Ctrl-Shift-N), and dick the Rule Above check

box. Set Rule Length to Indents, meaning the

rules go the full width of the text box, minus
any rule indents, here none. Use a small rule

width, like .25pt for light Iines.The Offset is

tricky,The value is given as a percent, but it

works better to enter points. Try the point size of the type, or a bit larger, and go from there-
10pt (or pl 0). Click Apply to check it out. Ideally the rule above should be vertically centered

between two lines of text.

~

I~h~ '-'-~ ;;;.-. S<~:I ..
fromloll: 0;-- -~: ~@8

I
::~~ig~, ~ ~~'::~~::O~.::
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. e @ FAKE A RIGHT-ALIGNED TAB

r:, II r:)o'. fiTiIIiiTi11(::;":J.pg..3

r;111~:"'.fiTiI'iim1~t

I ::~~r:i~a:~~t~r~:~~~~~

~g.. 31
;~~:~r:~~~~ ~~t~: :~~he
top left and you want the

date on the right of the same line. Or in a short table of contents (no leader tabs allowed!),
you want the topics left-a!igned but the page numbers right-aligned. Just throw in a fight-
indent tab between the two-it's a special character. On a flush-left line of text, highlight the

word space between the left-aligned text and the character; to be right aligned. Then type

Option-Tab/Mac or Shift-TahlWin to send the following text over to the right, regardless of
any other tabs present. Bonus-that text stays at the right edge of the column or box, even if

the box width is changed. If you Show Irwisibles (Cmd-I or Ctrt-I), you'l! see the right-pointing

tab character separating the two.

. e @ INDENTING WITHOUT DIALOG BDXES

M
B"beC'rbJum'SI.'Dalmali

,

on.
wulntJw.habitmrunalngway

ahe.xl 01 hw Mom,lindill8 a
ICraporhrod,lood.and-woU
ingil,dowo,beloreyou couki
oav"Co!(,o, ,,,,,,,-"II"Ho ,.....

thi uoneol,lheolewlhingo
about thi.-crazydog that

!'Ou
julII,hadlO-ovwlook.

The Indent Here character is another way, somewhat
unusual, to do indents, completely bypassing both the

Formats dialog and the Tab ruler. Two small drawbacks-
only one indent per paragraph and no leader tabs. By

inserting the Indent Here character at an insertion point

of your choice, all the following lines in the paragraph

automatically indent to that point-just press Cmd-\ or

Ctrl-\. One of many possible uses for Indent Here is to
draw more anent ion to a drop cap used in a fancy quote

or introductory paragraph. Put your insertion point right

after the drop cap, then do Indent Here-now that large

lener real!y stands out.
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. e {9 CONTINUOUS APPLY IN TAB (OR ANY) DIALOG BOX

This tip is so easy and seductive, you'll slip into a regular

-=::z'"
~ e!iI habit It's called Continuous Apply because once you

turn it on in any dialog box, whatever you do becomes
immediately effective. Well, okay, you might have to dick

in another field close by to tell Quark you're finished typing. Pressing Option or Alt,click Apply.

You'll see the button stay in theNdown" position until
you click it again, no key. This tip is

especially handy when sliding tab markers back-and-forth on the Tab ruler (Cmd-Shift-T or

Ctrl-ShifH),or adjusting the Offset when adding paragraph rules (Cmd-Shift-N or Ctrl-Shift-N).

And an extra perk-when you return to that dialog next time, Continuous Apply
is still on!

. e e NO-HYPHENS SETTING FOR HEADS, SUBHEADS, CAPTIONS

I

N.m"
INo Hyph~n~

rO:utoHYPhe

.

n;lIion-

I <;m3!1~~! Word

Headlines, subheads, and usually captions shouldn't be hyphenated.

It looks bad and makes it harder to read your most visible messages!

Rule out one surefire set of pitfalls and repetitive fixes by making an

H&J setting that has hyphenation turned off. Do it for all files you

make from now on by closing your Quark files first. Of course, it may

also be just right for the file you have open. Go to Edit> H&Js with

Cmd-option-J or Ctri-Shift-Fll.Click New,and type this name:No Hyphens.Then uncheck Auto
Hyphenation, right below. Click OK and Save.To apply the setting to a headline, click on it once
and press Cmd.Shift-F or Ctrl-Shift-F to open Style> Formats.Then select the No Hyphens option

from the H&J popup menu. Of course, the best way to automatically apply a no-hyphens setting
is with style sheets.

See also NAutomate Hyphenation with Styles. (this chapter).
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HYPHENS-GmING TOO MANY OR NOT ENOUGH?

With two columns of justified text on a

~;:~;~-~;,~ standard page, and plenty of words on a line,

--IIn>h you can probably let hyphenation do its
thing. But with three or more columns, exer-

- cisecontrol using H&Js.Hyphenation and
Justification go together like peanut butter

and jelly. Without good hyphenation,justified

text can have big gaps between words, or
letters can be crammed together. In the

H&Js dialog, the numbers you plug in for

Justification Method determine how much

Quark can space out words and letters or

cram them together. The more slush room
youallow, the fewer hyphens you'll have
because Quark only tries to hyphenate when

it can't meet your spacing range limits.

Quark's default Maximum word space setting

of 250% allows word spaces to grow into
gaping holes that can be two-ond-o-half

times the normal space. 'Rivers of white

space"means big gaps between words start

to visually connect down the page.

Goto Edit> H&Js with Cmd-opt-J or Ctrl-Shift-F11.Click Duplicate to make a new H&J setting

for justified text, based on the Standard setting. Change Hyphens in a Row, the maximum

number of consecutive hyphenated lines from Unlimited to 2 or 3. The Smallest Word (6) and
Minimum Before (3) default settings are good. But for Minimum After, 3 characters instead of 2

avoids an"-Iy"at the start of a line. For Justification Method, trying 75% Minimum and 125%

Maximum reduces those gaps and increases hyphenation. Increase the Maximum Character
spacing from 4% to 10% so the word gaps shrink more.

For flush-left type, the Hyphenation Zone controls frequency of hyphenation, not Justification

Method. If a line ends with a word falling in that hyphen zone, Quark doesn't try to hyphenate.

With the default HyphenZoneof zero,Quark attempts to hyphenate everyline. But with a two-
column setup, you can afford to have fewer hyphens and allow a more generous rag (the in-out
profile of the ragged-right edge), so increase the hyphen zone to 1

p
or 1p6 (.167" or .25').
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8 e @ AUTOMATE HYPHENATION WITH STYLES

It's not hard to apply an

~::~::~~~:~Leh H&J setting to an entire
story you highlighted with

the Content tool using

Select~AII (Cmd-A or Ctrl-A).
Just do a quick Cmd-Shift-F

or Ctrl-Shift-F to open Style> Formats and choose your hyphenation-justification setting

from the popup menu. But what do you do when you've got an H&Jsetting you want to
apply to many paragraphs that are sprinkled through the text? Are you going to open the

Formatsboxforevery

headline and subhead? The resounding answer is no!Makea style sheet for each of these
paragraph types and incorporate the appropriate H&J setting. Thenyou can just apply the
style and forget about the H&J that's getting handled in the background! (By-the-way
design tip: Even if your body copy is justified. use flush-left in your style sheets for the
no-hyphen heads and subheads!)

f

c
''''''

~
H'

I

'
H
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8 e ~ ON-THE-SPOTFIXES-DISCRETIONARY HYPHENS

Great.looking type takes finessing.

Correct bad line or hyphen breaks

in flush-left or justified copy using

discretionary hyphens. Bad line

breaks occur when you need a
hyphen. For example,justified
copy can have big gaps between
words. Hyphenating the last word

on a previous line can even out

the spacing. But not with the
hyphen key. Without fail, after

some edits, that hard hyphen

causes a bad break from the

middle of a line! A discretionary
hyphen, however-Cmd-hyphen

or Ctrl-hyphen-does the same
job, but like a good guest, it disap-

pears when not wanted. Bad hyphen breaks occur when you
don't want a hyphen. For exam-

ple, in flush-left copy, if two or more consecutive lines are the same length, it's not ragged.
But if one line is hyphenated, you can force that hyphenated word to the next line, no
hyphenating, by typing the discretionary hyphen right in front of the word. You've heard of
safe havens? Well these are safe hyphens <ow>.

onrne-pnone- ro-rne-rresloenr- ora profes-

sional- association. from' which. she. is

resigning,- she- tells him- in- no uncertain

-~IPII!8nII!IWft!l!tms8111

fonhrightness- may. be. aggravating- an lit

already. weakened- organization. Politic

~h..'~- not .Wh..n. ~h..-w::o~.::o.kirl.- mOrfo-th","
on [ne pnone [0 rne- l-reSIQenr- o[-a- pro res.

sional. association
-

from. which. she. is

resigning.. she. rells. him. in
-

no
- IIIDIII

11m- terms. how- his- lack
-of I eadership' and

lit

forrhrightness
-

may
-

be. aggravating. an

already. weakened
- organization. Polhic

~h t"~- n nr -Wht'n -~ht'- W'U >1-k jet.
mort'- th>l n
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8 e 8 HYPHENATION EXCEPTIONS-WHERE TO HYPHENATE

Proprietary, technical, and industry

terms cause problems with hyphen-

ation. Quark uses algorithms for
hyphenating, but they're not always
right. Control hyphenation for

unknown words with Utilities>

i!, Hyphenation Exceptions. Enter a word

I ~no:~: ~~~~u~:I~;~;~~~~ ~~~:~~~e~:

Return or Enter to add the word to the

~ t Delete' (C~~tI' ~ ~~~~~r~';;~:~:t~o~e~:':;t~o~~~~:
you

stored in the Preferences file and do

not cross reference to those added to

the Auxiliary Dictionary, used for spellchecking.Notonlywillthe spellchecker stillstop at
the words you add in Hyphenation Exceptions, you can't use the Auxiliary Dictionary to
indicate preferred hyphenation.And ifyou enter a word using lowercase,it won't apply the
suggested hyphenation to the capitalizedword in the text. However,using Hyphenation
Exceptions should certainly improve your hyphenation!

See also~Make Spell'(hecklng Go Faster and Do More" (Chapter 7).

I:IIMII+JIHa
bean-ii-iv

~~~I~;~::-,h-i<

fonl-tru.
hyd.o-tlly-roid-i.m
quan-rl-rep-II-t.lto

,,-ul-I'"

1

HyphenilionExuptionsforQllendar.Sprinll-03

IttiQ~is~pi-nate
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Nothing beat5 style sheets! After all ~
these years, ir still amazes me that ~
you can apply umpteen different

looks to type with just two clicks. Of course,

Power,Pow~~~
you still go through that tagging process-

rhis one's a subhead, this ones a caption.

But think how much time and aggravation

you save not having to manually style those

29 subheads, each with a font, point size,

leading, ete. After applying a style to the body

copy, two clicks per paragraph is a small price

to
pay compared to hand-rooling. And if that

were the only benefit of styles, ir would have

been enough! But thank goodness, there's

more! Changes. Now that you've got all your

paragraphs tagged with the right style, you

con offord to make styling changes at the last

minute. Don't even touch those paragraphs

that are affected. Now certainly that would

have been enough. But again, still more.

Design consistency is assured because,

assuming you've applied the correct style in

each case, you know the numbers all match

up. So if you're not using styles, the time is

now! (Okay, if you only do ads and one page

flyers, you're off the hook.)
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. e ~ GO HOME EARLY-HA HA-STYLE SHEETS FOREVER!

'-:;~ ::'i~~::u,::u'B~'."'A high.- Nothing better in desktop publishing than style sheets-

~ cI-.dllro::e fromPecilicRim lightening-speed text formatting,easier-than-pie style

changes. instantly affecting countless paragraphs, and con-
sistent type handling. That's a lot for two clicks. Click on the
paragraph, click on the style name-zap, it's formatted.
Setting up a style is easy with some sample text looking like

the style you want. Because you've got to format the text
anyway, might as well make it a style and avoid

'-;~:. :~:';~~:'''~:;'B~''''A t~

==
:

having to choose those type formats repeated-

r,*of_ndllllCf:fromPecjficRil~::"""
I"

ly.To makea style,start withan insertionpoint
~ ~~d

~~::=-T'-
p

~nh::~st~~~'I:~~I~~i~:~,ls:~~:;:~a:~~~,

HO~S:=~h~O~~Of; E::~_".:: and,in the next dialog, name your style. Click

280.000spect.«or!.oIIersacMrnser.~~~'"lf
;lit OK,then Save. Now open the palette with Fl1

t£$pOI1SOI!.,8Ildb.J1datior1 rti to apply the style to your sample so this

~na: to "'8Ch
neeootyan unus"aff~ : paragraph gets updated also, when you

rii_~IJdir.""" h,~~kn~~moJn'."'" n change the style. You can get many of the

styles commands with the Context menu.

isncw""P!~d

. e e CHARACTER STYLES FOR POLISHING

Character styles are the icing on the cake of paragraph
styles, which do most of the work since they include

paragraph and character attributes. Character styles

are like polishing those exceptions within a paragraph.

For example, say you have a bulleted list of items, each
beginning with some key words to flag the reader.

You apply a paragraph style that gives you hanging
indents, font, size, and the like. But to make the first

few words of the bullet in a contrasting font, you

either do it manually or apply a character style, by
highlighting the text and clicking on a character style

listed at the bottom of the Style Sheets palette. To make a character style, design some sample

text to base your style on, dick in that text, and press Shift-Fl1 to go to the Styles dialog. Click
New, drag down to Character, and name the style in the next dialog.

8g..un.IURIIGRTis.

~~~c:.~;~;~hoJ~

=:%-~=~ts
'?-''::=''l!Io._U'J.IIInDGRT~"{:;:.,

~~a:.,I:",~~-:
OJ"

11
c..'"

!a'I1 caI..th~..."..'A.~
Getyoorp"obl..."ssdved 4-;nst.,t~ : :;;;~::.c..

.:=E~~~~cI .~=:~
;~..::;"!..!!80'..~"'e~

~\ 142 CHAPTER
9'

Style Sheets Tips



. 6 @APPLYING STYLES-tOOK MA, TWO HANDS ARE BETTER THAN ONE

i
'~W'" ""- ""

I

Doyo,",,, lot ofR__~

(OJ

, ~

::=:~.or- i! E:=5,hR ::;e~;~~~t~a:~~~d
-"."'."""'1 -
::::::::::"-'

0 1,'-'<00 : forthb"woeothete".h_- n DC ,"dtheStyle,,,,,le«e?

"

_1V

_- 01
, ~ - '=J I~:.~,. ~ Grazingyour eyes over

,AOecLD"",CIp. the page, maybe

m:::.., ""'. Ij~"'.'~Iir "..,..., ,~](~tCl you're also overlook-
ing a few subheads.

Try this. Click the Content tool in the story. then choose Select All ((md-A or Ctrl-A) and apply

the body style.Thenclickin the top paragraph.If you're right handed, put yourcursoroverthe
StyleSheetspalette and keepir there.Open the palette to see allthe stylenames and avoid

scrolling the list. With your left hand, click the down arrow on the keyboard repeatedly, moving

the insertion point down one line with each click,applying a style there or passing.To
apply,

move your right hand slightly to get to the style name in the palette. It looks like this-down,

down, down,click, down, down,click, and so on. If you're left handed, switch hands.

8 6 6 APPLYING STYLES-WHEN THEY DON'T WORK

Unfortunately, all is not perfect in Quark's

style sheet world. Sometimes you apply a
style and the paragraph looks just the

same. In the Styles palette, the style name

is highlighted but there's a"+"in front of

the name to indicate that the text styling

doesn't match the style sheet definition.
You have only one choice. Force the style

to apply by pressing Option or Alt as you

click the style name again. But that wipes

out any local formatting in the paragraph.

like italic, bold, or a different font. Then reapply those formats manually. There are two steps
you can take to minimizethis occurrence.First,make sure the text comes from MS Word,

where a style (Normal style) is applied automatically before you import it. Second, when you

choose Get Text, be sure Include Style Sheets is checked in the dialog.

See also, ~[fYou KnowWhat's Good forYa, Include Style SheetsU (this chapter).
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. e 8 MODIFYING STYlES-QUICK CHANGES TO STYLE SHEETS

~

.~::~~.f.

~

:i=~O:;~~~! E::;.~
=-- ""~---I" 1m"".=:'=.:!:..~8! _::':=: =~~

ttendanceI "'---""-"'L~.""''''__~
~":.'!', ",- ,,;::;~.=':'''::4 """".

Stylesheets are works in

progress. Because a style is

based on sample text. adjust-

ments are sometimes needed if

it doesn't fit all instances. When
you (orne to the

34"'
subhead,

you might decide that the point

size should be smaller. That's the
EditPara!ilfaphSryltSh

beautyofstyles,youcaneasily

Nam.l~l,liad::;~-~:<":'-
'-'

make a change in the
11'"

hour.,

ItS of s. All you have to do is (md-dick

or Ctr1-click on the stylename in
the Styles palette (Fl1 tcopen)
to jump to the Style Sheets dia-
log with that style highlighted.

In fact you just type in quick

succession-Cmd-click. Return!
Mac or Ctrl-dick. Enter/Win to be

in the Edit Style Sheet dialog for

that style. And, once you edit

that style using the Edit button

for Character Attributes or, for
paragraph attributes, the tabs

at the top-Formats, Tabs, and

Rules-all paragraphs with that

style are immediately updated

when you click OK and Save.
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. e 8 BASED-QN STYLES-WATCH THEM CASCADE

EdilParagra.phSt'f!t Sheet With lots of styles, based-on styles are a great

. production method. Simple idea-multiple
stylesthat are related are based on a single
style that has the shared attributes. In a two

typeface treatment, those subheads, captions,

bylines. and what not could all be based on

a single style that supplies font,alignment,
color, scaling, and so on. Then at the last

minute, when you need to change those common attributes,youjust change the definitionof
the base style, and all the based-on styles follow suit. Create a Base style with the common

attributes in Style Sheets (Shift-Fl1 ).Then set up each based-on style by choosing the Base
style from the Based On popup menu in the General panel of Edit Style. Choose the attributes

that are unique to that style, such as point size. Though it's not an intuitive way to set
up styles,

you'll be glad when changes are afoot.

N~me:I~YFir5I:JW;i:1 .
"~for-IT"IRa"..

KeyboardEqulnlentj \'1NoSl¥e

IP~;:~~:r-

8 e 6 SQUEAKY-CLEAN! STYLES ''TAKE'' AND FONTS ARE TRUE

Here's a
tip from Toby Zallman,

a I-o-n-g-t-i-m-e Quark user and

friend, who spent many years type-

~ ~=::=~~ :~:~:e~ ~::~~:;:;~i:~~:.~:~e
files in a word processing program,

then saves them as ASCII text, about as raw as it gets-no bold, no italic, no nothing. When she
gets the text in Quark and applies styles, they go in nice

'0'
easy. Then, with character styles,

she reapplies all the italic and other local formats, as she looks at the hard copy for reference.

Of course, all her styling uses true fonts so no italic or bold styling ever reaches her pages. It's a
sure method and totally professional. Now are you going to try it?

See also"Character Stylufor Polishing" (this chapter).

See also"Use True Fonts. Not Bold and ItalitType Styles"IChapter 8).

from:! ~OialoglnCNl ...
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This feature is so buried that you need a micro-
scope, or this book. to find it! When you've got a
lot of styles and a long list in the Styles palene,

you may discover that you have some very

similar styles. You might even apply
them to

the same paragraph in turn and can't tell what's

different about them. And maybe they're not

different! Check it out. Go to the Styles Control

Room (Shift-Fll),and select the two styles you

want to compare using Cmd-click or Ctrl-click to
~ select the second one. They must both be the

same type-paragraph or character. Then, get
this, press the Option or Alt key so that the Append bunon now says Compare, You struck it
rich! Click while it's hot! Amazingly enough, up pops the Compare dialog with a complete
report on the attributes of each style. Well done, Watson!

. 6 0 COMPARE TWO STYLE SHEETS

.fII...........-t_"".c..o..~
'_,'n

'
CamIIoR, ",....

""-.................--

~'::..E'-i2~ ~::;.::~~.~ ~
...--.....-.........
~'::..E'-i2::.:~-;:; ::=.~:-~

8 6 @ RECYCLE YOUR STYLES

Setting up style sheets isn't hard, but why

repeat your efforts? Here comes a project

that's related to one you did and needs a
similar look. It's a promotional campaign,

or your corporate identity. Append styles

so you can reuse what you've already got.

Press Shift-Fl1 to go to Styles-Central.

Click Append, then double-click the Quark

filename with the style sheets you want.

The Append Style Sheets dialog opens

with a list of styles in that file, with descrip-
tions, and a blank list on the right for your

"shopping cart." Select the styles you want,
using Shift and Cmd or Ctrl to select mu!tiples.Then click the right arrow to drop them in

your cart.The Append Conflict dialog box then asks you to choose what to do when the

style you're importing has the same name as one you already have-Rename, Use New,

Auto-Rename, or Use Existing. Click Repeat For All Conflicts to bypass all those approvals.

111(10.,..,"9
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. 0 e IF YOU KNOW WHAT'S GOOD FOR YA, INCLUDE STYLE SHEETS

~Include Style Sheets .::~e:n:~~~~:;i~~~~:a~~teT:hx~t;i::~~~::~d:b~~~:eS~::t~
By default, the option is not checked, but it should be. It's crucial

to getting styles to work correctly in Quark. Once you check it, Quark remembers, unless you

delete your preferences file. But if the option is left unchecked. any text file you import and
apply

styles to will not"take"the style--without force. Yes, you can press Option or Alt when you

applythe style("Okaybrotha,either put up or shut up1 and make that style listen up. But

watch it take revenge by also removing all the local formatting you lovingly gave it. {"Why you
dirty ratn 50 you see, the lesson is, Include Style Sheets ore/se!

. 0 6 FORMATTEXT ON THE FLY AS IT'S IMPORTING

In<;ludinw

'bodvAppend Conlkl("SI...dudl

If your client uses styles in her

word processing program, you're
in luck! When you import her

text file, final or not, her style
T~ls H6;lls aI'udyln us. ~ {1,uto-Ro_' names are added to your Style
~==:'~::~:~I;IO

~ r Us.£xIsllng} Sheets palette. Then make new
styles based on that text, now

styled. Just add one letter to

each original style name, maybe

a hyphen at the end. Then delete

her styles. When you click

Delete, you're prompted to

replace that style with another

one--yes,choose your equiva-

lent style name. Paragraphs tagged with the deleted style now have the new style instead. If

the text file isn't final, go back and remove the hyphens from your style names. Then, when

the final text comes in and you choose Get Text, you can immediately reassign all paragraphs

tagged with her style names to your styles. In the Append Conflict dialog, click Use Existing

after checking the Repeat For All Conflicts (this time around) option.

I!iR"IH'alForAlICOnflim

I D ~-=~: ~ '::=:=r~l~ ..:;=~
~,,: /I;~

Now

~.;~.;=~~-~~~~~~.;~
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. e ~ WHEN YOUR CLIENT'S STYLES GETINTO YOURS

8 e ~ STYLE AS YOU TYPE WITH NEXT STYLE

EdltPara\lraphStyleSMeI Many graphic designers (especially on Maes)

Name:ISu~~"':..~:""-
-, don't have a word processing program,such as

~ FomWsI TobsI ~ :~:';e~;':~U~~~ ~~:~k~:~~S~::~;~r~;~~s

~;"d EqulvaJenl" and clients-set up your style sheets, and then
you can write and style at the same time-

multi-tasking!It'scalled NextStyle,and it works
only when you're typing, so don't get all excited

about cutting your time applying styles. First,

set up your styles (Shift-F1 l}.After naming, check out the Next Style below.MSelf" means the

same style, but pick the one that's more likely. For your Headline style. how about using

the Subhead style for Next Style? And for Subhead, use Body text.Then type your headline,
applying the Headline style. Press Return or Enter, and you're automatically in the Subhead
style. Type your subhead, press Return,you're typing in BodyText style-and only one trip
to the Styles palette!

::;.
NUl Styl~.

,-chariCt~r Attributes :~~~~~~
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. e 8 HEADLINES WITH STYLE

Headlines usually need
tracking to trim down

excess letter and word
spacing that happens in

large desktop type. You
can fuss over every head-
line to get it just right,or

you can cut that time in half-because tracking is an attribute that can be included in your

style sheet (although not kerning). How much tracking do you need? Highlight the headline,

then Option-or Alt-clickseveraltimes on the left-arrow button on the Measurements palette
next to the track control. Or press Cmd-option-Shift-[ or Ctrl-Alt-Shift-[ to close up space

until it looks good. Then Cmd-di,k or (trl-dick on your headline style in the Style Sheets
palette (Fl1),quickly followed by Return or Enter, to beam up to the Edit Style Sheet dialog.

Click the Edit button inside the Character Attributes area, Enter the negative Track number

for that headline, OK. OK. Save. Now when you apply the headline style, it's rocking.

. e 8 INDENTING-TWO STYLES: ONE WITH. ONE WITHOUT

"--""""-~'"'--''''

J
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Have you ever noticed at the begin-
ning of a story and after a subhead,

most designers don't indent,even if

all the other body copy paragraphs

are indented? It makessense,

I Indenting is a way of telling the

reader, "Heads up-new paragraph:

"

But in these two special positions,

~ you don't need a flag, it's already.
obvious tothe reader, And you get

a much nicer squared-off corner without indenting. So how does that translate into style

sheets? Two styles for body copy, not one. If you've already got your body style set up, get

another one by clicking on the style name in the palette (F11) by pressing Control/Mac or

right-click/Win, then choose Duplicate in the Context menu. You're whisked away to the Edit
Style Sheet dialog, where all you have to do is enter a new name, Body First, click the Formats

tab above, and set the First Line indent to O.(Okay, you also have to apply the style!)
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. e 8 PARAGRAPH SPACING-BLISS WITH STYLES, AGONY WITHOUT

'", Paragraph
spacing is key to making your editorial

W """

lli
'

.,' message clear.Subheads need spacing before and

:::.:: ~ maybe a bit after.ln-columnheadlines need space
:::..""'::.-

Homo,lbOy

~
after.Toobad,paragraph spacing didn't make the

~"-.
. Measurements palette. Some people, not you, do

:~~

..

~a

-

1..<"'"""'"
~ bizarreworkarounds,justto~voidthedialog.Using

==-
FI",U..,op double returns has a major pitfall-blank linesfall

::::::::: ""'.,,_: ~ atthetop~ofcolumns,causin.gadropdowninthe
""''''.. loullng ~ column alignment.Theysure Jump out at you on

;::~-
. 5~.lofo<o:I~. ~~:~~;ti~dy~~erC::y~:~:eh;e~:~~~~~I~:::~;:;~~:h

Add paragraph spacing to an existing style by

Cmd-clicking or (trl-clicking on the style name in the palette to open Style Sheets. Press a
quick Return or Enter to edit the style. Click the Formats tab for Space Before, Space After.

More intuitive-apply paragraph spacing (Cmd-Shift-F or Ctrl-Shift-F) to your sample text

before you create your style.

Nobody likes tabs, so don't go there...
often. Wrth styles, keep your tab expo-

sure to a minimum. A quick in and out,

and the rest is practically automatic.
Style your first table with font. point

size, and so on.Then Cmd-Shift-T or

Ctrl-Shift-T (T for Tabs). After you set
your tabs and your table is glowing,

click in the body of the table. Press

Shift-Fl1 to open Style Sheets. Click
New.. .Paragraph.Quark picks up all the attributes, including tabs,leaders, everything.Try this
style naming-TS-coI.B.T stands for Tab, so all tab styles list together. It's got S tabbed columns,

and it's the table Body style. Now click in the column headers paragraph and set up a new
style-- TS-co1.H for Header. With consistent naming, it's easy to spot the style you need. Import
your next five-column table, highlight, applyTS-col.B, click in the column headers,applyTS-coI.H.

See also the tips on tilbsand indents (Chapter 8).

. e e TABS-ONCE AND FOR ALL

!'nj~-
"'mil.....

"Normll
'ft.<d-\

.......

; -: :~~A:~
'"

n. ... "'!.Igo
:Ii .. ,.. ..,

"1
X> .

"
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. e @ STYLES FOR WIOOW AND ORPHAN CONTROL

Widows? Orphans? (Is this Oliver
Twist?) Widow and orphan control

lead to Good Typography-because

the first line of a paragraph widowed

at the bottom of a text box or the last

line orphaned at the top will not be

tolerated. Two lines minimum, fair and
square.Start with your subheads. In

Style> Formats or the Formats tab of

the Edit Subhead Style Sheet box
(Shift-Fl 1), click Keep lines together

and All Lines in 11so your two-line

subhead stays together. Then add
Keep with Next'. For a minimum of

two lines of body copy following the
subhead, apply to the body or its
style sheet the attribute Keep Lines

Together, then Start 2 End: 2. Warning: Flush bottom layouts are not permitted when widow

and orphan control rules. In every case, the last line at the bottom will be automatically

moved to the top of the next linked box or column. Do you understand?

I Jig
~

. e e PARAGRAPH RULES WITH STYLES ARE A SNAP

Paragraph rules pop your heads or subheads

and add pizazz when you lack pictures.Rules

above or below a paragraph are done with

typesetting. When text is edited, the rule moves

with the paragraph, no hand-tooling. And you

can use rules in a style! Set it up once,use it

again and again. Create a sample paragraph

first. Click a headline or subhead with the

Content tool. Press Cmd-Shift-N or Ctrl-Shift-N

(Style> Paragraph Rules). Click Rule Above or Rule Below or both. For length, choose Indents

so the rule goes the width of the box,minus any indents you enter. Or choose Text so the

rule extends as wide as the longest line. Set other choices. Offset is given as a percent. but

points are easier. For Rule Above, try the point size p14 or 14pt, then click Apply. For Rule

Below, try half the point size. Now set up your style...

'~-' , -'--'-

_.1

',"'..:.::.~
Io

rnlng8j Rl!IItBted.

.<:::=au~":~ji=~~~=R---r
.''''''''''I " II!I~''.

_RUll !
"';~~-:.=':.'";~~~ U-cdB ~ .

-"'7:~:~::'" ~ ~3'"
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8 6 ~ SUBHEADS REVERSED OUT OF A BAR-PARAGRAPH RULE STYLE

Reverse type lightens up a
page with color. Thisreverse
is done with a paragraph rule.

It takes some fussing to set
up. impractical to do case by

case. But you don't have to-
paragraph rules can be in

your style.Start with some
sample text on the page,

and base your style on that.

Click the Content tool in a

subhead. and make sure it has

a descender (as in
g, p, y).

Add
one, if necessary, to make your

sample representative.

Then press Cmd-Shift-N or
Ctrl-$hift-N (Style> Paragraph Rules).The sample shown here has a Rule Above, Length:Text

and a thick line Width in color. For 14pt Frutiger Black, I chose a 14pt line Width and an
offset of -pS (-.069"). Then flip over to the Formats tab in the dialog, and add some para-
graph spacing. If your rule is dark, make the subhead text white before making your style.

length

Fromltft:

m
14pt @3

I.PANTONE IU
I1iI

From Ri<jjlh1:

Offset.
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.. 6 8 PARAGRAPH RULES HANG OUT

Here's an unusual lookyou might want to try. Your paragraph, maybe a pull quote. intro
copy. or other specialty text, is indented on the left, right. or both sides. Above and perhaps

below, you've got a paragraph rule going the full width. Looks easy, but it's got a little twist.

Start by indenting your text in Formats, Cmd-Shift-F or (tfl-Shift-F, noting the amount of the

indents. Click Apply. Then, without closing, switch over to the Rules tab. Click Rule Above,

Below,or both. Set Length to Indents.Nowenter those same left and right paragraph

indents here for the ruleindents (Fromleft and From Right)-but, make them negative

numbers. Finish with Width, Color, and Offsets (in points). Click Apply. Your text should be

indented from the rule, which goes the full width of the box! Now make it a style sheet.
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When all is said and done, it's the loy- f@jfl
out that goes out the door and into ~
the hands of your client or boss.This
meaty chapter covers all the tricky

Livi~~ht~!2~~~~~
aspects of assembling the parts. Stort with

one of Quork 6J most exciting feotures-

layout spaces. Then discover more than seven

great woys to make your layout fit, including

desperate measures. Know how to send

that head or subhead to the rop of the next

column or box? Getting those lines of body

copy to line up across the spread? Takes a

few tricks. Moving and removing pages, and

more. Then, there's a plethora of ways to align

and space items for a pleasing finish, not to

mention making scads of multiples wirh a

single click or two. Getting runarounds to

go all the way around, and around irregular

silhouettes and graphics. Finally, you come

to some of the least known capabiliries in

Quark-layers and tables-having only first

appeared in Quark 5 and enhanced a lot in

Quark 6. With one chapter, the kingdom

can be yours!
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. e 8 LAYOUT SPACES FOR DIFFERENT VERSIONS AND PAGE SIZES

The operational word for
layout spaces-repurposing.

Don't
go back and forth

between multiple files of
related projects, such as in an

~!':'~"'~I~_~tcAkj~1 ~:..~:~... ~[MdftH~1111 ~:t~:m:~~:,~::~~:ep:~:t;i~:

changed, you started a new

file. Now Quark 6 can accommodate any number of layouts of varying dimensions and orienta-

tions-ail in the same file or project.lnstead of documents, you now have layout5,along with

Print layout preferences. not Document preferences. and a layout menu for makjng new layouts

and setting layout Properties, including LayoutType (Print or WebJ.Try this. When you're design-

ing and want another look, instead of starting over,just Duplicate the current layout (layout>

Dupllcate).Now you have all the same content, but with a new set of master pages. You can have

a new layout in no time by just rearranging the items. Navigate between layouts using the tabs

down in the lower-left screen.

~ ~;i;~I'~..
~Dele!e

_I!l"li'/JI.~..",~."...-

. e 8 TITLE BAR BLUES-PROJECT 1: LAYOUT 1:HUH?

e Item Page IIP!I!III View Ulilltie\

r~ Paul Rewn
; And His Midnight Illde

uyoutPropen

uyout
Name' lAnd Hi! Midnignt Rjd~ T

Pa~

Size: IUSlefler 10,1

You launch Quark 6,Iook at the title bar and...

what's all that stuff up there? See the previous tip
for a complete explanation. But, because you can
now have multiple layouts (what we would've called

"documentsM in the past) in one big project (what
we would've called a .qxd file before), you've got to

name not only the New Project (Ctrl.N)-when you

save the file, ,qxp-but also each new layout that you
make, If you have only one layout your title bar will

read "(your file name): Layout 1." No big deal, but at
least you won't be banging around trying to find out
how to get rid of the annoying "layout 1.N(I admit to
this initial reaction!) Guess what, even if you only

have one layout, you can use it to give your filename

a subtitle! Name your layout from Layout> Layout
Properties,or use the Context menu.

layoUITYJ)e. fPrint

Helghl ~

IIJ~
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. e 8 SYNCHRONIZE TEXT (OR NOTIIN DIFFERENTLAYOUTS

DPiUIR,v...;HeRod.SoFaslbut...
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Synchronizing text means you

edit text once for an entire
project (in other words, multiple
layouts in one file as described

above},and all synched text in

other layouts instantly updates.

Select text with either the Item

or Content tool, then click the
Synchronized Text button, top left

of the Synchronized Text palette
(Window menu). The entire story
is added to the palette as a

named entry, not just what's
highlighted. Now add this text to

another layout by clicking the
story name in the palette, select-
ing an empty box on the page,

then clicking the second button,

Insert Text into Text Box. If you
duplicate a layout, synchronize

all text first before duplkating-

otherwise, it's not automatically
synched.lf you add synched text

to existing text in a box, the new
synched text replaces what's
there. To un-synchronize text,
clicktheUnsynchronizeAI1

button or delete the selected
story entry-trash.lt/Mac or

X-itM'in in the palette, The text
story stays on the page but is

now custom text-editing it has

no effect on other layouts.
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. 6 8 FITTINGTHETEXTTOTHELAYOUT

~ hi. ~,- :e~rkhnO~:at:;:::P~~t~;:tt~oBL~:~:~~::~~:nd?
~ ~~ Sorry,nicetry.ThetoughpartISmakingItfit
without compromisingthe design.But here are a few ways to pull out all the stops and make
it fit kosher-style, not klutz-style. What's known as "tricks up the sleeveH -from best to worst.

Tracking short lines. First line of attack, recommended even if fit is not a problem. Look at

the last line of each paragraph and see if there's a hyphenated syllable or short word,alone

on the line. If so, highlight the entire paragraph. four clicks, then remove a few units of track-
ing until the short line pops to the previous line.

See also "Track Body Copy to FiJIShort Lines" (Chapter 8).

Reduce paragraph spacing. If you've used paragraph spacing for body copy, reduce the
amount of the space. A fast fix with style sheets

Reduce point size or leading slightly. Again, use your style sheets to make very small
changes until it fits. This technique is best used for stand-alone projects, one-time designs-
not a newsletter or quarterly report.

Make pictures smaller. Consider reducing slightly those pictures that are less important.

Just a bit Or reduce the runaround down to 9pts (.125").

Tracking body copy. Firstsneakyway to fit more in,and the only good way.Toreduce letter
or word spacing for body copy consistently, edit your style sheets. Cmd.click or Ctrl-click on

the body style name in the Style Sheets palette (Fl1) to open the dialog. Reduce tracking, a
character attribute, in very small increments, perhaps tenths of a point, though it can be as
littleas.OOlpt.

Reduce slightly the page margins. Go to the master pages and choose Page> Master Guides,

Apply 98% horizontal scaling for body copy. This is common, although not my favorite,

because it changes the aspect ratio of the type, Again,
use style sheets to add the character

attribute.

Desperate measures. Case by case. Here's where you stoop to the bottom line-whatever
it takes, short of deleting text. What is the client or audience least likely to spot? For exam-
ple, you've got a ton of tabbed charts, but a few of them need a small adjustment to the last
tab. Go ahead, do it manually-make sure no one's watching. Extend a text box a tiny bit
beyond the right margin, Extend a text box down below the bottom margin a smidgeon to

fit in the last line of the paragraph. You get the picture, Don't ask. Don't tell.~ffJ\ 158 CHAPTER 10' Can't-Live-Without LayoutTips



. e 8 CONTROLLING THE LAYOUT WITH SPECIAL CHARACTERS

You can shorten a text box from a bottom

handle to force a headline to the top of the

next linked box. But sometimes the Next

Column and Next Box characters work bet-

ter.Make an insertion point in the text, right

before the headline you want to .send on.

Press Enter on the keypad and it's done.

With a subdivided text box, the headline

goes to the top of the next column,same

box. Either way, press the up arrow on the

keyboard to send the insertion point back

to where you started.Tum on Invj~bles (Cmd-I or Ctrl-I)-there's a single down-arrow character,

which you can delete to remove the break. If you have subdivided text boxes, you can send the

headline to the next box, using Shift-Enter (keypad), making a double-down arrow. With the

Auto Text Box, you can have a sequence of articles with headings at the tops of pages! Bravo!
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. e e WITH SUBHEADS. ALIGNING BODY COPYTAKES TRICKS

Getting body text

Lt~djnll:
""i4""Pt toalignby the

I
Spge

8efo~. ~ ~I::~:ea~:~~:
SpolceAfter: ~ approachable page,

f'i":it art hough there are
good designs that

can't be accomplished with this goaL If all we had was body copy, layout would be a cinch.

Subheads, especially two-liners, make it tougher. But it can be a cinch. First. the subhead lead-
ing must equal the body leading. So if the body is 9 on 13-9pt with 13pt leading-then the

subhead can be 9, 1O,1 1, 12 or 13pt on 13pt leading and in bold, italic, or a contrasting font,
(But, if your subheads are bigger than the body, use baseline grid to avoid non-alignment

when subheads fall at the tops of columns-see next tip.) Second, the paragraph spacing

must equal one line of leading, with more space above than below. For 13pt leading, use 11,
12,or 13pt Space Before and 2pt, 1pt,or no Space After.
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. e 8 BASELINE GRID-TEXT ALIGNMENT ACROSSTHE PAGE

Keep text aligned by the

baseline across the page or
spread with Lock to

Baseline Grid-especially
good with text-heavy
layouts,where non-align-

ment is noticeable. Text
snaps fO the grid,a set of

horizontal guides set at a
tixed interval down the
page. First, where will the

baseline grid start on the
page, measured from the

FM~m~nt: ~ ~~: ;:r~e~~~~;~~V~:~Ved

rulers,reset them ("zeroing-

8\LOC!r.10aa.~II~ Grid out") by double-clicking in
the smallsquare at the
intersectionof the two

rulers. Then drag from

there to the baseline of
the top line of body copy,
noting the Yvalue on the

Measurements palene.

EnterY into the Start
value, under BaseHne Grid
(Paragraph preferences-

Cmd-Gption-Shift-Yor
Ctrl-Alt-Shift-Y),ForIncrement,enter the bodycopy leading,ThenapplyLock to Baseline to the
body copy and subheads, preferably using style sheets, in Formats (Cmd-Shift-F or Ctrl-Shift-F).

It's unnecessary and distracting to show the grid (Option-F7 or Ctn-F7).
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8 e @ VERTICALLY JUSTIFYING TEXT
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Vertically justifying text in a box so it goes from the

top to the bottom regardless of the number of lines

or the box height is questionable at best. Sometimes

with a flush-bottom layout, however, you have to

resort to "desperate measures," instead of using

more kosher methods (as in the two tips above). To

get this authoritative look, go to Item> Modify by

double-clicking the box with the Item tool. Or, with

the Content tool, Cmd. or Ctri-double-dick.Click

the Text tab, and from the Vertical AlignmentType
menu, select Justified. If you leave the Inter' Max
setting at 0, the leading increases equally. But if you

want the needed space only to be added between
paragraphs. enter an Inter' Maxsetting.Ifyour
setting is too low. leading will stillbe affected to

achieve justification. Avoid a paragraph return on

the last line, which offsets the justification.

. e @ REARRANGE YOUR PAGES IN THUMBNAILS VIEW

~1.1
l_~

fIEl.
... -'=.:.

ITiir&;i =i!

You can use the Page Layout palette or Page> Move Pages to

move pages to new positions. But did you know that you can

also rearrange pages in Thumbnails view? Press Cmd-ctrl-V

or Ctrl-Alt-V to highlight the View % field in the lower-left

corner of the layout window. Or just double-dick it.TypeMr

for thumbnails, then press Return or Enter.On the Mac. you

can see the type better in thumbnails ifText Greeking is

turned off in the General Print Layout preference. Then,

with Item or Content tool, grab a page and move it to a new

location. Use the Shift key to select a range of pages or use

Cmd-dick or Ctrl-click to select non-consecutive pages. If you

see a right-pointing arrow cursor before you release, you will

shuffle the remaining pages down. If you see a down-arrow
cursor, your page will push the next spread down one.
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. e 8 TWO WAYS TO REMOVE PAGES
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Having to remove pages is common. Aside from budget cuts and

project reductions, you typically end up with more pages than you

need due to importing text and linking when the text isstillat a large
point size. Naturally, you end up adding a lot more pages than you
really need to get all the text on pages. Once you size down the type,

you've got extra pages. You can remove pages from the Page> Delete
Pages command, when you're on a layout page, not a master. Specify
in the dialog which pages to delete. If you're a fan of the Page layout
palette, select a range of page icons using Shift-click. Or use Cmd-click

or (trl-click to select non-consecutive page icons. Then click the
Trash/Mac or XlWin button at the top of the palette to delete.

. 6 8 TEXT RECOMPOSING WHEN OPENING SOMEONE ELSE'S FILE?

'-
Workgroup publishing is a facte ;:~~ ~~"::- =",".:;;~:';;.~:ojffi an!diffo!",nt'...m tho..
of life.Typically your work is

reviewed by someone else,

or you get files from other
designers. What happens when

::: ~i::~~",:",
Cunomfr.r,,,,,.rTIiV

f Un XPm. !'men"c.s
, you open another person's

Quark file?The Nonmatching

Preference alert dialog opens to

warn you that thefi)e you are

about to open may contain
dangerous materiaUust kidding.

It only contains different track or kern tables or different hyphenation exceptions. I have a feel-
ing that it's more than that because I get it all the time with my own files!To open that file
without causing the text to reflow,just dick the button Keep Project Settings. If you dick Use

XPress Preferences (your application settings, not the document's), the text will likely reflow on
opening. Other things that can cause text recomposing are corrupt fonts or fonts on your

machine of the same name but different font manufacturers than the ones used in the file.

.Kemlng/ttacking don r>01mi{ch

o..ngnmidolokeming;ondtracki",
tidJl.os..,dhyphtnltionnClP!:ionswhile
!hi. ptojffi Is act"'.wlll IPP/Y 10 !his
ptOjffion!y.
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8 e 6 TEXT RECOMPOSING WHILE OPENING AN OLDER QUARK DOC?

It's preny easy to convert a Quark document

from versions as far back as XPress 3.1-

use the Open command. If you just want to

make a few changes, you don't need to do
anything special. By default, text doesn't
recompose and line breaks stay the same.

But if you're overhauling the file,you can use the improved hyphenation introduced in
Quark4.Youget better-looking text with the more recent Expanded hyphenation method

when text is reflowed. Quark re-hyphenates words based on its own dictionary and makes
up hyphenation if needed. Though not perfect, expanded hyphenation is the best bet.
Apply expanded hyphenation to an older file by going to the Open dialog box and pressing
Option or Altwhen clicking Opefl.lf the file is already open, you can apply the expanded
option by opening Preferences (Cmd-Option-Shift-Y or Ctrl-Alt-Shift-Y) and choosing

Expanded for Hyphenation Method (Paragraph preference).

I"'::::'

I

".,~"..- ,-'s""", I-
~r.~:::''.!.-

8 e 6 BLEEDS-GOING OVER THE EDGE

r'~~v:~It:~'"

In print design, when a COIOfextends to the edge of the
paper, it's called a bleed-an effective way to bring drama to
a page. It seems like the artwork-picture, type, colored box,
or line-would extend right to the trim edge of the page.

But imagine the printer trying to cut the paper right on

that colored edge. Forget it, nothing in printing is that exact.

Artwork must extend beyond the edge, usually W' or 9pt.

Then when the cut is made, it doesn't matter jf
it's a little off.

To bleed an item off the top or bottom, simply add +.125"

or +p9 to the Height value in the Measurements palette-

that's .25" or 1p6 for top and bottom bleeds. To bleed off the

outside left or right trim edges, add the same number to

the item's Width. Make sure the picture or type goes that far.

For top and left page bleeds, subtract the same number from

the Y (top bleed) or from the X (left bleed).
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SPREAD GUIDES MAKE ALIGNMENTS EASY

Most left or right alignments are

handled by column guides.Butwhen
aligningitems by their top or bottom
edges across facing pages of a spread,
you need help. Compared to the Spacel

Align box or the Measurements palette,

a spread guide is fast and intuitive-
just drag down a guide and snap

everything to it. Start as if you're just bringing down a rulerguide from the top ruler.Butwhen
you release it, the cursor needs to be on the pasteboard around the page, not on the page.
Easiest,Dne-step method-bring your mouse down to the right or left pastebwrd. going far
enough down so that the guide aligns where you want. When you (et go, with cursor on the
pasteboard, it's a spread guide! Now just drag each item to the guide and it snaps right in.
Check'em by the numbers-you'll find no mistakes.

. e 6 ALIGN ITEMS FROM THEIR CENTERS

~°lel<
SpKe

@iHorizonti.l-

,-"Distri
Item.

lefrEdg".

Sometimes you just have to do those odd-ball alignments for

items of various sizes and shapes-from the vertical centers

of side-by-side items or from the horizontal centers of top-

to-bottom items. And in Quark, there's only one good way,

but it's a tricky pass with the Space/Align dialog. Select your
items using Shift-and-dickor marquee them with the Item

or Content tool.Then press Cmckomma or Ctrl-comma to
open Item> Space/Align. There are two quagmires. First,is it

Horizontal orVerticalalignment?Onceyou make the wrong

move and choose Apply, there's nothing you can do except
cancel and start over.Thinkof the axis on which each item

must move to aligo-side-by-side items use Vertical and

top-to-bottom items use Horizontal. Second pitfall, Between;

Items isn't what you want typically-that's only for butting

items. But for this tip, you want Centers anyway.The rest is

a piece of cake.

eS~e: 0-_00

Righi jg'"
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. e 8 SPACING ITEMS-ALL THINGS BEING EQUAL

Howdo you get a set of three or more items equally
spaced? This calls for the dreaded Space/Align dialog box.
Why so feared? You can easily waste your time and have to

start over (see previous tip). With your items selected, press

Cmd-comma or Ctrl-comma to open Item> Space/Align. As
above, think of the axis on which each item must move to

align-to equally space side-by-side items. use Horizontal
alignment and with top-to-bottom items, use Vertical.The
key is choosing Distribute Evenly, rather than the Space

option.Ifitemsare identical, itwon't matter whichoption you choose from the Between
menu. If items aren't the same, experiment with the Between choices and see what works.

Settinqs in the SP<lce/Align Dialoq
Item Arrangement Align Space Equally... Side.by-side Vertic~1 Horizootal. Top-t<:>-Bottom Horizontal Vertical..

~
-.~--

~

. cO".,
Ospo,,;~ s.,....

~:~~~ ~

. e 8 STEP AND REPEAT AND SUPER STEP AND REPEAT

Use Step and Repeat to duplicate one or more selected

items with or without offsets as many times as you

want. Press Cmd-Option-D or Ctrl-Alt-D to start. To
duplicate right on to~reat for aligning-set Offsets

to 0, click OK. then Shift-drag the item to keep it

-<-
-, ""-''"''-'''''--- aligned.The command is also good for making multiple

::7~:K ~ :::::,
-

~:~~rss~::n:;:i~;;~~~ss:;a~~:~a~~n~:;yt~:~:~:.
:-: with a single selected item, and optionally its content,

that can be cumulatively scaled and rotated. Go to

Item> Super Step and Repeat.Choose number of copies, offsets, angle, and a series of attributes
for the end state--ending line weight or frame width, box shade, item scale and skew. Pick

from nine points of origin for the rotation and scaling. The XTension of the same name must be

loaded and active-check Utilities> XTensions Manager.

Q$~
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. e @IDENTICAL BOXES THAT PERFECTlYFIT A GIVEN SPACE

I~,:.# I My friend Clint Funk gave me this great tip.

Want to fit a bunch of identical boxes into a
given space so it looks perfect? Say you want

6 identical boxes. equally spaced apart by

I t:Jqt:J~~q ;:o~\.~~~~:~~nh~:a~:~;~~;~:::xs~:~e
goes the full width of that space, at the

desired height. Now,in the Measurements palene, subtract from the Width the total width

of the gutters. With six boxes, that's five gutters (one less than the number of boxes), each
gutter 1p6 wide. Total gutter is five times one gutter or

5*'
p6 or 5*.25". Don't try to do the

math, type it in and let Quark do it.

With total width of the space at 41 p6 (6.917"},it looks like this;41p6-5*' p6 (6.91
7"-5*.25").

Press Return or Enter. Now divide that width by the number of boxes to get the width of
one box: 34p/6 ::=spa (S.667"/6::= .944").

Copy that numberW and open Step and Repeat. Repeat Count S (you already have one).

Vertical offset is O.For Horizontal offset, paste in your number-plus one gunerwidth:
Sp8+ 1p6 (.944"+.2S").Click OK and your boxes should be perfectly fining that space!

. 6 6 DON'T ALWAYS WANTYOUR TEXT ATTHE TOP OF A BOX?

When you color a text box, you usually don't
want the type hugging the top edge. For that
fancy headline in a blended box or a simple

headline with a colored frame width to set it
off,vertically centered is usually better. Or for

something like an invitation, you want the title

vertically centered on the page. All easy matters

for the Text tab of the Modify box. With your text

box selected, go to Modify (Cmd-M or Ctrl-M).
Click the Text tab, and check out the Vertical Alignment popup menu with options for
Centered, Bottom, Justified, and the default Top. To vertically center text to the page, first
extend the top and bottom box handles to the top and bottom page edges. Or just enter

the page height as the box Height in the Measurements palette. Then set the Y to O.

Finally, vertically center the text.
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. 6 @ MULTIPLE PICTURES WITH EXACT POSITIONING~.
'I:~:~:~::~I,;::;..,.
'I:~:~: ~::~If::~~.

Positioning pictures in a row or column
gives them strength, Using the Measure-

ments palette to calculate, you can butt
pictures edge-fo-edge or separate them
by an equal space. With pictures A and B

in a row, select A, copy its Width (double-

click the number to highlight)-26p6-

and add that to its X location: 5p+26p6,
press Return or Enter.Copy that number
x, then Undo (click on the page first),

which puts A back where it was. Sele<:t

box B,and paste that number into its X,

which puts box B butted to A. If you want

it one pica out, add one pica to the X:
(current X)+1p. press Return or Enter. If

pictures are stacked vertically,substitule

Height for Width, and substitute Y for X.

Another method, though less exact, is

easier. After A is positioned, drag out the

zero point from the intersection of the

rulers and align the vertical axis along the
right edge of A.Then 8's X coordinate is
simply the distance out you want~ 1p,

and soon.
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. e e WITH COLORED BOXES. TRY UNEQUAL TEXT INSETS

t~~==J
~=:-:£_=~----.-----....--...-.

iiI .

~\

Tutlnsel - Use asymmetrical color bordersfora text boxto
I!\Multlple f~

get a more unusual effect with a sidebar Of pull

Top 48 pI quote.Think of insets as the text box margins.

- Withyour boxselected,press Cmd-M or Ctrl-M0 pt
to go to Item> Modify and click on the Text tab.

"'36"'Pt UnderText Inset,check Multiple Insets, then

Righi o""p! enter values for all four sides. Consider a large
inset at the top. half of that at the bottom. and

none on the sides.Thenadd a large initialcap
and justify the body. Or how about a big left

inset with an image overlapped onto that area.

Another idea-with a top or large bottom inset.
overlap a picture box of the same width so that

there's about a quarter-inch of color extending
above or below the picture. The sidebar now

has the text and picture in one neat package.

GOING ALL THE WAY...AROUND

There are occasions when wrapping text all the way around

four sides of a box is the look you're after. But if you plunk a
picture into the middle of a text box, you'll find that the text

only wraps on three sides-top, bottom, and either the left or

right side, depending on which side is wider. But you can have

your cake and eat it too using the Run Text Around All Sides

option in Item> Modify. There is a trick,however.You're used

to setting the runaround for the picture box so it seems natural

to do the same for this feature, but this time it's the text box
underneath the picture that has the "run all around" option. Go

to Modify by double-clicking on the text box with the Item tool

to set this four-way wrap. Click on the Text tab, then check Run

Text Around All Sides.
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. 6 6 BOSS SAYS/KEEP THOSE PICTURES LOCKED TO THETEXT!"

TIle
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When pictures need to stay at a particular point in the text.

use anchored boxes. Then, when text is edited, pictures

Ntravel" with the text. To anchor a picture box into text, copy
or cut it using the Item tool.Then, with the Content tool,

make an insertion point in the text and paste. To put the
picture in its own space, add a blank line before pasting.

Set the leading of that line to Auto so the vertical space

automatically fits the picture height. Position it horizontally

with paragraph alignments. If the picture is on the same

line as text, click on the picture to see handles, then use the

two bunons on the left end of the Measurements palene

to Align with Text Ascent or with Text Baseline. The former
drops the picture down to roughly top align with the text.

The latter sits the picture bottom on the first line text base-

line. Anchored boxes are best for a one-column book layout

or for small drop-in icons.
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.. 6 t) RUN, RUN, RUNAROUND, I GET AROUND-IRREGULARITY

pIay
Hear the Beach Boys playing?--a tip for sunny Californians

and everyone else! You've
got an irregular shaped EPS

graphic or a cutout photo,outIined with a dipping path to

drop out the background,done in Photoshopor in Quark.

How do you control the runaround for that irregular-shaped

picture? 5electthepicture box and do Cmd-T or (t,1-1to

open Item> Runaround. For an easy way out, select Type;

--
".110 Autolmage,andemeranumberforOUtsettocontrolthe

.:: distance from the teJd: to the picture edges.This may be

0l\Il'
enough. However, ifyou want to edit the outset boundary,

~.. ..~.. then there are two steps.Step one,change runaroundType

.:: to Non-White Areas.ClickOKStep two, press Option-F4 or

...,.. Ctrt-flQ to turn on (oroff) Item> Edit Runaround.Zoom in,
toillr and edit the magenta path by moving points,control

_"toII_,I...,,_-
handles,and path segments.OpOOn-dkk orCtri-click on a
point to remove it.Dragging from between boundary
points goes faster than dragging a point

.. e t) DOESN'T LOOK LIKE A RUNAROUND UNLESS...

~J.C1Y . "...

~-
=-h

'~"- " '~

,

~
,

~~.
...

~.PANTONETS
-.PANTONE75

~- ..::~~g~~~
k- ~.Re9inralion
: .:~~:~- ..~""."",'SiI,-Eift,",-" ,._,,...-

Here's one I stumbled over, and it really

caught me off-guard. You know how the

default color of a picture box is white? Well, if

you leave it white and then try to make an

irregular text wrap around the picture, it will

look like nothing's working. The white box

background is covering up the text that's
wrapping around, underneath the box! If

you're zoomed in close enough to read the

text, you'll probably notice what's happening.

But from any kind of distance, you'll think

you're doing something wrong. $0 get in the

habit of setting the box color to None before

you make an irregular runaround so you

won't be thrown for a loop <ha ha>.
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. e @TYPE MASKS IMAGE-TEXT TO BOX

Turn text into a picture box shaped the same as those letters-

then fin with a picture! First, style a headline with a very bold
font,such as Futura Extra Bold or Gill Sans Ultra Bold, probably

with tracking.P\Jtthe headlineon top of the image you plan to
use,and size the type to match.Then highlight the first line of

the text-you can only do one line at a time. Convert the text

with Style> Text To Box. Keep the original text,still there, on the
pasteboard for possible changes. With picture box background

color set to None, you can see the image through the text. If
your picture is dark, temporarily add a light-colored frame width. Move the picture-text until it

lines up with the image the way you want Repeat for any additional lines. Now, use Get Picture

fOf each picture box. With the Con!ent tool, move the image within the box so it lines up with the
big picture behind.Then delete that big picture box.

. e @GmlNG TEXTINTO A TABLE

:)U~':)'~pan"..~pu.(...
You can type right into a

table if you've got text cells,

not picture cells-choose

link Cells in the Table

Properties dialog when

you drag out the Table tool.

To go to the next cell, press

Enter on the keypad. You

can change picture cells to

text cells-highlight with

the Content tool, then

choose Item> Content>

Text But there's no direct

way to import a text file so

that it tlows into all the

cells of your table. You've got an extra step-import the table text into a simple text box, then

convert it to a table. First, make sure the fields are separated with tabs, spaces, or commas, and

the lines of text are separated with returns. The rest is easy. Highlight the text, then choose

Item> Convert Text to Table. In the Convert Text to Table dialog, the default row and column
number; reflect what's in your text. Click OK.

Cascadmg M~nu

..~.. ~ --~---...

.. =:=r:~~~.~~ 8Ij.- .. -.. ~ - - - loiii

.. ,. III- -
II~ MIl

Tabl~
G,idhn~\

RasicRoHo""",
2-posilion Rollov~,s-
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. e e FORMATTINGTHETEXTOFANENTIRETABLE

Because you use Cmd-A or Ctrl-A to
select all the text in a story, you might

think that would work fine to high-
light all the text in the table, after

clickingin one cell.Wrong. It should

work that way. Instead, it highlights

all the text in one cell-anyone ever
put a novel in a cell? But the answer

is easy. Just take your Content tool,
and drag from the top-left cell down to the bottom right cell so all cells are highlighted. Or,
sarpe tool, from just outside the selected table, drag across or down along any table edge

to highlight column by column or row by row. Then style from the Style menu, not the
Measurements palette! If you're using style sheets, highlighting across cells is necessary for

both character and paragraph styles. Click on one cell of table text and apply a paragraph
style sheet-you get the text in one cell styled!

8 e 8 INSERT ROWS AND COLUMNS USING EXISTING FORMATTING

You know that scene-you've got that table all done, it took

hours to get everything to fit and be formatted and now they

need another row or column! (See next tip.) It could be worse.
Now in Quark 6 you can add a row Of column, and pick up
existing formatting. With the Content tool, click in a cell or

highlight cells that you want to match in your new row or

column. Go to Item> Table> Insert Rows, or > Insert Columns.
I prefer getting the same commands from the Context menu (control-click/Mac or right-click/
Win). Choose where to insert, either above or below (rows), or left or right (columns) in relation
to where you clicked or highlighted cells. Then, the key step, click Keep Attributes, which copies
type specifications, including style sheets, local formatting, picture attributes (angle, skew,
offset), and settings in the Text and Cell tabs of Modify dialog.

Number of Rows: 0
81nsen Abovt Stlution

0 In:>en Below Selution

~Ktep Attribute:>

~\ '72
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. e 6 IFYOU HATE MATH, BUT NEED MORE ROWS AND COLUMNS

Jolly Grem Grear.
g
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I'm
just teasing. You don't have to love math to like this feature

called MAINTAIN GEOMETRY (accompany with trumpet
fanfare). With this option on, when you add or delete rows or
columns to or from your table, the outside dimensions of the
table stay the same size-very useful if you don't have room
on your page to enlarge. Ifyou add a column,your cellwidths
get smaller. If you delete a row, your cell height increases.

Toturn on MaintainGeometry (it'soff by default),do Cmd-M

or Ctrl-M (Item> Modify), click on the Table tab, and check

Maintain Geometry. Or easier-use the Context menu

(Control-click/Mac or right-click/Win), then choose Table>

Maintain Geometry. But if you like your current cell width
or height, and want to add on ("Honey, let's add a second
bedroom"), then go direct to Item> Table> Insert Rows,or >
Insert Columns-even better, use the Context menu again.

. e @ COMBINING TEXT AND PICTURES IN A TABLE

Because tables condense a lot of information, use

pictures to make tables easier to understand.

Pictures are the visual anchors for the text on

each line. How do you get the pictures? If you

don't have a blank column or row to use,insert

one. If you've only got text cells, convert them

to picture cells. Drag across to highlight those

cells with the Content tool, then choose Item>

Content> Picture or use the Context menu

(Control-click/Mac or right-<Iick/Win). Finally, put

your insertion point in a cell and do Get Picture.

For fast sizing, use Cmd-Option-Shift-> or -</Mac

or Ctrt-Alt-Shift-> or-<lWin to size the picture larger or smaller in 5% increments. For

in-between sizes, use the X% and Y% fields in the Measurements palette. Extra perk-

you can use or make a clipping path to silhouette an image inside your table!

See also -Insert ROW5 OInd Column5 Using Existing Formanlng1- (thi5 chOlpter).
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. e 8 GRIDlESSANDSEE-THROUGHTABlES

1t
'0I2OI:'"

Make tables transparent! Then why use the table tool? Can't
you just apply styles to the text (or use the Tab ruler) to get.

'~ ...
-

the same effect? Yes, bur not with text that wraps around

::'.."" within a cell. Using tabs just doesn't cut it. Another related

...

"

idea-use horizontal ~ridlines or no lines and no table :olor
.. background to see a picture underneath! To remove gnd-

lines, select your table with the Item tool, go to the Grid tab

,'"'
,

." ofModify(Cmd-MorCtrl-M).On the right, choosefromthe
'-

: -:;,
,.' ", default Select All (gridlines),as well as SelectHorizontalor

SelectVertical.Forjust horizontal lines, click Select Vertical,
then set Width to O.To see the full effect on your page, use Hide Guides (F7). Now put that
table over an image. Select the table with the Item tool and set table background color to

None in Colors palette (F12). Then drag across all cells with the Content tool and again
choose None for box color. Yes, doing it twice with Item and Content is what's called for!

8 6 @ MISCEllANEOUS, BUTCRUClAl, TABLE TIPS

{""iNED ULLS Here are a handful of tips you won't want to miss.

rfm.

Combine cells. To combine two O

.

r more adjacent
cells, across or down, highlight the cells with the

Content tool, then choose Item> Table> Combine

Cells (or Context menu). Content In all but the top-

left celt is deleted.

Scale a table-and its cells-non-proportionally by simply dragging any handle.
Type and pictures stay the same size, but text may fe-wrap and pictures may get cropped.

Scale a table-and its contents-proportionally. Drag a handle while pressing

Cmd-Option-Shift or Ctrl-Alt-Shift,

Convert a table back to text. Choose Item> Table> Convert Table to Text (or Context menu).

Make a series of identical tables and skip that dialog when you drag out to make a

table. Go to Preferences-double-click on the Table tool in the toolbox. Click the Modify
button, then the Creation tab. Choose table attributes (number of rows and columns, and

the like), and uncheck Show Creation Dialog.
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. 0 6 SNAZZ UP THATTABLE WITH COLOR

The Content tool is King of table styling. Drag across or
down, just outside the selected table, using the black
arrow cursor.From the Colors palette, apply a box
background color as you would for any box. Apply a

blend to the whole table. For Linear and Mid-linear

blends. try reversing the blend direction for every

other column or row.Shift-click from outside the table
edge to select. Then change the blend degree to 90",

-90°, or 180., Or be more conventional with alternat-
ing coJor rows, using a color and a tint. Color the type

of highlighted cells also. Change the gridline attrib-
utes, color, weight, style, and so on by directly selecting

the lines on the page using ShifHlick.Or click with the Item or Content tool to bring up the

Context menu, with commands Gridlines> Select HorizontaINertical/Borders/AII.Color

them, or if changing other attributes, go to Modify, Cmd-M or Ctrl-M, then dick the Grid tab.

8 e 6 LAYER PALETTETRICKS

~~[j'i]III-"
I-. Lao.'. II
:-'~~~'.I! Nowl~1
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I u.ooc. ~I L.",...

There's more to the layers palette than meets the
eye. There are "hidden" commands in the Context

menu for Duplicate layer, Hide Other layers, Hide All
layers (why?), lock All layers, and more. And there

are always shortcuts. Instead of moving an item to a

new layer by clicking a button (top of palette) to
open a dialog box, use that small dotted-line square

that appears next to the layer name, when an item is

I :~:;~:~i~;:~ ~:: ~~:~::~i::~C:~: ~:eumc:~
copy the item to a new layer by dragging it while

pressing Control or Ctrl.lf you want to rearrange the

layer order, just drag the layer to a new position-

no key needed in Quark 6.
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. e 0 TURN OFF THOSE LAYER MARKERS

Quark calls them Visual Indicators-

those colored boxes with white centers

that appear in the upper-right corner of
any item on a layerother than the
Default layer. The color of the marker

tells you which layer an item is on, COt-
responding to the color assigned to

each layer in the palette. They're kind of
big and clunky, but useful, especially if

you're often moving between layers,
hiding, and showing layers to get to what you want. And, there's always a but. ..when you're
going to be working on one layer for a while. you might find it less distracting to hide all those

colored markers on your page. Easyto do.Just go to the Viewmenu and choose Hide Visual
Indicators. Turn them on again with another trip back to the menu.

Show Culdes
Show Baseline Grid
Snap to Guides

Hide Rulers
Hide Invlslbles

Show Tagged (onten

Hide Full Res Previews

. e @ SELECT ITEMS ON LAYER

0 -. 'm;;~~~OO,.'- I.
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--EaitFlctll..&C8pt","8L~,..,
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~~::t.~
~'"~~~
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~ ......

,--,.," . -.

The Context menu gets more

powerful in Quark with each new

version. In Quark6there'sa very

handy command
that's only on

the Context menu-select Items

on Layer. Access the Context

menu by Control-clicking/Mac

or right-clicking/Win on the layer

whose items you want to select

Doesn't matter if another layer is

highlighted or not. Selecting all

items on a layer can be useful for changing attributes for all your layer items in one fell swoop-

from Modify, there are attributes in the Group and Frame tabs,as well as Picture tab and Text tab.

And there are a host of other commands in the Item menu that you can choose for multiple

selected items. Using Select Items on Layer is also good to see what's on a given layer, without

having to turn on the Visual Indicators (View menu).
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. e 8 THE LAYERED LDDK-VERSIDNING

Tocreate versions for different audiences and markets, use layers. Put all the base elements,
art, text, rules, and such on the Default layer. Now, transfer the versioned content to a new

layer. Open the Layers palette (Window menu). Click the New Layer button, top left, and

double-dick the layer name to rename it. Select the text and picture boxes that have

custom content. Aselected item isindicated by the doned square on the right of the
corresponding layer name. Drag the dotted square to the new layer, leaving a blank spot

below, on the Default layer of the page.The custom content is now on the second layer.

For each new version, Duplicate the second layer with the Context menu, Control-click/Mac

or right-cHcklWin the layer name. Then replace the text and picture contents as necessary.
Quark prints the visible layers only, so telt your service provider how to print each layer.
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. e 8 SPEED PERFORMANCE-HIDE PICTURES GLOBALLY

If you want to edit text, scroll faster, and print pages without those pictures dragging you
down, put them on a hidden layer. Or, if you're doing a product catalog and want to have

multiple versions specific to different markets and readers, put aU the pictures of one version

on a single layer. Those pictures no doubt have runarounds to keep the text wrapping

around. And if those picture boxes were on the page and you deleted or moved them, the
text would fill in those spots in a second. Right? So what happens when you use a layer for
your pictures and then hide the layer, will yOUf text totally recompose? (The mice wit! play

while the eat's away?)Noway!Andthat's because of the default layerattribute Keep
Runaround-even when those boxes are hidden, But to turn it off,double-<Iick the layer

name to open layer Attributes.
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. e ~ TEXT BOXES WITH VERSIONS

';:..- .
AnrIbute$- Product catalogs and foreign language

versions typically have text variations in

boxes identically positioned on the page.

stacked on multiple layers. One problem-
try editing that custom text on any layer

but the top one. You turn off all the above

layers-and that's easy to do by clicking

the eyeball to the left of the layer name.

But the text is gone! What? Yes, the default
layer runaround is the culprit, ifyour text

boxes have a runaround. A text box at the

same page position, on any higher layer. causes your text to look invisible-even if you loom

in. You can remove the runarounds-for those higher layers by double-clicking on each layer
name and uncheckingKeepRunaround.Better,when you makethat second layer, your first

custom version, turn the layer runaround off before you duplicate the layer.

. e ~ PRINTING LAYERS

1~1-'10uIp"1Opr-.""" -1-1-1; -~..-,a . 1"0"0 . 5h."",~0",. . bIOI.;
g ~ ~:::O(..

In Quark S you couldn't control

which layers to print from the

.l ~:~;r~~~'~~~'~o~:::~~a~~~f
the Layers palette to see if the
Suppress Output option was

1\-"'loI'''''
checked. Now make those choices
in the Print box instead. (And,in

Quark6,you can just look at the Layers palette and tell which layers are suppressed-the
layer names are displayed in italic.) Back to the story. Go to the Layers tab of Print (Cmd-P or
Ctrl~P),where all your layers are listed. Just check or uncheckeach layer to turn it off or on for

printing. And if you check Apply to Layout, then turn off a layer and print. Suppress Layoutis
now chosen for that layer in the Layers palette. If a layer is hidden, then printing and applying

to layout means it's now showing and not suppressed.
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Color is one of the Crown Princes of ~PogeDesign.C%rcallsout to the ~
reader in song, makes the page entic-
ing and fun. It celebrates the message being

Time for a Paint Job
1011- color tips

communicated. Of course, how you use COIOf

is the subject fOf another book! This chapter

contaim tips on almost all other aspecrs-

how to set up different kinds of colors, such

as spor colors, tints, multi-inks, spot colors

converted to (MY/(, rich blacks, and spot

varnish. There's more.Applying color fast and

easy by doing trial rum, using style sheets,

as well as changing colors mid-stream, and

avoiding applying the wrong Mblack.
N

Have

you ployed with Quark blends? B/ends are one

of the most fun capabilities in Quark fOf all

the spot gradients. Finally, a few words on

managing c%r in imported EPS graphics,

spot colors in CMYKjobs, printing separations

and CMS, Quark's color management system.

By the time you're done, you'll whiz through

setting up colors, opplying and modifying

them, blending them, and managing them.

Not bad for a few pages!
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. e 8 FAST-TRACKTOCOlORSDIAlOGBOX

Style Sheets...
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F12isthemagic key for color in Quark
of1! It opens and closes the Colors palette

-..:;tF (Window> Show Colors), and Shift-F12
opens the Colors dialog (Edit> Colors).

First, if you're doing print work, delete

colors you'lJ never use-Red, Green,

and Blue are RGB.The most popular

color libraries for selecting colors
(Model popup menu) are Pantone spot

colors (solid coated and uncoated) for

1- 2- or 3-color jobs, and Pantone

process colors (coated and uncoated)

for full color process printing, with
photographs. A Pantone color is

referred to by its PMS (Pantone
Matching System) number, such as

PMS135or 1355.(Don't change the

color name, when you choose a color!)
And don't choose a color based on
how it looks on screen. Check it out in
printed sample books you can buy

from Pantone and other color manu-
facturers, such as Trumatch. Quick

shortcut to get back to Colors-

Cmd-click or Ctrl-click on the color
name in the Colors palette.



. e e TINTING A BOX BACKGROUND

Tints are often used in spot color jobs that typically

havejust a fewcolors. You can get the illusion of
more color by making and using tints or percent-

ages of a color. In Quark, you can set them up in

advance or make them on the fly,using the Colors

palette (F12 to open).Choose the button at the top

of the palette to specify where the color will be
applied, then click in the color listto apply it. When
it looksliketoo muchcolor,however, cut it back by

using the Tint % field at the top right of the Colors

palette.Type in a number or choose from the

popup.Note that a 10% tint may be too light to
really see when output to high resolution. Your

best bet, if you use lots of spot color, is to get

the Pantone Tint Specifier to see tints in 10%

increments for each PMS number.

See ;llso"Don't Keep Choosing the Same Tintn (this chapter).

,~

8 e ~ BE A DARE-DEVll-MIXTWO SPOT COLORS

Combine tints of two (or more) spot or

process colors to make some unusual color

combos. Avoid making color decisions

based on what looks good on-screen,

however. Try to look at the individual

colors in a printed selector book to get a

rough idea. Press Shift-F12 to open Colors

(Style menu), and set up your colors first.

Click New, then Multi-Ink from the Model

~
-

popup menu.Clickon a colorin the list,
then choose a tint value in the Shade
popup

menu at the top or use Other to

enter another number. You can mix more than two colors, but the combined color gets duller.

Enter an appropriate name, such as "326-1 0%_977-30%." Each color in the mix outputs to a

different separation. Be sure to talk this over with your printer so you set up appropriate

screen angles and avoid printing errors.
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. e e DDN'T KEEP CHOOSING THE SAME TINT

This tip is a variation on the previous

one so please read that one first. When
you repeatedly create different tints on

the fly, it's not only tedious but there's
a good chance you'll make mistakes.
Why not set them up with the Multi-Ink
option so they're ready to use in your

Colors palette? Press Shift-F12,click
New, and in the Edit Color dialog,choose

~
- ~h~~-:~~;;~;h~:S~;:;:~~~~~n~:~~~t

(fromtheonesyou've already set up).

Choose a tint percent from the Shade popup at the top of the list. Select Other to enter a
percent not listed. Before you click OK, type a good name, such as 'PMS 360-35%"or just

"360-35%." Repeat the process for each tint you want to use.
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8 6 6 BUDGET SAYS NO TO A SPOTCOlOR IN YOUR CMYKJOB?

Ever have to include in a full color job

some logo or other that demands a spot

color? No doubt,it was the corporate

color. This inexpensive work-around gets
you pretty close to what you need and
saves you an additional color on the
printing. Go to Colors with Shift-F12

(Edit> Colors). Click New, then from the

Model popup menu, select the spot

color library you'd choose, if money

were no object-Pantone or another

standard COIOflibrary. Pick yOUf color
from the list,then uncheckSpot Color, right below the Modelmenu. Last,move your mouse
up to the Model popup and choose CMYK.You've got the closest possible color in CMYK to
the originalspot colorafter conversion,and the CMYK valuesare shown in the dialog.Finish
up the job by renaming your color for its CMYK values-OC/44MJl DOY/7K or drop the

letters to make it D/4411 00/7. Fast and cheap!

IMIIJ1H:51I.(:

Qt~
q; ~,
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. e 8 "RICH BLACK" ADDS, WELL, RICHNESS

-~
Rich black is an old printing industry trick
forCMYKjobsthat makes largeareas of

black color look royal. Flat black just isn't
that great, looking thin or even cheap.But
when you add in other colors, it comes

to life.You'realready paying for cyan,
magenta, and yellow inks, throw tints of

those colors into the mix for rich black. Be

sure to talk to your printer. Typically, rich

black can consist of 6OC-SOM-l0Y-' oaK. or

40% for (MY with 100% black. Maybe you

want a
"cool"

black,just add cyan to 100%

black. For a "warm"
black, add magenta. Create a color for black in Colors (Shift-Fl

2), building a

CMYK black based on your printer's recommendations. Name it with percents for each color:

4O(40M40Y1OOK.Rich black solves trapping issues for overlapping or butting colors when it

contains all four colors. Avoid small serif
type reversing out of the black-too hard to register.

81"'~-.-
:-_,- ....---~.~~--;OS--~

.-~~ ~-

. e
@ SPOT VARNISHPERKSUP THOSE PICTURES-BIG TIME

~ Spotvamishisaveryclassyprintingeffect. 1

_

~,!I]!

_

[t]

-

-
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-

_

_

___

~i
that enhances images and headlines (it

:--= 'a looksNWOW"on a heavy-weight. coated
paper stock). Gloss or matte varnish.

~
applied to printed photos and graphics.

[gJ[gfillii-;;;;08 makes those pictures pop. Go to Colors

~ (Shift-F12)tomakea spotvarnishcolor.

~';'::...:- --11-

I Duplicate Black, but name it Spot Vamish.

::=:::~c :
[ Check the Spot Color option. Then choose

:;;:,.-:.,. 1111- Show Layers (Window menu) to put the

g:..
' .: - spot varnish onto your pages. Click the top- leftbutton on the palette to makea new

red layer. Double-click it to ref"lame it Spot

Varnish. Duplicate the picture using Step and Repeat (Cmd.option-D or Ctr1-AIt-D) with offsets set

to zero.Move the duplicate to the varnish layer
by dragging up the dotted square icon on the

right.Then delete the image, and
apply

the Spot Varnish color to the box background. Do this to

all your pictures, then hide the Spot Varnish layer until the job goes to print Discuss your varnish

plans with your printer up front
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. e 8 TRY ON A COLOR BEFORE YOU APPLY IT

. .
.

ii ~:~~
_

I Drag and drop color is a fun way

~ :;::"...
=

to see how color looks on a line,
.

:~=g~~gci~ =~!
box background. or frame-but

- '.
PANTONE36SU III. not text.Open the Colors palette

"
(F12) and select something on the
page. If you want to see how color

looks on a box frame, make sure you give the box a frame weight first (Cmd-B or (trl-8).

Start by dragging a color from the palette to a selected something on the page. Noticethat

as you drag your mouse over other things that aren't selected,they temporarily turn color! If
you decide not to apply the color,just bring your cursor back to the Colorspalette before
you let go. Easier-let go of your dragged color over any blank area of the page to cancel
drag and drop. Nothing's changed.

. e 8
~~~~M~~~~:~~

TYPE AND PARAGRAPH RULES
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For multi-page layouts, you're working

efficiently jf
you're

applying
color

manually to text only when making

initial design decisions. After that, set

up your style sheets to automatically

apply
color to text using a paragraph

or character style. Create a style by

first making some sample text that's

formatted the way you want your

style to look. This way you can see

whether your color and type choices

look right on the page before you
go further. When it looks good, click in the text. Press Shift-F11 (Edit> Style Sheets) and click

New.. .Character or Paragraph. Enter a name,click OK,and Save. To apply a paragraph style to a
headline or subhead. click in the paragraph, or, if a character style, highlight the text. Then click

on the style name in the Styles palette (F11 to open). Now it's colored and styled with two clicks!
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. e 8 NEED TO CHANGETHATCOLOR YOU'VE GENEROUSLY APPLIED?

This problem can be agony if

you
don't know this tip. You've

applied a color to a bunch of

things-type, boxes and maybe

lines. Now they tell you,gotta

change the color! It's actually a

breeze, and Quark's going to

take care of the whole thing for you! After you set up the new color in Edit> Colors (Shitt-F12),

don't close the
dialog, In the Colors list, select that color you were going to use, then click the

Delete button. Up pops a dialog asking you to choose a replacement color for the one you're
deleting. Select the new color in the popup menu provided, click OK, then click Save to close

the Colors dialog. Now, all the places where the old color was used are replaced with the new

color. Thank you Quark!

. e e REGISTRATION COLOR IS NOT BLACK!

Using Registration color instead of black is an

easy mistake to make, especially when you're

on deadline. You need black, you see black,

and you apply it. It happens more often when

you've got lots of colors and only the lower

half of your scrollable color palette is showing.

You see the Registration color at the bottom,

but not the black at the top. What's wrong

with using Registration color? It sure looks

black. Bur, it prints out to all color-separated

films. and printing plates, instead of just the

black film or plate-that thing wi1l print in

every color! Apply Registration color to things like hand-drawn crop marks for a 1 Q-up-on-a-

page business card. Those marks can be used to register printing plates because they're on

every color plate. But when you want black, don't settle for anything else.
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. e 8 OPTICAL EFFECTS WITH BLENDS IN BOX BACKGROUNDS

~
Combine linear blends that go in opposite directions. Wicked.
Draw any size text box (no more banding problems using
Postscript level 3 output). From the Colors palette (F12),apply

a box background color. Select linear Blend from the popup

menu that says Solid. Click #2 button, choose the second color.

Light-dark color contrasts are dramatic. From the Measurements
lIo~zO<1tAl011.." ~ palette, copy the box W or H value, whichever is smaller. Then do
v.r1I<IIorr..<: ~ Step and Repeat (Cmd-Dption-D or (tn-A It-D) and paste into the

~ .. appropriate offset. If you copied H, then paste into the Vertical
offset, and vice versa. The other offset is zero. Click OK and you've
got a duplicate butting the original. Switch the blend colors of

the duplicate fast using a 180" rotation in the Colors palette, where it now says
0". Select

both boxes, then again Step and Repeat and enter"*2"in the Offset field after the number

previously pasted. Repeat Count: How many pairs do you want? Click OK.
It's

blazing!

See arso"Type with Gradients" (Chapter 8).

. e 8 PUT BLENDS INTO LINES

This amazing tip lets you put a gradient-blend into a line! Of course, if
you want a gradient in a straight line, just draw a box and specify its

line "width" in the W or H field of the Measurements palette {F9},then
apply a blend. But how about all those other lines you can draw with
the Bezier and Freehand line tools (see Chapter4)? Give some weight

to that line width so you'll see the gradient-use the W field in the

Measurements palette. With the line selected, go to Item> Shape>
and select the Bezier shape. 0 Now you have a box shaped the same

as the line you just had. So naturally, you can apply a blend in the
Colors palette by choosing a blend type from the popup at the top,

then select your colors using color #1 and #2 buttons.
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. e 8 NO WORK-AROUNDS NEEDED FOR IMPORTED PMS COLORS

~
,.s".:".

T r e "'Ok ~
.Cyan 1:1
.Magenta II

~;y
'

,

.PAr.nONE320~ !II.

. PANTONE368'\.1 111 l;-

. ",ANTONE Rhoda.-- iii .

0 Why would a PMS color specified in

[gJu:IDcnioox 1.. an EPS graphic have a different
--;-1 name than the same PMS color

specified in Quark? No good reason.

But it's been that way since PMS

colors first appeared in Quark. So

then you needed a tip telling you

how to synch up those colors so

that the different names for the

same coJor don't output to different

films and plates. Well the miracle is.

now you
don't need a tip! Or, the tip is, starting with Quark 6, a PM5 color specified in an

imported graphic looks, acts, tastes, and is the same color in Quark. No duplication! In fact, even

if you try to set up a spot color in Quark, after importing an EPS that uses that color, you can't.lt

says you have to choose another name because the default color name is taken. Good news.

8 6 6 SPOT-COLOR EPS GOING INTO CMYK QUARK JOB

The EPS graphic you just imported into your full-color Quark job

~[gI]E:I;

'0'"
81 uses spot colors instead of process. Oops! Another reason why

! ~d

'"

printing out separations from Quark can save you time and
.

money down the line. If this color-mismatch goes unnoticed, your

monster print bill will include charges for printing 5.6.7. or more

colors! (In Illustrator, define your colors in CMYK, then, when you

save as EPS, make sure you check the CMYK Postscript option in

the EPS Format Options dialog.) In Quark, there's a real easy way

you can keep track of your colors. When you import an EPS

graphic, first open up your Colors palette (F12).After you choose

Get Picture, if you see new colors added to the Colors list, they are

spot colors. CMYK-defined colors are not added. Also. a spot color

has a colorless square icon opposite the color name.

See also~Budget Says No to a Spot Color in Your CMYK Jobl~ (this chapter).

0.\ O_l
O'

!!!IN....
.'lock II I.Cyan II
.lo4o.g."'. II

't
:~~:~~I~~~

C;
~

liiPA~ONEDlll-1' II
.PA~ONED~64-1C II
.Registration
[JIflhK.
Onll- II

CHAPTER 11'KillerColorTips 189 r4



. e 8 COLOR MANAGEMENT IN QUARK

'1<--- Color management in Quark
r

~7-' ~ =;- ~::~;t:~~::~:eOn~:;:~~ut-
'-"""'0vI_~.'" -! k___! --- ~

~~~ ~~~;:~~~~Oa~ ~~~d:~PY
you show your boss or client

who says thumbs up or down to
your design.Tum on Quark CMS

(Color Management System) in

Preferences and choose settings
(that's Cmd-option-Shift-Y or

Ctrl-Alt-Shift-Y). But color man-
agement ain't perfect-first, it
slows down your performance

OI> r~ ~sO- - I as you import imagesinto
Quarkbecause QuarkCMS is

translating the CMYK content of that image to an RGBdisplay device, your monitor, to generate

the display correctly. When you print,color management translates the color back from the RGB

device to your CMYK printer. That conversion time is overhead.$econd,Quark
can't color manage

EPS graphics. So while you can get better control printing the color you set up in Quark and the

imported color in TlF images, there's nothing you can do about matching the printed colors used

in EPS graphics and those same colors in Quark items and text.
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. e 8 PRINT SEPARATIONS TO CHECK COLOR BREAKS

~
:::~~~~~~~~o~ ~::~re~:~: ~~;ask::~~~:s;r;~~~~: :aus~l:h~:er-

~eparatiOn5
~~~~d~~:;? a~~I~~~h:opZ:ne t:r :r~:: ~~5:~::s~fb~s;:~ :~~sSh~~ld

0 Print Blank Plates have been PMS71O?Usedifferenttint percents by mistake?A sure-

fire wayto catch allkindsof color mistakes is to print out separations

to your desktop printer. CheckSeparationsin the Layoutpanel of the Print box. Then see if all

the items and text on each separation are supposed to be there. Tints of varying percentages
output to the same separation but you can see differences in primed tints more easily than on
screen. Sogivethose seps a good lookover,and youjust might spot at least one to fix.
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Sometimes it seems likenothing is r6\
.

-
more important than printing your I..Q..I
layout. Remember the last time you

lavished attention on a layout and didn't

Detailing Makes the Difference
printing & preflight tips

print fOfhours?Just when you thought you
had every detail in place, you made your first

proof and... Oh! So many wrong calls. Easy

to do. The Quark environment is Q visually

noisy one-roo/box, palettes, margin and

column guides,and more. No wonder your
type and pictures are too big. That dingbat
you thought was so Ukewrtums out to be

Nklunky."As we say in Chicago, print early

and often-oops, that's another game!

This chaprer takes you through the bells and

whistles of printing, exporting to PDF, making

on fPS, trapping, and job assembly,including
some dynamite preflight and packaging

checklists. Be amazed, for instance, by what
Quark daesn't include when it makes a
package of your Quark layout, fonts, and

linked pictures. Speed your printing time,

not only through 011those settings in the tabs

of the Print dialog, but lowering your print

time also. Thinking about trapping your file?

Read on to learn the secrets of printing and

file prep.
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. e @ DON'T KEEP CHOOSING THOSE SAME PRINT BOX SmlNGS

Quark remembers your choices in the Print

dialog and saves them with the file. So who

needs Capture Settings or Print Styles?

Sometimes you choose print options on

multiple panels (Cmd-P or Ctrl-P), then realize

you're not ready to print. Click Capture
Settings to remember those settings, while

closing the dialog. Next time you're a step

ahead. Print Styles. on the other hand, is

~
-

perfectif youprint to different printers or

n~d differentprint settings at various

times-such as when switching from a black-

and-white to a color printer. Though Quark can remember one set of choices, you need Print
Styles (Edit menu) to switch between sets. Click New, name your style, then choose yOUf set-
tings. Next time you're printing, grab your Print Style at the top of the Print dialog, enter your
page numbers, and you're done!

_'-V r=r_-- 1

-- 1.._......
"-;- .. 8-

'-"' '"...::: H~~ ~. -

.08 GOTABIGPAGETOPRINT?-TllING!

, When your Quark page is bigger than the paper

in your printer, use Tiling. In the Print dialog's
Layout tab (Cmd-P or Ctrl-P), select Tiling>

Manual to print using fewer sheets and overlaps.

The current location of the zero point on the
rulers marks the upper-left corner of the page

area that's printed. For your first print, though,

don't worry about the zero point unless you've

moved it.To reset,click in that small box at the
intersection of the rulers. If your layout is tabloid

and you're printing to a standard sheet for a
range of pages, choose Landscape in the Setup

tab to print the entire top half of each tabloid
page. Before making the second print move the
zero point down. Dragfromthe intersectionof

~
Ofr ... the rulers in the upper-left corner of the layout

Allloma
window. With your mouse down, X on the
Measurements palette is 0, Y is 51 P (8.5'). Now
print again for the bottom half of your pages.~\

Tiling
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8 e @ TURNING ON REGISTRATION MARKS

~ --~_h_-
--'-----"-.--._- --..

--"--- -------"--- ---.---- ----..--..----- -------.---'~ ."------ --.-"--- ------

I =~~~~ I!
BiOil

Choosing Centered or OffCenter for
Registration (in the Print dialog's layout
tab) puts printing marks and document

information on your printed page. Why

bother? With registration on, Quark puts

the date and time of printing, which helps
you find the latest proofs and track your

changes on any job. Ifyou're printing from

~
multiple filesof a book or magazine,the
filename on each proof keeps your mind

dear. If you're printing a Ncornp"for your

client and your layout page is smaller than
your printing sheet, Quarkplaces crop
marks at the trim edges. And when check-
ing separations on a black-and-white

printer, the option prints the color name

on each proof. Here's the catch-all marks
are placed outside the trim edges. So, if your
printing sheet matches your layout page,

you've got to have a printer that handles

tabloid or oversized pages-or reduce the
output percent in the Setup tab.

. ~ 8 WANTTO CHECK BLEEOS, SEE REGISTRATION MARKS?

The Fit in Print Area option in the Setup tab of the Print dialog

~it in Print Area (Cmd-P or Ctrl-P) is somewhat buried but eminently handy for

checking bleeds (for extension beyond the trim edge, '!B
inch)

and to see registration marks. As for bleed pictures, type or colored items-anything that's on

the page and extends off of it-is imaged to your desktop printer and to a high-resolution

imagesetter. Most of the time you
don't see the bleed because all desktop printers have that

non-printing border and the page and sheet sizes are usually 8.5xll inches (A4 is standard

in Europe). Clicking Fit in Print Area is also a great way to get a quick look at an oversized
page,

without having to paste pages together-with glue-if you don't have an l1x17-inch

or larger printer. You can also use the Reduce or Enlarge field to enter a specific percent.
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. e 8 DDING A COMP AND WANT SPREADS?

0
OQ[@J[(WI!]

OA.M8ItorA

P~ge5: ~ ::~L(::~~etin~:s:~::t~r::~cm
I ~ OplloRI--a.y.n facingpagesooonesheetofpaper.It'seasy

to do ifyour printer can handle paper that big
or you're willing to settle for reduced prints of

your pages (see the 5etuptab of the Print box}.Clickthe Spreads option in

the layout tab of the Print dialog (Cmd-P or Ctr1-P),and enter your page

number5 using a hyphen,as io"2-3,"(1fyou type"2,3"you won't get spreads.)

Printing spreads is a natural for a facing pages documentBut you can also
choose Spreads for a single-sided document ifyou've arranged side-by-side
pages in the Page Layout palette. And even when you've got three or more
pages across-facing or not,like a brochure with three 8.5xl1-inch panels

on a side-you can also printspreads, typing"2-4 in"Pages.

See also"Use Margins to Clarify Your Content" (Chapter 13).

I!!ISPf1!ads

I

~ ['
,.,!

, I

. 6 8 BETTER RESULTS WITH BLACK-AND-WHITE PRINTERS

IGr~.1o:o

Halftonlng" fConvenllonal

1:1

13

RUOlullon'~I!J(dpl)

Frflluen<y.~~{1P;)

Even if you have a color printer, chances are you use a black and white printer for most
proofing. So it pays to get the most from your fast printer, Go to the Output tab of the Print

dialog (Cmd-P or Ctrl-P).lf you're initialized to a Postscript printer, you can change the

Frequency setting, above the color list. By default the Frequency setting is set by your

PPD (Postscript Printer Description), typically to 60 lines per inch (lpi}. Frequency controls

the fineness of the halftone screen used to print tints in colored items, type,
and pictures.

If you increase the lines per inch, you get more dots and a finer line screen when printing-

especially good for light colors. Although you can go up to 400Jpi, don't
go there. With

greater frequency, you get fewer gray values in tints and halftones. Best bet is to choose

what's offered-the Ipi values specific to your printer.
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. e @ GOTTA CHANGETHOSE SPOTCOLORS TO CMYK?

~:<Od~~:~:~7''-E EU"."'.""
II. lUll . Your job was going to be real classywith fuU-

color photos and spot colors for the logo and

flat color areas. Then someone yells,NHoid the
budget! No spots with that CMYK "Dare I
mention that Quark has this printing feature,

Convert to Process? look for the Plates
option, in the Output tab of the Print dialog

{Cmd-P or Ctrl-P}, but only when youdick
Separationsin the Layouttab. But buyer

beware-1 only mention this to warn you not

to use it! Output settings routinely get
changed at your printer or service bureau,
and so can this check mark. Instead, set up

a new process (olorfor each of your spot

colors in Edit> Colors (Shift-F12). Then delete
youroriginalspot color, and Quark prompts

you to choose a replacement color from the

list. Every instance of that original color is

now replaced by the new color.{Wel!, okay,

not in imported EPS files!)

See also ~Budget Says No to a Spot Color In Your CMYKJobr {Chapter 11).

~ ~ s~51~~-1~-
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8 e @ PREVENTTYPE RECOMPOSING AT HI-RES OUTPUT (WIN ONLY)

,..
if"'

A long-mndlng Window, ootpot

"t:oxs
..""" ~""..

problem-type on your page ca.n
recompose when the Quark file IS

printed from a different printer for

high-resolution output. Happily, the solution has improved. The answer used to be saving

the file as Postscript. But outputting Postscript, one huge text file, is unstoppable. Once the

job is set in motion, there's nothing that can be done if a problem arises, The job runs until

it's done. With long files, that can be costly. Instead, export your file to PDF (see the next tip).

But also send along the original Quark file so that corrections can be made, if needed. And

send along or fax a complete set of black-and-white laser prints so that they can compare

their output to your proofs to make sure you're both on the .same page."

"1>1"'''''..._iD"

5.a.VI!'P;l.9~ as EPS...
CoIleClforOutpul...
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8 6 8 PDF IS THE WAYTD GO FOR HI-RES OUTPUT

--
Saving your file to PDF got a lot easier in Quark

S,and now in Quark 6, you don't even need
Adobe Acrobat Distiller because Quark has
developed its own "Adobe-free" Postscript-but
you do need a Postscript printer. Why bother

with PDF? Any problems that would occur when

the job is output at high-resolution happen

instead when you make the PDF, which optimizes

the Postscript. You control the show now, with

lower costs in the end. Choose File> Export>

CJ~' r~~~
~::~I~ ~:i:~:~:;:~:~~~~~~~e:~ct~~~~:~es,

if

~ ~ right to open a second dialog with settings on

five tabs. In Job Options, you can embed fonts or

a subset,as well as set compression and resolution for color, grayscale and monochrome
images. In Output, choose composite or separations, and CMYK or other color modes, with

options for OPI, registration and bleed. Lots of control and it's almost a breeze!

,-<00>"", "", ,-

~==~t:~J'EG'''' .c._,,,,,,,
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8 6 8 MAKING A PDF FROM WINDOWS

jjI'--"
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Making a PDF has a few extra steps on Windows. The

basic recipe is that you have to have a Postscript printer.

Then you need to "print the file to disk."Goto your

Control Panels, from the Start menu. In Xp,double-click
on Printers and Faxes, which opens another window.

Right-dick on the name of your Postscript printer, then

in the Context menu,go down to Properties. In the

Properties dialog, click the Ports tab. In the list of possi-

ble ports,at the bottom, is the FILE:Printto File check

box. Check that box, then click OK.Go back to Quark,

and choose File> Export> layout as PDF.See the above
tip for information about export options available from

the Options button in the dialog. Don't forget to go

back to the Ports dialog from Printer Properties and

reselect your default printer port, likely LPT1!



(8 e 8 SAVE PAGE AS EPS SAVES THE DAY

Ever need to scale a group of objects
rogether?The ad you designed is now
going in another paper at a smaller size.

Ifyou group the items first, you can scale

them together by dragging a handle
pressing Cmd-Gption-Shift or Ctri-Alt-Shift

I"dud. Imago' :!
But,group scaling isn't a perfect solution--
box frame widths and line weights don't
scale. Here's when to use Save Page as EPS

(Cmd-option-Shift-S or Ctrl-Alt-Shift -5).

Enter a filename, and below, in a tab of the

same name, specify which page, Scale %,(olor Formatand the rest. Don't forget the options in the

lower left for Spread and Transparent Page.The latter is what happens when you save an EPS in a

drawing program and the white page becomes transparent. Now make a picture box and choose
Get Picture (Cmd-E or Ctrl-E) to have all those items as one graphic that you can size-including

widths and weights!

See also"Size Items Together'" (Chapter 5).

... I °"1
P~g~ ~ format. lColor

S(~I~ ~ Spa.(~. 1CMYK

Pr~vl~w f nH

OSprud !lIlIlory

rnI
GI
a
...

~Tr~;;::r~::pPag~ o~

. e 8 WHAT'SWORTH TRAPPING IN QUARK, AND WHAT'S NOT

Trapping in Quark is like a can of worms, with a few
good crumbs. Trapping is the solution to slivers of

white space occurring between butting or overlapping

colors when color registration on press isn't perfect
(rarely is). By extending color, light over dark, to create a

buffer zone, mis-registration is handled. Most designers

let their printer or service provider make the traps.

Bottom line: Ifyou make trapping mistakes in your

Quark file and the printed job is a botch, it's your

problem (gulp). Ifyour printer or service provider

makes mistakes. it's their problem. Trapping is fine in
Quark for a headline in a colored box or overlapping

colored boxes. But when any item or picture has multiple colors at the edge. Quark's solution is

too basic-one trap fits all. In high-end trapping, the trap changes pixel by pixel, to spread or

choke depending on how the colors change.
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. 6 8 SPEED PRINTING-TURN OFF TRAPPING

[;:;:~u:ethod
0 PrOponlOMI ~KnockOU1AJI

I

~fh~;~:~~ ;e~o~~: ~:~trs~rr\~:i~~~~~'e

-
for every Quark job. The more pages
printed, the more time saved. Whether

or not the job needs trapping when it's finally output, the fact is, you're not printing separa-
tions until one of your last steps. And even then, you're probably just checking how your

colors break, not trapping. By default, with Quark's Absolute Trapping Method, trap informa-

tion is automatically passed to the printer, whether it's needed or not. 50 go ahead and turn
off that processing time. Go to Preferences (Cmd-Option-Shift-Y or Ctrl-Alt-Shift-YJ, click
Trapping under Print layout, and, for Trapping Method, click Knockout All.Watch your print
times go down. Oh yes, want to do this for all new files? Close all your open Quark docs, and

then go to Preferences,

. 0 @ COLLECT FOR OUTPUT-LET QUARK PACKAGE ITFOR YOU

Collect for Output (File menu) is very handy for
gathering almost all the files you need for hi-res

output or offset printing.(What doesn't Quark

include? See the next tip.) Quark assembles your

layout, linked pictures and foots,color profiles, and

more. But first, make a folder to locate all the files in one place.ln the dialog, at the bottom, Layout

and Linked Pictures are already checked. Check Fonts also (Screen and Printer Fonts for Mac
users). Click Save, then click OK to a warning about copying fonts. Ifyou have missing pictures,
click List Pictures in a second alert box to go to Picture Usage (Utilities> Usage). To skip a missing
or modified picture, click Show to see it, then if you're sure, uncheck it in the Print column. Ifyou

have fonts missing,go to Font Usage to resolve the problem. Continue with a Save or two to
process the collecting and generate a handy report. Everything's now in one folder!

See iIlso NGeneriite a Complete Report About Your layout AnytimeR [this chilpter).

Collect

IUyout @lColorProfile.

Unk~Plclures s.creenFonlS

fmbedd~Plctu",' IPrinlf'FonlS
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8 e 6 "BATTERIES NOTINCLUDED"-PICTURE AND FONT USAGE

Ai
I

:O;~~-~I

Font Usage and Picture Usage (Option-F13 or

Shift-F2fWin) keep track of the fonts you use

and the pictures you import onto your pages-

TIF, EPS, and the rest. And when you get ready

to assemble that final package for output or

offset printing. you'll need all those linked pic-

tures with the Quark file and often some or all

of the fonts. But there's one hitch. If any of your

imported EPS pictures have editable text with

fOflts that are different from those in your

Quark documentorthey havebitmapimages
embedded in them-well, Quarkjust doesn't
see them (it's only a passing glance). So be sure

to include those fonts and picture files in the
package you send out the door-orelse! (Tip within a tip---in your drawing program, convert your

editable text into path outlines for tI1e final version, then no fonts are needed.)

See also "Collect for Output-Let QUiilrkPiilckiilgeit forYoli' (previous tip).

8 e 0 GENERATE A COMPLETE REPORT ABOUT YOUR LAYOUT ANYnME

I~

To get a ton of information about your Quar\c.layout,

go to File> Collect for Output. If you're preparing your

package for final output, the report is generated auto-

matically. But you can just click Report Only. The default

filename is useful-your document name with "report"

at the end. Click Save. Then use GetText (check Include

Stylesheets) to import the report on your page and see

a clutter of information about your file--path name.

last modified. file size. version number, number of
pages, dimensions, fonts, style sheets, and much more.

Even better,open Quark's Output RequestTemplate

(Quark's application folder> Templates> English>

template file). Fill out the top part with contact and job

handling information. Then use Get Text and import the

report into the empty text box at the bottom of that

page. Again be sure Include Style Sheets is on to see that

same report fully formatted and a pleasure to read! ~CHAPTER 12. Printing & Preflight Tips 201



-------
. e 8 USE LAYERS TO COMMUNICATE WITH YOUR PRINTER

........--..-, ...,...-

........-.----. ......--...
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. e 8 FASTER OUTPUT. LESS HASSLE (AND LESS MONEY1j

.., To communicate with your printer, some

~.: things are best handled right on your Quark
layout, rather than in a separate ReadMe file,

such as those FPO labels (For Position Only) or

any last minute details. Put the instructions on

- a layer {Window> Showlayers),clicking the

:: top left button in the palette to make a new

layer. Oouble-dick the layer name to type a

name like 'nstructions for Printer, .then click

OK.With this layer name highlighted, the text

boxes you draw now for your written instruc-

tions go on this layer. Until the file is ready

to go, hide the layer by clicking in the palette on the eyeball. When you want to add another
message or the file is ready for output-show the layer again by clicking that same spot-and

then highlight the layer by clicking the layer name to add more items.

This tip is easy to do, makes your file

size smaller, and ensures the file will

output faster (which could mean

fewer dollars). When the job is done
{is it ever done until it's out the

door?).do a Save A5 (Cmd-Qption-S

Of Ctrl-Att-S) to create a new file to
send, giving it a different name. Try

not to beg the questioo by naming

it FINALqxp! Then. in that duplicate
file, delete all the items on the paste-

board,that area around each page or

tt spread where you might be storing

logo's, boilerplate text, boxed text,

and such.Thosethings can make your email attachments larger and longer to send,as wellas
eat up processing time on output. You might also want to delete all colors that aren't being

used in Edit> Colors (Shift-F12). Now your file is cleaner, meaner, and a screamer, besides.
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. e 6 ONAMACWITHAWINDOWSCLlENT?(MACONLY)

., 6 8 g:"'Uln\lMlghtyMDMVCO

~ S 111'="'1' " 6) t
Compute, Dolo'. "..f

lof4~.m...lKtod.n,I~YiW'~"i:.
-

I ~
MMMlnllUllbport.- Gr..nTr...Fum.qxp

mite
MMM<.t.log-O}.q.p c..,rrr.yC,um,q.p

This is a fast one.When you hand off your
finished project to a Windows client Of'boss,

yCHivegot to do something that's not

required on a Mac -add an extension to the

end of the filename. For any Quark 6 file,it's
.qxp (which stands forQuark-XPress-Project).

Forearlierversions, it's the .qxd extension.
Otherwise, the file will have a generic icon and

Windows won't recognize itSecond,don't
give clients your Mac fonts, unless they're

Adobe OpeflTypefonts, which work on both

platforms.They'li have to get their own.

CHAPTER,2. Printing & Preflight Tips 203
~



. e 8 MASTER CHECKLIST .'-GET READY (FINAL FILE CLEANUP)

Use this form to help yourself through all the ne<:essary steps to getting your job ready for

high-resolution output at the service bureau, prepress house, or offset printer. As they say,

so many things to think about, so little time.

Check the File(s)

CI Searches-Find/Change Kmd-F or Clrl-F):

':I Truefonts,not bold and italicstyle'

a Spellchecking-Onelasttime.'
I;)

Removedouble.paces,doublereturns,straycharaoers.'

Q Change underHnes to italic {fonts, not styles)' espe.:ially jfyou've gotleo new copy since you last did
thesepass.es.

1:1 Typographicproofing-dofromprintedp'ooh

':I
Look for bad line breaks, widows and orphans, justified text with too much 'pace between wOfds

andle!!ers.'

Q Bleeds: Items extend off the page
'/! inch(.12S')?'

a Marks Ih!t print outside the trim edges of the page, including manually drawn crop marks, fold lines,

perforalion lines. die-<:ut lines, registralion marks.

a Correctly drawn to dimen,ions of your job'

a flegislrationcolorapplied?'

a Pa,teboard-remove everything.items fatten file,ize ~ndeat up processing
lime.'

:J Red"X.intexlboxe,-Oversettext?

:J Alivalidcoiors,CMYKorspotcolor,a,needed.'

a NoRegiwalioncolor.ppliedlol.youtilems,"

a NoRGBcolors:Red,Green,Blue."

Q Hairlinerule,

Q NotQuark'sHairlinebul'pecifiedas.2Spl,"

::J No accidental variations in line weighl-.2S, ,5 and lpt (all look the same at 100% view or less)."

-:J Picture Usage---Check for missing ormodifoed pictures,'.

0 FPO:lf,ubmi"ingphotograph,fortheprintertoS(an,doeseachfor-position-onlyimage on the page have
an obvious label,"FPO:rlghton top of the image?"

a Printdi~log(optionan

:I Registralion:Centered-toturn on allregistrationmark,(layoul tab)."

':I ReduceorEnlarge,100%ISeluptab)

~\
a Separationschecked
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1 Seeol,o"U,eTrueFonrs,Not8o1dol!(/lrolicTypeSryles"/Chopler81

1 S ol,o"SpeIiCher.kingfromrheKeyboord"(Choprer7)j
S ol'o"Mo~r""tLooI<h'keTypesefrlngWjfhouIAnY""eNoli<jng,"/Chopfer71.

4Seeol,o"lIepltxeUn,jghffy~wirhjtolic"(Chopter7).

S Seeol,0"Hyphens:GertingTooMonyorNotEnough1"(Chopfer81-

S al,o"Onlhe5pOlFixes:Di""retjonaryHyphen,'(Chapfer8).
S,."oba"Slyl..forWidawondOrphonContro1"(Chapfer91

6 S ol'o"WanttoChec~Bleed$.5«Regj'lrorjonMark51"(fhj'ehopfer)
1 Seeal,a'7urningonRegiSfrOlionMorl<s'lthi,ehopter).

S,."olro"CropMork5for811,;nes,CordArt'(Chapfe<13}

8 5,."airo"fa'ferOUfpu~Le"Ha'*(andle"M"""y?)"(fhi'ehopfer)
9 S,."ai,o'BudgetSays Notoo spor Color in YoorCMYKjof>?"(Chapter II).

SeeoJ,o'GottoChangeTho,eSpotCo!orsroCMYK1"(rhi,chaprerl

IOS,."al,0'RegistrarionColorbNot810dc!"(Chopferll)
115eeal,0"Delete8<>gusCQ/arsfarAllTime"(ClWpterl)

115eeol,o""FJ""Way,foChangeaLineWldrh'orWeight"/Choprer41
13seeol'0"GerJdenrJcollysryledUnesEveryflme."(Chapter41

14 Seeol,o"1!orteriesNorlnc!uded'-l>i<rureondFontU,age'(thJ,chopter).
15s,.,,01,o"U,eLayerstoCommunicotewirhYourPrinler"/thi,chaptetl
16Seeol'o'7l1miagonRegjJ/!otjonMorkJ"(thischapter).

Seeolso"WanrroCheclc SIeed"s..eRegistrotion Morks1"(fhl,ei!oprer).
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8 e 6 MASTER CHECKLIST '2-GO (PACK IT ALL UP)

Delivery

a tncludeajobdescription,heet(seejustbelow)whetheremailed,faxed,orcouriered.

Q tfsendingthejobviacourier,suchasFedEx,indudeacompletesetoflaserprinlS

1:1 If job is going to a printer, also indude a complete mock-up of the piece.(Cut folded. and trimmW,made

from final proofs;andifpossible,the PM5 color chips for the colol"1 used in
job.)

:I Ifemailing as attachment orFfP,BB5;Fax a complete set oflasef print s

Job Description That Goes with the Job (and Also Helps You Assemble All the Pieces)

':t
Quark supplies an excellent form Output RequestTemplate.qxt in:QuarkXPress application folder>
Template, folder> English folder.'

a Quark', Report that COm..s with the Collect for Output command-you can use this although it includes lots

of nonrelevant info!

I Prefer to Make My Own Job Description

Q Jobhandling

:J Your name,comp.3ny,address,contactinfo:Email,cell,dayand ni ght phone numbers,
fa"

:J Delivery info: pickup date/time and tu'naround time to delivery

::J Duedates:colorproofs,hi-resoutputand/orprimedjob

':I
Items you're submitting Icheck lis! for you but also include lisl wi thjob)

0 MaclWindows.

1:1 Type
of files: Quark S-O-6.0/PDF/Postsc:ript

0 Font names and manufacturers:for Mac OS 9-screen and printer fonts. (Check with your provider

for which fomsyou need to send.)

::J Use Collect for OutpU! to assemble Quark file with its fonts and pictu'e
s.'

:J Imported EPSgraphics:manuallyinciudeall"live"'onuandembedded image5used.'
:J Picturefiles:EPS,TlF,etc.-listfilenamesandtotalnumber.

1:1 Fi(ms: ff sending films to printer,include Ipi (lines per inch) that films were output at.
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0 Pho!os for scanning at hi-res:

0 Yes/No

Q Numberofphotos/scam

0 Colororblack-and-white.

Q SC<!natIOO'1borotherpercem,(optional:recordonlaserproofspercemusedforeach picture on

Quark page)

0 Color proofs:

Q Type:digitalproofOris,Rainbow.KodakApprovaI.Epson.etc.J,Blueline,Matchprint.etc

Q Typeofservice:ovemight,sameday,etc

';J Service bureau orprepreSl house

0 Typeofoutpu1.

0 CMYKjobs:you don't have to
,ay, they are alwaysoulput to film

0 Spo!colorjobs:filmorpapel;paper(cheaper)ilokayifnohalftones(photos) or tinted items

;:) lPI(linesperinch,linescr~n)foroutpurtingjob:typicallyIB,ISOlpi,check withyour printer.

1:1 Emulsionside down (or up)

1:1 Typeofservice:overnight.sameday.etc.

0 Document description for service bureau or pre'press house,odtf

1:1 Page numbel"i if no! outpul1ing all pages.

0 Trapplng:indicateiftrapsn~dtobeadded

0 Document description for printer, odd'

1:1 Delcription of the pie<:etobeprinted(flyer.brochule.annual repor1.e! c.).

1:1 Page numbers if not outpul1ing all pages.

1:1 Trapping:indicateif!rapsn~dtobeadded

Q Quantity

a Colors:CMYK and/or spot colors (number and names)

Q Paper wxlccover and in<ide <tame of rn.x:k. finish,color, weignt and manufacturer.

Q Printeddimensionsofjob(trimsizeJ

1:1 Numbefofpages.

1:1 FinishingarKfBirKfery:die-<uts.embols,score,perforate,typeofbinding(saddlestitch,perfectetc.).

1:1 Special instructions:

I Seeolso"G,-",erareDCompJereR.porrDoomYDurLoyourAnyr;"",'(lhi,chDpr.,).

2 Seeolso-Botterje.-Norinduded'-PicrureondFonrU>oge-(rhischoprerJ.
3 See oJso

-CD"",r
for OulpUf:-Ut QUARKPaclmgt' 1/for You"

(rhi< chop/.,)

4 5eeQJSJJ~BQtterj..Norinduded'-PicrureQndFonrU'Qge'(lhischQ,,~'I.
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Usually a software tip book like rhis ~
doesn't have UdesignUrips, so why I.;.:J

include them? Good question. The

answer is that people who write books geared

The Winner's Circle
\Nay cool design tips
to design are usually writing to a market

of people who use different page layout

programs. So they present each idea with lots

of cool pictures, but then let you rhe reader try

to figure out how to do that particular thing

in the software you use. So here is a mixed

breed, if you will. Here are some solid rips that

are driven purely by design and production

concerns. But they include rhe back end too-

all the details you need for implementing

these techniques in Quark. Here you've got

tips for making brochures, newsletters,

magazines, manuals, and long documents, as

well as business cards. Of course, this chapter

could easily have became a whale book (they

wouldn't let
me!), so of course these tips are

just a smarrering of some of the more useful

and classic siCUations you encounter with a

variety of projects. Use these tips to blast off

into flights of creative design that are also

production-worthy!
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. 0 @ USE MARGINS TO CLARIFY YOUR CONTENT
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In your brochure, will Wigit A

content be on a leftpage and
Wigit B on the right? Or will

each Wigit fill a complete
spread? Use margins to visually
clarify your intentions to the

reader. If a product fills two
facing pages, you can enhance

that message by unifying the
spread, making it look like one
big space. Use small inside

margins, such as 3p (.5"), and big

outside margins, such as 7p6

(1.25").* But if there are two
products or categories on a

spread, then emphasize that

message with the individual
page as the module. Use the
same set of unequal margins for

each page, such as wide margins
on the left,narrow on the right,

How? Quark 6 has it! Start your

document as single-sided
(uncheck Facing Pages). Add

your pages using the Page

Layout palette or Page> Insert.

Then choose layout menu>
layout Properties, and check

Facing Pages, Instantly, you

have facing pages spreads with

identical margins, left and right!

'When
priming, dick rheSpreod,oprion in

Print>L"YQ<ltrobroprimbothpoge<toonl'
iorg~,hHr



.. e 8 INDICATING FOLD LINES FORTHE PRINTER

I
I
I
I

=f
l I ::~:. Cyan

I . Magenta
. . Re

.

9
.

istration
1.0 White

0 Yello~

For any folds within a Quark page, you need small

lines to indicate folds to the printer. When folds

are vertical, use vertical ruler guides to mark
them. Later,draw right on the guide a vertical

.~ # 1 8 #2 Q" ~~:h~t~~e~~~~~:~:f ~~~~:~:~o~i~~~:~~:gOe~ted

extending off the page about 2p (.33"). About
p9 ('~") stays on the page so that the line gets
imaged when output. But cover up the part that's
on the page with a small white-filled box, the

default fill color. The top of that box should be at

the top page edge. Now group the line and the

white patch (Cmd-G or Cui-G). In Step and
Repeat, set the Offsets to 0 and Repeat Count 1,

then click OK. Shift-drag the group across the
page, snapping the line to the next vertical guide. Duplicate the last line-patch group at the
top, using Cmd-D or Ctrl-D.Shift-drag it down to the bottom of the page so that the bottom
edge of the patch is on the bottom page edge. Without ungrouping. use the Content tool

and Shift-drag the line down so that it extends off the bottom edge about .33". Duplicate

the group again to set the remaining bottom fold-lines.

P.S.lfyou have color or an image bleeding to a fold line, extend the box so it snaps to the

vertical guide. And. be sure to discuss this with your printer as this is a challenging problem

for them to fold on that edge exactly!

16
Colon

~ [fj[]£:!Ii 0

I Solid
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. e @THE"THREE-FOLD"BROCHURE

Back Civer
............

~er
I

. Doal. :

i~i

:~
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Hey, it's not a Nthree-fold,Nit's a "two-
foldN-that #10 brochure that fits

into a business envelope. Three
panels on a side, two folds. Use a

standard page with Landscape
orientation, one column, 2p6 (.417")
margins left and right. No Facing

Pages or Auto Text Box. Using equal

panels is the dumbed-down version.

The foldover panel is narrower, so

the panel won't go crunch when

it's folded in. On
page one, the cover

isontheright,backpanel in the

middle and the short fold over panel

is on the left. Equal panels would be

3.667"wide.Take'Is"
from the short

and add
'/'0

to each of the other
panels. Draw a box for the short
panel, set W to 3.542" on the

Measurements palette and X to O.
Duplicate that selected box in Step

and Repeat with Offsets set to 0,

Repeat Count 1, click OK. Move that

box over with X at 3.542" (copy W

and paste into X).Then set Width to

3.729". Now duplicate that box for
the cover (Cmd-D or Ctrl-D). Copy W

and add it to X:3.542 + 3.729". Press

Return or Enter. Now three boxes are

on your page marking the two folds.
Drag out vertical ruler guides to

mark those exact positions (zoom
way in. if needed}. Then drag out

two more guides for each fold to set

the gutters, each lp6 (.25") from the

fold guide,3p (.5') apart. On page

two, the short panel is on the right!



8 6 @ ROLL-FOLD BROCHURE-MORE THAN THREE PANELS PER SIDE

~
A brochure with fourar more panels is dramatic and mysterious

because it keeps unfolding and uncovering more-a bit like toilet.

...
paper! If you followed the previous tip, this one just takes it farther.

But do the math first so you know the dimensions. Three panels

take 11".Nowadd on to that the fourth panel which is '/,6"less
than the short panel:3.542" - .0625" = 3.4795". For a fifth panel.
deduct another'/,/ from 3.4795", which is 3.417.With six panels,
the smallest inside panel is 3.3545". Now to get the page width,

add up 1l'
plus the widths of each additional panel beyond three. For four panels,the page

width is 14.4795"-Quarkcalls it 14.479".Forfive,it's 17.8965" or 17.896", And six,21.251".

Give your offset printer this weird-specification-it's okay,I'vedone it-but make sure their
presses can handle it. Keep the same gutters of 3p (.5") between panels.

. ~ @ ARTWORK SPANNING FRONT AND BACK COVERS

There are several ways to produce

a spread of covers with shared art

or type.
Here's an easy solution. Put

the cover and back cover spreads

at the end of your Quark layout.

Page one is your first numbered

page, not your cover. For offset

printing, your last numbered page

is even, such as page 12,and, with

the two cover spreads, that's a

16-page layout. In the Page Layout

palette, page 12 has no right
page,

but below it are the two cover spreads as facing pages 13-14 and 15-16. In the Page Layout

palette, page 6 has no right page,
but below it are the two covers as facing pages 7 and 8.

You can also make the covers an entirely separate file. Checking with your printer is always

good, though.
Don't

worry about artwork, headlines, or pictures that go across the spread.

Imposition software that turns your reader spreads into printer spreads is sophisticated

enough today to handle it. Use the Spreads option {Print box, Layout tab} to print your

covers to one large sheet.
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. 6 8 GATE-FOLD BROCHURE

Gatefolds are like grand-opening

performances. Capture attention on

those two facing foldover panels,

which open out to reveal center
stage, four panels total. Page size is

larger: lS.25"x8.5",The front and back

covers are the inside panels,3'1,"

wide. The two outside panels are

3%". Use landscape orientation with
left-right margins 2p3 (.375'),one
column, two pages. Start with a big

box from left to right trim edges. X is
0, W is 15.25" on the Measurements

palette. Divide the width in half-

15.2512.Press Return or Enter.W is

now 7.625". Drag out a ruler guide

to that location, watching the palette

as you go. Set W to the short panel

width 3.75". Put another guide there.

Now drag the left center handle
across and snap to the center guide.

This is the inside panel width, 3.875".
Change the box's X to 7.625", then
put the third guide at 11.5". As in the

above two tips, drag out two guides

for each fold to mark the gutters.

TM 'pen forrni'gorefoldcomefrom awonderfullycr...,rj~loolJrime, now-defuncr pliblicoliOflcolftodThePage,pubJj,h."jjr1
Chicagoandma,riywriller1byde,ignerextraordinoireDovidDory.
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fit e @ SHORT PANEL COVER OR REPlY-TEAR-QFF PANEL

Short-panel covers arouse interest-they Iookdifferent Takethe one picturedasan example.starting

with a portrait orientation file in Quark. To get the Height dimension, start Vlliththe folded size,say 55><85"
(based on a US. standard page). For the cover,subtract the amount you're lopping off from two times the

folded height,here ,"from the 5S'xl.Page heightforthis short-coverfile isthen 10".On page one, the

short45" rover panel is on the bottom,the 55" backcover panel at the top. Drag out a horizontal guide

to 55", checking its location in the Measurements palette.For page two, the il'\';ideview, the short panel

is atthetop.lf)UUrfini~ed piecewill bevertical,use landscapeorientation,Width lQ',Height8S'.0n
page one, the short

45'
cover panel is on the right and the wider 55" back cover is Of! the left

(Be
sure to

include fold lines.see"lndicating Fold Unes forthe Printer;"earlierin this chapterJ Ashort panelcan also

be used for a tear-off regirtration orcoupon panel inside. For a 3" tear-()/f panel on the inside of a portrait

85xl1' brochure (folded size),use 11.5" for the Width of your Quark file.11"Height.Position the tear-off
panel on the left for page one and for page two, the inside view. on the right Put a dotted line right on

the fold and consider having your printer add a perforation there.extra charge. (Again.be sure to include
fold lines.)
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8 6 8 GREAT-LOOKING PAGES WITH LOTS OF COLUMNS

Sometimes people think that grids are limiting. Hogwash! Grids don't make the layout

unless you just fill up every column with text. Much more is possible. Consider working with

four, five, or six columns on a standard page. With more than four columns, the body copy is

not confined to the single-column width, too small. Instead use text boxes the width of two

columns. With a five-column grid. you'l! have an extra column. Small pictures can go in that

single column or extend into the body area, occupying two or more column widths. With

this approach, you get a lot of contrast in size between small pictures in a single column

and large pictures going the full width, and all the widths in-between. This kind of layout is

more labor intensive, but you get lots of layout choices and a dynamic, exciting look.
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. e 8 THE FLUSH-BOTTOM LAYOUT

';;:-'60 "'l~ I:!ImElIi

~~if~]:::.::::~==.I-~::.:;::~~ ij:..-:;:.:.~;;:Z

'¥~~¥i! ~r~1~. i=~~~~~g~

Middle managers, no offense,

love this flush-bottom look,
especially when the body is

justified (across). I call it the

"blocky"look but there are many
standard formats that call for it,

such as newspapers. magazines.
books, and the like. Hey, you can't
fight city hall! One of the easiest

ways to get everything going

down to the bottom of the page

is to use the multi-column text
box, a text box that's subdivided

into columns. You can use the

Auto Text Box when you start a
newfile,oryou can draw your

own boxesand subdivide them
using the Measurements palette

or the Modify dialog. With one
big box on the page, your flush-

bottom is assured. Newspapers

use these types of boxes for each
story, instead of having to keep

multiple boxes of the story

together. Then the spacing

between stories, as well as the

size of the pictures, can be used

to achieve that trimmed-off

bottom look.
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8 e @ GETCONSISTENTVERTICAL SPACING BETWEEN ITEMS

-
IlItI!'r¥ieww1hRobert

- Lombardo
_..~--,1_-4~1
a_"--,-"",a.

Getting consistent vertical spaces between

items helps deliver your message without

-,
-

the distraction of varying white spaces. It's
easy to do with typesetting, using paragraph

spacing before and after, but how about

when it comes to items?The space between

a two-column headline and the two body-
COpytext boxes of that story is controlled by

the runaround ofthe headline box.The top
edges of the body-copy text boxes coincide

with the top edge of the headline box. In the
stacking order, the headline box is on top, so
its runaround determines the space to the
story below. Be sure the headline box is

trimmed up to the bottom of the highlighted
headline text and not a singlepixeldeeper.
But what about the space between the base-

line of the lowest line of that story (call it A)

and, below that, the top of the uppercase

letters of the headline farther down? First,

re-set the zero point to A.From the upper-left
comer of the document window, where the

rulers intersect. drag out a floating X-Vaxis
and, in the same action,align the horizontal

to A.Then select your headline box, and per-
haps also the body copy boxes for that story.
On the measurements palette,set Yto 2p

(33"), or whatever interval you want to use.

~ .~
~foII°X:~W:~ ~'r
=V:~H:~

L .--..-
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. e t) PUll-QUOTES ARE EYE CANDY

T'=';'::;
With lots of dreary text and no pictures to break up the
page, throw in a pull-quote.Feature an important statement

taken directly from the text on that page or spread.Draw

the reader in byenticing them with a stimulating thought,
creatively styled and as graphic as possible. Use a very bold

or decorative font that contrasts well with the body copy.

The point size can be larger-perhaps 14 to 18 pts,maybe

italic.Try exaggerated quote marks that stand out-hang

them outside the text box so that the left-aligned text

makes a nice vertical alignment.To dothis,add a word space

infrontofthe open quote mark,then kern back the space

between the quotes and the word space until you can't see
the quotes. But when you print, they're there.Kem with
Cmd-Qption-Shift-[ or Ctrl-Alt-Shift-{.Add paragraph Nles

for extra emphasis (Cmd-Shift-N Of Ctrl-Shift-N).

,

-= ~-~
-.n.t--rilla.
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. 6 6 NEWSLETTERS lOOK GREAT WITH VERTICAL RULES

Vertic.alrules,orlines,canmake

anattractiveandcrisp Iookfor

a newsletter or joumaL

But...production with ru\es is

more time<onsuming and

cletail-oriented You must be

dedicated! Rrst your gutter.;

srouldbe6lXJintswider,such

as lp6(.25'1.Drawrulesvvith

theOrthogonaI Unetooland.

on the Measurements palette,

seuheirWto25pt.not

'1-tairtine."Rulesareexactly

centeredtothegutterwidth

and are top and bottOlTl aligned to the type.using ruler guides.At the top,afign to the cap height ortop of

Ia.vercase letters.Atthe bottom,align by the baselneofthe longest line.But itgetslNOl'Se..lna~where
yoIivegotonestoryabc:Neanotheronthe ~one rulepergunerwon'tworkRules must5tartand stop,
repeatedly and as needed, to make W<fJfor multkolumn headlines that extend across the gutters.
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. e 8 JUMP lINES-AUTO-UPDATE CONTINUED ON AND FROM
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Very few magazines run a story continuously.

They throw a bunch of things at you up front

and let you go chasing the details as the

story jumps. Quark has a cool feature that

automatically updates .continued on" and

.continued from"
page numbers, when a

pagil'\ation change affectseitherthejump-

from or jump-to
page numbers. Create a

small text box the width of the body copy

and with no runaround. Type inside,

"(continued on page"then
type

Cmd-4

or Ctrl-4, followed by a close parenthesis.

Overlap the jump line slightly at the bottom

of the body<opy text box. The jump
line's

baseline should fall at the next body<opy

leading line, 50 first pull the body text 00)(

down a line, briefly,and mark it's baseline

with a ruler guide. Then close it back up and

line up the jump line to that line. If you've

already linked to another page, the code you

entered is replaced by the jump-to page

number. Do a similar number at the top for

the continued from
page,

with Cmd-2 or

Ctrl-2. The text
bo)(

must overlap the top of

the body text.



. 0 @ DECKS FDR MAGAZINES-GIVE THE READER A PEEK

Decks are introductory copy that visually steps down in size from the headline to the body

copy and gives the reader an inkling of what the story is about. In short, a kind of teaser.

Get
'em

interested. Typically the deck appears above the body copy,
several point sizes

larger and often in italic with generous leading. It can be in a contrasting font to the body

and set to a wider width. It should look distinct but not steal the show from the headline.

Consider it another design element on the page to work with for adding style and flair to

the layout. And of course, you'll want to turn your first deck into a style sheet so that you

have it for all the other stories. Then just click on the deck and click on the deck style name

and it's handled.--Republican.
Watch

:-':::::;"-=-===== =.:=.:::....

5~S ;;::'~M =---=""f
"'-""'"

------ _._M-----
"'-""-""-"""- -----, -------
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Watch
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. 0 8 BREAK UP A LARGE DOCUMENT INTO MULTIPLE FILES

There are two reasonsto breakup a document tnto
multiple files. One---you and others are doing team

production and, obviously, you can't all work on the
same file. Two-it's a long document, sayover24
pages, with pictures, and your Quark file is more likely

to crash and burn when it's large-not to mention
performance slows down. Break up the file where
there's some absolute page break, like the story ends
Chapter Of section breaks are naturals. But, as text is

~ edited, you don't want to be copying and pasting

UtileI(ooh"na...~.qxp same-story text from one file to another! Save your
file, then do a Save As and delete the second half.

Reopen the full version and resave after deleting the first half. Or be more systematic, set up a
template that has all the master pages set up, style sheets, standing items, and defaults in place.

Base your files on that.

See OIlso"Quark's Template Versus the Real thing" (Chapter 2).

---""jj stealr.lnll Up'r; Hiord To 00

'@)~~~fo,
ComF>Ut., Del... NewfoJ(le, 1>11<.>.11<

- J~.m..Jl-19(;'av.llabl.
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~
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8 0 @ IF YOU'RE DOING MULTIPLE FILES, YOU NEED THIS TIP

~ You'vebroken up your files, then ask,
"How do you get

'8~~1II the second file to start with the correct page number?"
Sections! Go to page one or the page that starts your

. new section. Click the Section Start button at the top of
the Page layout palette (or Page> Section). If your first
file is 24 pages, enterN25"here.ehoose a numbering
scheme in Format-iil. 3.m,e,or c-then click OK. Add a
Prefix, a four-letter maximum section indicator that
appears with auto-page numbering. Because you can

restart your page numbering to one, within a document,
you can use sections to combine the front and back

matter-a preface, table of contents or index-with the
body of your document by using i, ii, iii, then 1,2,3.

Don't forget to add auto-page numbers on
the master pages. Also, with multiple files for the same document, put the start page number
in each filename to help you locate your content.

See also"Automatic Page Numbers Instantly Aligned" (Chapter 21.
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. 6 8 GREATlAYOUTFOR TEXT-HEAVY DOCS

---
This easy layout is based on a three-column grid,

standard page, but only has a single one-column text

box per page. Start a layout, using three columns and

the Auto Text Box. Go to the master pages, select each

Auto Textbox, and set number of columns to 1 in the
Measurements palette. In this layout, the body copy's

left indent is equal to the width of the left column.

Easiestwayto figurethat is to draw a box the width of
the first column, but extend it right to cover the gutter.

Won the Measurements palette equals the left indent

for body copy. Major heads have no indent and start at

the left margin. Secondary heads, like subheads, have

the same indent as the body. Pictures can be a single
column, on the left, or extend into the body the width

of two or three columns, lots of choices. Use style

sheets to make this layout a breeze.

See a.l5o~Controiling the liIyout with Spedal CharadersN (Chapter 10).

8 6 6 PARAGRAPH RULES-CLARIFYING WHAT'S IMPORTANT

Using rules to emphasize headers and subheads is

a great way to go. Paragraph rules can be part of a
style, move with the text as it's edited and retain

a fixed position in relation to the paragraph. In the
layout described in the previous tip, you can use two

weights of paragraph rules to express the header

and subhead levels. For both, the paragraph rule

is set to Indents-go there with Cmd-Shin-N or

Ctrl-Shift-N (Style> Rules). Choose a rule Width for

the header that's heavy but doesn't drown your

text Try an offset in points equal to the point size
(disregard the % symbol, but enter using the form;

"lSptHor"p1S"). For the subhead that falls in the
body copy width, set its Length to Indents. Choose

a much lighter contrasting weight so its lower hierar-

chical level is apparent.
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. e 0 ANCHORED HEADLINES STAY WITH BODY

Thistip goes a step farther than the one two tips up-that layout with one big text box per
page and an indented body. But those major headers that start at the left margin? Instead

of letting them run on into the two right columns, wrap each in its own text box, the width

of the single column, alongside the body. But when the body copy is edited, don't be
chasing after those header boxes to realign them. Instead make anchored text boxes,
so the header box travelswith the body!The firstparagraph of body copy after the header
has a Hanging Indent style. Make the first line indent equal to the left indent and make it
negative, -15p4 (-2.556"). Draw the header text box across the first column. Select it with

the Item tool, and cut. With the (ontent tool, click before the first character on the first body
copy line, then paste. Press Tab to push the first word of the body over to properly align.

Then dick on the anchored text box and, from the Measurements palette, far left, dick the
top button (Align by Ascent, not Baseline). When text is added or deleted above, the

anchored text box travels with the body!
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fit e @ TABLE OF CONTENTS USING LISTS

Use lists to make a dynamic table of contents (TOC), based on your style sheets. Set up and
apply styles for the heading levels you want to include, such as Headline and Subhead. In

Edit> Lists, click New, name your list, then select the style names you want, clicking the right

arrow. Set formatting options from the header popups. Use the Numbering
popup

to set

the location of the page number, before or after the listing. Text Only is good for headings.

OK, Save. Open the lists palette, Option-Fl 1 or Ctrl-Fl1. The lists palette previews the

paragraphs in your TOC. Use the palette to navigate your document by double-clicking

on a paragraph to go there. To make a TOC, select an empty text box, then click Build in

the palette. Style the TOC, then make Toe style sheets to match each level. Edit your list

by applying these styles in the Format As
popup

so your TOe updates retain the current

formatting. For changes, click Upaate in the palette, then Build again, after selecting the

same or a new text box.
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. e 8 °ID-UP"LAYOUT

Because business cards are quite small, art work is usually produced in multiples-though

check with your printer first. Get the card completely designed, then duplicate it out to ten
on a standard page. Select all the items for one card, including the

3.5' x
2"

rectangular box

that frames it but has no frame Width. Group them (Cmd-G or Ctrl-G), and go to Step and

Repeat (Cmd-Option-D or Ctrl-Alt-D}.Use Repeat Count 1 with Horizontal Offset set to 3.5",

Vertical Offset set to O. Click OK. Now you have two cards, buned side by side. Select the

two, and return to Step and Repeat. Repeat Count is 4, Horizontal Offset is 0, Vertical Offset

is 2", Click OK and now you have all ten cards butted together on one sheet so that when

they cut the sheet into cards, there's only nine cuts per ten cards.Jfthe card is vertical,

rotate it 90. after grouping, then follow the above steps. See next tip for crucial second step.

,.---------------..: I
'

:!
'

:
1 !!iull!!l. t !!bll!HI.t

r
--Jiml :-1-

'1

--- --r:J J
:

--

~i
'

-

I

- r

i :HlhU. : :1;jh~1Q ;
~--:

" '!II "'!: II I : I } :
! i{j'I!1j'!1 :- ,iLI!! j

,j

!1
!

: ,l;hi{ ij. I dohir Q :
~- - -J--- -+-- --- - --~ - -~- --- --- - ~
: f

'
: f

'
:

I ,II o,!
H

II 1'1
11

I
: ~H1hijH. !HihiJr Q
~---J

,

i t. ,J
~

{,
, jd .I. jl ',IJ II!!!

IL!mmL ,1./:..11 CI>

~ 226 CHAPTER 13'
Way Cool Design Tips



. e 8 CROP MARKS FOR BUSINESS CARD ART

Add crop marks tayour lo-up card layout (see above rip) to indicate the trim size of each card,

so the sheet can be cut once the job is printed. About
'/S

inch to the outside of the top-left

card, drag out a short horizontal line with the Orthogonal Line tool. In the Measurements
palette, enter .25pt for W.lf your job is two or more colors, apply Registration color to the line

so it outputs to all color films. Select the top box, and copy its Y from the palene. Reselect the
line and paste that number into Y.Make sure the Line Modes popup

isn't set for Endpoints.

Duplicate the line using Step and Repeat (Cmd-option-D or Ctrl-Alt-D). Use Repeat Count 1

with both Offsets set to O. Click OK. Now Shift-drag the line across the top right card, about

'/"
inch to the outside. (Mouse down, add Shift. then drag.) Now select the two lines, click, then

Shift-click. In Step and Repeat, use Repeat Count 5, Horizontal Offset 0 and Vertical 2". Click OK.
You also need three sets of vertical crop marks top and bottom to mark the center line and

outside edges. Use the left box's X for positioning the first one. Offset is 3.5".

J

IJhdlJ II.

t,
1
"

111hd111.

1111111111.

i,
1'

1
11I!!!!II.

IfiHIIIII.

t,

J

'

~
! t.IU,flhu .

Ih.luhdlh.iJ~.
t,

J

'

~
11:'111;~Il.u .
i, j

~

I : Iii I
!haJ',
L

I~
!

'It
U!Jolla.

r4CHAPTER 13'
Way Cool Design Tips 227



I.,.,.D..E.~...

SYMBOLS ",.............

1o-up layout, business
cards, 226

A,......................

accessing
Item tool, 13, 39
tools

fly-out tools, 40
without toolbox, 40

adding

color
to tables, 175
to type and paragraph

rules automatically, 186
master pages, 27
pages, 91
type to pictures, 79

adjusting type vertically with

baseline shift, 117

alerts for picture changes, 86

aligning
by X and Y, 65
items from their centers, 164
numbers when some are in

parentheses, 132
page numbers, master

pages, 22
rules to other items

(Orthogonal Line 1001), 65

spread guides, 164

text
with Baseline Grid, 160

with subheads, 159

Att key, 13

anchored headlines in long
documents, 224

anchoring picture boxes in
text, 169
angled type, 119

228

angles. reslzlng lines, 48

Application preferences, 4

Auto Backup, 6
Auto Save, 6

live Scroll, 4

application settings, 2-7
applying

styles, 143
type styles, 113

arranging pages, 163.168

arrow keys, moving insertion
polnt,96

art, crop marks tor business

card art,227

assembly, 200-207

Auto Backup, 6

Auto Save, 6

Auto Text Box, 20

automatic ligatures with
Character Preferences, 125

automatic page numbers,

master pages, 22

automating hyphenation with
styles, 137

Auxiliary Dictionary, 98

avoiding

bad resolution, 79

long font lists, t10

B

background colors, picture
boxes, 95

backgrounds, box backgrounds

blends, 188
tinting, 183

backing up

files, Auto Backup, 6

preterencesfile, 5

based-on styles, 145

Baseline Grid, aligning text, 160

baseline shift, adjusting type
vertically, 117

Bezier Drawing tools, 54-57
drawing shortcuts, 54
editing shorfcuts, 55

editing points, 56
flipping images, 55

heart-shaped or scalloped
curves, drawing, 54

Merge commands, 57

moving shapes, 56

bitmap images, 78

bitmaps versus vectors, 78-79

black, rich black, 185

black-and-white printers, 196

bleeds, 163
checking, 195

blends, 181, 188

box backgrounds, 188
putting into lines, 188

box backgrounds
blends, 188
tinting, t83

boxes, 51-53

circles, 52

colored boxes, text insets, t 68
colors, 52
drawing more than one, 51

identical boxes that per1ectly fit

a given space, 166

matching line lengths to box

widths, 49

of text, linking, 90

picture boxes, anchoring text

In,169
placing text lower in the

box, 166
reshaping, 53

shaped boxes, wrapping

texi. t23
shapes, 53

sizing with contents
proportionally, 66



skewing pictures within, 83
squares, 52

transforming, 68

breaking up long documenb

Into muttiple files, 222

brochures, 216-215

fOld lines, 211
gate-fold brochures, 214
margins, 210

reply-tear-off panels, 215
roIj.b!d brochures, 213

short panel covers, 215
three-fold brochures, 212

budgets, spot colors, 184

bUllets,105

burled items, selecting, 60

business cards, 226-227
1O-Up layout, 226
crop marks for art, 227

master items, 25
master pages, 25
print layout settings, 21

stacking order, 61
styles, 144

with FindlChange, 104
weignts of lines, 49

character attributes, 110-117

Character Preferences,

automattc ligatures, 125

character stytes, 142

characters
removing strange characters

from text, 1 02
special cnaracters, searcning

for, 106

charts, paragraph rules, 133,
checking

bIeecIs,195
what you did by deselecting

,...~ text, 93
checklists, preflight, 204-207
circles, 52
cleaning up text. 5H also
searching

removing strange

characters, 102
replacing underlines with

italic,100
searching for double

spaces, 100

that was pasted into an
email,101

clipping paths. 83-84
Cmd key, 13

CMS (Color Management
System), 190

CMYK, spot colors, 184

EPS graphics, 189

Collactfor Output, 200

calculating wtth Measurements
palette, 64

capitalization
drop caps, 120-121
small caps, 118

Capture SetUng.. 194

Center Ptcture command, T7

centering
page numbers, master

pages, 22
pictures, 77

centers, aligning Items
from,164

changes to pictures, atem

for,86

changing

colors, 187
columns, 21

to different pages, 37
margins, 21

color breaks, printing
separations., 191

color conversion, 75

color management, 190

Color Management System
(CMS),190

colors
adding to tables, 175
applying to type and paragraph

rules automatically, 186-187
background colors, picture

boxes, 95
black, rich black, 185
blends, 181, 188

putting into lines, 188

boxes, 52
Changingcolors you've already

applied, 187
Colors palette. 182
deteting, 9
dragging and dropping, 186
duotones, faux duotones,

81-82
managing, 189-191
mixing spot colors, 183
modifying, 186-187
Multi-Ink option, 184

Pantane. 182
PMScoIor,l89
printingseparations to check

color breaks, 191
Registration color, 187
setup, 182.185
spot colors, 197

budgets, 184

EPSgraphics. 189
mbdng, 183

spol varnish, 185

testing, 186
lints, 183
trapping, 199
type, Text to Box, 121

Colors patette, 182

229



columns, 18
changing, 21

inserting into tables with
existing formatting, 172

in newsletters and
magazines, 216

Combine, 57

combining text and pictures in
tables, 173

combo shortcuts, 13

commands
Center Picture, 77
Fit Box To Picture, 77
image editing commands,

accessing (Mac only), 80
Merge, 57

Redo, 38, 102

Select All, 93
Undo, 38, 102

communicating with printers
through layers, 202

comparing style sheets, 146

composite proofs, printing, 196

constraining moves without
deselecting, 62

Content tool, 39
deleting items, 70

context menu, 12

Continuous Apply, 135

controlling layout with special
characters, 159

correcting mistakes, Undo, 102

crop marks for art, business
cards, 227

cropping pictures, 76

Ctrl key, 13

curves, drawing heart-shaped

or scalloped curves, 54

230

D

dashes, 127
hyphens, 136

automating with Styles, 137
discretionary hyphens, 138
exceptions to, 139

No Hyphens, 135

Dashes & Stripes, 50-51

decks in magazines, 221

default line styles, setting, 50

Default Print Layout prefer-
ences, changing to picas, 9

default type specifications,

editing, 110

defaults, global word
spacing, 131

Delete Changes, 25

deleting, 70-71
colors, 9
guides, 43

items, 71

for faster output, 202
with Content tool, 70

locked ilems, 70
spot colors, 197
text, shortcuts for, 96

deselecting
items, all items, 60
text, 93

design tips

for brochures
fold lines, 211
gate-fold brochures, 214
margins, 210

reply-tear-off panels, 215
roll-fold brochures, 213
short panel covers, 215
three-fold brochures, 212

for business cards
10-up layout, 226
crop marks for art, 227

for manuals and long
documents

anchored headlines, 224
breaking up into multiple

files, 222
layout for text-heavy

documents, 223
paragraph rules, 223

table of contents using
lists, 225

for newsletters and magazines
columns, 216
decks, 221

flush-bottom layout, 217
jump lines, 220

pull-quotes, 219

vertical rules, 219
vertical spacing, 218

Designer Frames, 51

dialog boxes, indenting, 134

discretionary hyphens, 138

Document preferences. See

Print Layout preferences

documents

anchored headlines, 224
breaking up long documents

into multiple files, 222
layout for text-heavy

documents, 223
paragraph rules, 223

table 01 contents using
lists,225

Doly, David, 214

double spaces, searching
for, 100

Drag and Drop Ten, 95

dragging and dropping

color, 186

pictures from your desktop
(Windows only), 74



drawing

Bezier Drawing tools,
shortcuts, 54

boxes, multiple boxes, 51

heart-shaped or scalloped
curves, 54

straight lines, 48

drop caps, 120-121

duotones, faux duotones, 81-82

duplicate master pages, 26

duplicating Items, 165

E

editing

default type specifications, 110
points, Bezier Drawing

tools, 56
shortcuts, Bezier Drawing

tools, 55

text
by dragging and

dropping, 95
moving insertion point

with a"ow
keys, 96

over pictures, 95
spell checking from the

keyboard, 99

editorial style tags, searching
for and replacing with style
sheetS,103

Em dashes, 127

emalls, cleaning up text that
was pasted into emaits, 101

En dashes, 127

Endcap styles, 50

Environment dialog, 7

EPS graphics, 189

Exclusive Or, 57

exporting files, 75

extensions
to filenames for Windows

clients, 203
.s$v, 6

eye candy, pull-quotes, 219

F

faking right-aligned tabs, 134

faux duotones, 81.82

filenames, extensions for
Windows clients, 203

file sizes of pictures,
managing,

86

files
exporting, 75

preferences file, backing up, 5

file setup, 16-20

Find/Change. See also
searching

bullets, creafing, 105
changing styles, 104

correcting mistakes. 102
searching

for numbered lists, 107
for special characters, 106
text on master pages, 106

Fit Box To Picture, T7

Fit In Windows, 35
Greeking,8

Fit Picture To Box, 76

fi"lng,
pictures to boxes, 76

text to layouts, 158

fixing

mistakes, Undo, 102
short lines with tracking, 115

flipping images with Bezler

Drawing tools, 55

flush.bo"om layout in

newsle"ers and magazines, 217

fly-out tools, accessing, 40

fold lines for brochures, 211
gate.fold brochures, 214
roll.fold brochures, 213
three.fofd brochures, 212

folioing, 222

Font Usage, 201

fonts. See also type

avoiding long lists of fonts, 110

default type specifications,

editing, 110

Font Usage, 201
point size, 111

true fonts, 111
for styles, 145

type styles, applying, 113

foot marks, 97

forma"ing text
as it's importing, 147

as you type, 148
of entire tables, 172

FPO (For Position Only), 202

fractions, type, 125

full resolution preview, 85

fun-house mirrors, 80

Funk, Clint, 166

~..........

gate-fold brochures, 214

generating reports, 201

Get Picture dialog, 75

get text with styles, 147-148

global word spacing, 131

Grabber Hand, scrolling, 35

gradients, type, 122

graphic effects, 80-83

graphics. See also pictures

creating from boring
pictures, 82

EPS graphics, 189
skewing within a box, 83

231



Greek Text Below option, 8

grid less tables, 174

grids, 18
grouping Items, 62

sizing, 63

groups, scaling, 199

grunge type, 123

Guide Manager, 45

guides, 41-45
deleting, 43

Guide Manager, 45
hiding, 41
limiting, 44

master pages, 42
positioning numerically, 43

Snap-to-Guides, 42

gutters,20

H..., ,.", ""

hanging indents, 133

hanging punctuation, 119

headlines
anchored headlines in long

documents, 224
tracking, 149

heart-shaped curves,
drawing, 54

hidden commands, 61

hiding
guides, 41
pictures, 178

high-resolution output
PDF, 198
recomposing type, 197

highlighting text, 93-94

hyphens, 127, 135-139

automating with Styles, 137
discretionary hyphens, 138
exceptions to, 139

No Hyphens, 135

232

I"............................

image editing commands,
accessing (Mac only), 80

image effects, 80-83

images. See also pictures

Importing PDFs, 75

importing pictures, 74-75

Importing text, 90-92

Inch marks, 97

Include Style Sheets, 147

Indenting

with dialog boxes, 134
paragraphs, 153

stytes, 149

indents
hanging indents, 133
specifying in points, 130

inserting rows and columns

with existing formatting into
tables, 172

insertion points, moving with
arrow keys, 96

insets, text insets, 168

italic, replacing underlines, 100

Item tool
accessing, 13, 39
getting pictures, 38

Items
aligning from their centers, 164
deleting, 71

with Content tool, 70
deselecting all items, 60
duplicating, 165
grouping, 62
locating from the bottom of the

page, 66
locked items, deleting, 70
master items

changing, 25

locking, 24
moving

in groups, 63
one point in any

direction. 61
rotating, 69

selecling

buried items, 60
on layers, 176

sizing in groups, 63
ungrouping,62

J

Job assembly, 200-207

Job descriptions, 206
jump lines in newsletters and
magazines, 220

K

Keep Changes, 25

Keep Project Settings, 162

kerning, 114

KerningTable Edit, 116

manual kerning, removing, 116
pair kerning editor, 116

Kerning Table Edit, 116

keyboard shortcuts

Alt, 13

Gmd,13

combo shortcuts, 13
Glrl,13
deleting text, 96

Item tool, 13
Option key, 13
Shift,13

Zoom tool, 33
zooming, 33

keyboards, spell checking

text, 99

l

launching Quark, 14

XTensions,15

layer markers, turning off, 176



Layer paleue, 175

layers,175-179
communicating with

printers, 202
printing, 179

selecting items, 176

versions,177

layout
aligning

items from their
centers, 164

text with Baseline Grid, 160
Auto Text Box, 20
bleeds, 163
changing print layout

settings, 21

colored boxes, text insets, 168
columns, 18
controlling with special

characters, 159
different versions and page

sizes, 156

documents, text-heavy
documents, 223

duplicating items, 165
fitting text to, 158

flush-bottom layout, 217
gutters, 20

identical boxes that penectly fit
a given space, 166

margins, 19
naming, 156

positioning pictures, 167
removing pages, 162
synchronizing text, 157

tables. See tables
text

move down the box, 166
vertically justifying, 161

layout and pagination. 156-163

layout pages, moving to master
pages, 37

Layout Properties dialog
box,21

leading, 129

libraries, 29

ligatures, automatic ligatures

with Character Preferences, 125

limiting guides, 44

lines, 48-50

default line styles, setting, 50
Designer Frames, 51
Endcap styles, 50
matching lengths to box

widths, 49
putting blends into, 188

resizing at same angles, 48
straightiines,48
weights, changing, 49

lines of text, selecting, 94

lining up tabs, 132

Link tool, 90

linking, 20

boxes of text, 90
text, 90-92

lists, font lists (avoiding long

font lists), 110

Live Scroll, 4, 36

locating Items from the boUom

of the page, 66

Lock to Baseline Grid, 160

locked Items, deleting, 70

locking master Items, 24

M

Mac users
accessing image editing

commands, 80

automatic ligatures with
Character Preferences, 125

ZapfDingbats, 97

Zoom tool shortcut, 33

magazines

columns, 216
deckS,221

flush-bottom layout, 217
jump lines, 220

pull-quotes, 219

vertical rules, 219
vertical spacing, 218

Maintain Geometry, 173

managing

color, 190
pictures, 85-87

manual kerning, removing, 116

manuals, 222-225

anchored headlines, 224
breaking up into multiple

files, 222
layout for text-heavy

documents, 223
paragraph rules, 223

table of contents using
lists, 225

margins, 19

for brochures, 210
changing, 21

master items, changing, 25

master pages, 20..27

adding pages, 27
changing, 25
changing master items, 25

duplicate master pages, 26
guides, 42
locking master items, 24
moving 10 layout pages, 37
multiple master pages, 26
naming, 26
page numbers, automatic page

numbers, 22
picture boxes, 24
running headers and

footers, 23
searching text, 106

text boxes, 23

matching Une lengths to box
widths, 49

measurements, positioning
guides numerically, 43

233



Measurements palette, 64
aligning by X and Y, 65
calculating moving and

sizing, 64

line weights, changing, 49

menus
context menu, 12
Undo History, 38

Merge commands, 57

merging shapes, 57

minus leading, 123

mistakes, Undo command, 102

mixing spot colors, 183

Modify box, Text tab, 166

modifying. See changing

moving

between layout pages and
master pages, 37

calculating with

Measurements palette, 64
insertion point with arrow

keys, 96
items, 61-63
shapes, Bezier Drawing

tools, 56

movIng and stacking, 61-69

Multi-Ink option, 184

N

naming
layouts, 156

master pages, 26

negative images, pairing with
positive images, 81

newsletters, 216-221
columns, 216

flush-bottom layout, 217
jump lines, 220
pull-quotes, 219

vertical rules, 219
vertical spacing, 218

Next Style, 148

234

No Hyphens setting, 135

non-breaking spaces, 128

nudging Items one point in any
direction, 61

numbered lists, searching
for, 107

numbers, aligning when some

are In parentheses, 132

0

objects, scaling groups, 199

on-the-fiy color conversion, 75

on-tha-fly full-fesolution
preview, 85

opening

Preferences dialog, 4
Tools preferences, 10

Option key, 13

orphans, 151

Orthogonal Line tool, 48, 65

output, speeding up, 202

Page Layout palette, 25

page numbers
adding to multiple

documents, 222
master pages, centering, 22

pages, 36-37
adding, 91
changing pages, 37
layout pages, moving to

master pages, 37
master pages, moving to

layout pages, 37
moving between layout pages

and master pages, 37
rearranging in Thumbnails

view, 161
removing, 162
seeing both pages in

spreads, 36

pagination and layout, 156-163

pair kerning editor, 116

pairing positive and negative

Images,81

palettes

Colors palette, 182
Layer palette, 175

Measurements, 64
Measurements palette

aligning by X and
y,

65
calculating moving and

sizing, 64
Page layout palette, 25

panel covers for brochures, 215

Pantone process colors, 182

Pantone spot colors, 182

paragraph attributes, 129-131

paragraph rules
adding color, 186
charts, 133

in long documents, 223

paragraph spacing, 130

paragraphs

indents, 153
rules, 151
selecting, 94
spacing, 150

subheads, 152

parentheses, alignIng

numbers, 132

paths
clipping paths, 83-84
type, 122

PDFs
creating in Windows, 198
importing, 75
printing, 198

performance, hiding
pictures, 178

plcas,9

Picture Box tool, 11



picture boxes

anchoring in text, 169

master pages, 24

Picture Usage, 201

pictures. See also graphics

alerts for changes to, 86
as fun-house mirrors, 80
centering, 77
clipping paths, 83-84
color conversion, 75
combining with text in

tables, 173
cropping, 76
dragging and dropping

from your desktop
(Windows only), 74

duotones, faux duotones,

81-82
editing text over, 95

file size, managing, 86
fitting to box, 76
flipping with Bezier Drawing

tools, 55
getting with Item tool, 38

hiding, 178
pairing positive and negative

images, 81

PDFs, importing, 75
positioning, 167

resolution, 78
avoiding bad resolution, 79

full-resolution preview, 8S
scanning, 79
sizing, 77-78

incrementally, 67
skewing within a box, 83
turning into graphics, 82
type, 79, 169-171

updating, 87

placing

favorite settings in every
file, 10

text in tables, 171

PMS color, 189

point size, 9

of fonts, 111

points
editing with Bezier Drawing

tools, 56
paragraph spacing and

indents, 130

positioning
guides, numerically, 43
pictures, 167

positive images, pairing with
negative Images, 81

Posterlze button, 82

PPD Manager, 14

PPDs (Postscript Printer
Description Illes), 14

preferences
Application preferences. See

Application preferences

Default Print layout prefer-
ences, changing to picas, 9

Print Layout preferences. See
Print Layout preferences

Tools preferences, 10-11

Preferences dialog, opening, 4

preferences file, backing up,S

preflight, checklists, 204-207

preventing
copy from wandering when

linking text, 92
type Irom recomposing at

high-resolution output, 197

prices, type, 125

Print box, 7
shortening time in, 14

printing and exporting, 194-199

Print Layout preferences, 8
colors, deleting, 9

Greek Text Below option, 8
placing favorite settings in

every file, 10

print layout settings, 8-9
changing, 21

Print Styles, 194

printers

black-and-white printers, 196
communicating through

layers, 202

printing

black-and-white printers, 196
Capture Settings, 194
checking bleeds, 195

Collect for Output, 200
composite proofs, 196
fonts, 201
layers, 179

PDFs, 198
preventing type from

recomposing at high-

resolution output, 197
Print Styles, 194
registration marks, 195
Save Page as EPS, 199
separations to check color

breaks, 191
speeding up, 200
spot colors, 197
spreads, 196
Tiling, 194
trapping, 199-200

proofing text, 98

pull-quotes in newsletters and
magazines, 219

punctuation, hanging
punctuation, 119

Q

Quark, launching, 14

XTensions,15

Quark CMS (Color Management
System),190

Quark XTenslons, 12~1S
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R

rag-bottom. 23

rearranging pages In
Thumbnails view. 161

recomposing text

when opening older Quark
documents. 163

when opening someone else's
file,162

Redo commands, 38, 102

Reglstr8tlon color, 187

registration marb,
printing, 195

removing
kerning, manual kerning, 116
pages, 162

PPDs,14
strange characters. 102
styles from style sheets, 148

replacing underJlnes with
1ta11c,100

repfy-tear-off panels for
brochures, 215

Report Only, 201

reports, generating, 201
repurposlng,156

reshaping boxes, 53

reslzlng lines at same
angles, 48

resolution, 78
avoiding bad resolution, 79

full-resolution preview, 85

reverse type, 117

roll-fold brochures, 213

rotating Items, 69

rows, inserting into tables with

existing formanlng, 172

rules

Orthogonal line 1001, aligning

to top of other items, 65
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paragraph rules in long
documents, 223

paragraphs, 151
vertical rules, 219

runarounds, 11

masler pages, 24

running footers, 23

running headers, 23

,',

" ~, " "
,...

Save Page as EPS, 199

saving Auto Save. 6

scaling groups, 199

scalloped curves, drawing, 54

scanning Images, 79

scroUbars, Live Scroll, 4

scrolling, 35-36
Grabber Hand, 35
Live Scroll, 36

Scrolling slider, 4

searching. 102-107. SH slso
cleaning UPj Find/Change

lor double spaces, 100
for editorial style tags and

replacing with style

sheets,1oo
text, 99

for numbered lis's, 107
forspecial Characters, 106
on master pages, 106

see-through tables, 174

Select All command, 93

selecting, 60. See also

deselecting

Items
buried items, 60
on layers, 176

Unes of text, 94
paragraphs, 94
text, 94

words, 94

separations, printing

color breaks to check
separations, 191

shadow text, 124

shaped boxes, wrapping

text, 123

shapes, 53
merging, 57
movingwithBezjer Drawing

tools, 56
shaping boxes. 53

ShHt, 13

Shtft key, constraining ttems, 62

shortcuts
AIt,13

Cmd,13

combo shortcuts, 13
Cttt,13
deleting text, 96
drawing, Bezler Drawing

tools, 54
editing, Bezier Drawing

tools, 55
Item toot, 13
Option key, 13
Shift,13
Zoom tool, 33
Zooming, 33

shortenIng lime in Print box, 14

size of picture., managing file
sl%e,86

sIzing

boxes with contents
Proportionally,56

calculatingwithMeasurements
palette. 64

items in groups. 63
pictures, 76-78

incrementally, 67
type,111-112

incrementally. 67

skewing pictures within a
box, 83



amall caps, 118

Smart Quotes Interactive
preference, 97

Snap-to-Guldes,42

80ft retums, 126

spaces, non-breaklng

spaces, 128

spacing

delaun global word
spacing, 131

paragraphs, 130, 150

vertical spacing, 218

special characters

controlling layout, 159
searching for, 106

apeclal retums, dashes, and

word spaces. 126-128

Speed Scroll, 4

speeding up

output. 202
printing, trapping, 200

spell checking, Auxiliary

Dictionary, 98

spot colors

budgets, 184
deleting, 197

EPS graphics. 189
mixing, 183
printing, 197

spot varnish, 185

spreads
guides, alignments, 164
printing, 196

seeing both pages, 36

squares, 52

stacking order, changing, 61
Step and Repeat. 62, 165

straight linea, 48

strange type ellecta, 124

atyte sheets., 142. See ./so

styles
basics, 142-146

character styles, 142
comparing, 146

formatting text as it's
importing, 147

including, 147

Next Style, 148
removing styles, 148
replacing editorial style

tags, 103

styles. See .Iso style sheets
applying. 143

basecl-on styles, 145
changing, 144

with Find/Change, 104
headlines, tracking, 149
indenting, 149

orphans, 151
paragraph rules, 151-153

paragraphs

indenting, 153
spaCing, 150

removing from style

sheets, 148
subheads, 152
tabs,15O

lruefonts, 145
type styles, applying, 113
widows, 151

workflow for, 145

subheads
aligning text, 159
paragraph rule style, 152

Subscript, 114

Super Step and Repeat, 165

Superior, 114

SUperscript, 114

synchronizing text, 157

."
" ! ".......table of contents, using

Ils18,225

labkta,171-175
adding c%r, 175

combining text and
pictures, 173

formatting text in an entire
table, 172

gridless tables, 174

inserting rows and columns

with existing formatting, 172

placing text in, 171

see.through tables, 174

tips for, 174

labs, 131-135, 150

faking righi-aligned tabs, 134

lining up,
132

setting, 131

templatea, 28-29

testing colors, 186

text. See also type

aligning

with Baseline Grid, 160

withsubheacls, 159

anchoring picture

boxes
in, 169

cleaning up, 99-102
removing strange

characters, 102
replaCing underlines with

italic,100
searching for double

spaces, 100

text that was pasted into
an emaif, 101

combining with pictures in

tables, 173
deleting shortcuts for, 96

deselecting, 93

double spaces, searching
b,100
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editing, 94-99
by dragging and

dropping, 95

moving inserfjon point w#h

alTOW keys, 96

over pictures, 95

spell checking from the

keyboard, 99

Iitting to layouts, 158

lormatting
as it's

importing, 147

as you type, 148

entire tables,
'72

highlighting, 93

inch and foot marks,
typing,

97

insets,168
justifying vertically, 161

linking, 90-92

adding pages, 91

preventing copy from

wandering, 92

linking boxes, 90

plaCing in tables, 171

plaCing lower in a box, 166

proofing, 98

recomposing

when opening older Quark

documents. 163

when opening someone

else's file, 162

searching, 99

for numbered lists, 107

for special characters, 106

on master pages, 106

selecting, 94

shadow text, 124

spell checking

Auxiliary Dictionary, 98

from the keyboard, 99

synChronizing, 157

turning into picture boxes

shaped like letters, 171

unlinking, 92

wrapping
a/l the way around,

'68
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around i"Bgular

objects. 170

in shaped boxes, 123

Zapf Dingbats, 97

text boxes
master pages, 23
typing in angles, 119
versions, 179

Text tab, Modify box, 166

Text to Box, 121

ThePage, 214

three-fold brochures, 212

Thumbnails view, rearranging
pages, 161

Tillng,194

tinting box backgrounds, 183

tints, 183

toggling between views, 34

Tool preferences,10-11
opening, 10

runarounds,11

tools, 3841

accessing without toolbox, 40

Bezier Drawingtools. See
Bezier Drawing tools

Content, 39
deleting items, 70

fly-out tools, accessing, 40
lIem, 13

getting pictures, 38

Item tool, accessing, 39
keeping tools, 41

Unk,90

Ortl'lOgOnal Une, 48, 65
Pict\Jre Box tool, 11
Zoom, 32

keyboard shortcuts, 33

tracking, 114, 149

to fix short lines, 115
Tracking Edit, 115
type for open spaces, 118

Tracking Edit, 115

transforming boxes, 68

trapping, 199-200

troubleshooting style
sheets, 143

hue fonts, 111
styles, 145

turning text Into picture boxes
shaped like leUers, 171

turning off layer markers, 176

turning on registration

marks, 195

type. SH 81so fonts; text

adding to pictures, 79
adjuSting vertically with

baseline shift, 117
aligning numbers when some

are in parentheses, 132
changing angle oltexl. 119

charts, paragraph rules, 133

with colors, Text to Box, 121
Cootinuous Apply. 135
dashes, 127

hyphens.
'36

No Hyphens. J35

delaun global word
spaCing, 131

drop caps, 120-121
Em dashes, 127

En dashes, 127
fractions, 125
gradients, 122
grunge type, 123
hanging punctuation, 119
hyphens, 127, 136

discreOOnary hyphens, 138
exceptions to, 139

No Hyphens, 135

indents
creating with dialog

boxes, 134
hanging indents, 133
specifying in points, 130



kerning, 114

air kerning editor, 116
Kerning Table Edit, 116

leading, 129

non-breaking spaces, 128
paragraph spacing, 130

paths, 122

pictures, 169-171
preventing from recomposing

at high-resolution output, 197
prices, 125

reverse type, 117
shadow text, 124
sizing, 111-112

incrementally, 67

small caps, 118
soft returns, 126
spaces, 128
spacing, paragraph

spacing, 130

strange type effects, 124
Subscript, 114
Superior, 114
Superscript, 114

tabs
faking right-aligned

tabs, 134
lining up, 132
setting, 131

tracking, 114

for open spaces, 118
Tracking Edit, 115

vertically overlapping type, 123
wrapping text inside shaped

boxes, 123

type effects, 117-123

type masks Image, 171
type rules, adding color, 186

type styles, applying, 113

typesetting, automating,

149-151
typing Inch and loot marks, 97

U

",'n""""""""""''''''''underlines, replacing with
italic, 100

Undo commands, 38, 102

Undo History popup menu, 38

ungrouping Items, 62

Union, 57

unlinking text, 91-92

updating pictures, 87

varnish, spot varnish, 185

vectors, 78

versions
layers, 177

text boxes, 179

vertical rules In newsletters

and magazines, 219

vertical spacing In newsletters
and magazines, 218

vertically justifying text, 161

vertically adjusting type with

baseline shift, 117

vertically overlapping type, 123

view percent field, zooming, 32

view thresholds, limiting
guides, 44

views, toggling between 100%
and 200%, 34

Visual Indicators, 176

visually sizing type, 112

W

weight 01 lines, changing, 49

white space, 19

widows, 151

widths 01 lines, changing, 49

Windows

extensions to filenames, 203
PDF, 198

pictures, dragging and drop-
ping from your desktop, 74

word spacing, delault global
word spacing, 131

words, selecting, 94

workflow lor styles, 145

working last, 12-14

wrapping text

all the way around. 168
around irregular objects, 170

inside shaped boxes, 123

x
..."

, ,.........

X andY, aligning by, 65

XTenslons, sets for different

clients and projects, 15

XTenslons Manager, 15, 75

v-Z

Zallman, Toby, 145

Zapl Dingbats, 97

Zoom tool, 32
keyboard shortcuts, 33

zooming, 32-35
Fit in Window, 35
keyboard shortcuts, 33

view percent field, 32

Zoom tool, 32
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